Version 10.1

To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09421010

Copyright © 2015 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor (any such agreement, a “Separate Agreement”), the following terms apply:

This Software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2015 by MicroStrategy Incorporated. All rights reserved.

This Software and documentation are provided “as is” and without express or limited warranty of any kind by either MicroStrategy Incorporated or anyone who has been involved in the creation, production, or distribution of the Software or documentation, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose, good title and noninfringement, quality or accuracy. The entire risk as to the quality and performance of the Software and documentation is with you. Should the software or documentation prove defective, you (and not MicroStrategy, Inc. or anyone else who has been involved with the creation, production, or distribution of the Software or documentation) assume the entire cost of all necessary servicing, repair, or correction. Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you.

In no event will MicroStrategy, Incorporated, or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other person. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and documentation, based upon principles of contract, negligence or otherwise.

Furthermore, MicroStrategy, Inc. and your exclusive remedy, shall not exceed, at the option of MicroStrategy, Inc., beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U.S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at FAR 52.227-19, as applicable.

MCCORPORATION, INCORPORATED 1850 Towers Crescent Plaza, Tysons Corner, VA 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.

The following terms and notices apply regardless of whether you have executed a Separate Agreement:

Trademark Information


Other product and company names mentioned herein may be the trademarks of their respective owners.

Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 5,321,520, 5,416,602, 5,748,560, 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,501,832, 6,567,796, 6,587,547, 6,606,596, 6,658,093, 6,658,432, 6,662,195, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,707,889, 6,741,980, 6,765,997, 6,768,788, 6,772,137, 6,778,768, 6,792,086, 6,798,867, 6,801,273, 6,801,274, 6,804,855, 6,833,344, 6,837,976, 6,848,929, 6,850,982, 6,856,201, 6,859,013, 6,942,755, 6,996,566, 6,996,569, 7,003,512, 7,010,516, 7,016,480, 7,020,251, 7,039,165, 7,082,422, 7,113,474, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,461, 7,228,303, 7,250,577, 7,266,181, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,340,040, 7,356,758, 7,356,840, 7,415,438, 7,439,912, 7,440,988, 7,457,397, 7,486,780, 7,509,671, 7,516,181, 7,559,408, 7,574,376, 7,574,201, 7,725,811, 7,801,967, 7,836,178, 7,861,161, 7,861,253, 7,881,443, 7,925,616, 7,945,584, 7,970,782, 8,005,870, 8,035,382, 8,051,168, 8,051,369, 8,094,788, 8,123,918, 8,296,287, 8,321,411, 8,452,755, 8,521,733, 8,522,192, 8,577,902, 8,606,813, 8,607,138, 8,645,313, 8,761,659, 8,775,807, 8,782,083, 8,812,490, 8,832,588, 8,943,044, and 8,943,187. Other patent applications are pending.

Third Party Software

Various MicroStrategy products contain the copyrighted technology or software of third parties ("Third Party Software"). A list of Third Party Software, as well as links to any terms and conditions associated with such Third Party Software ("Third Party Terms"), can be found at http://www.microstrategy.com/third-party-notices. Your use of MicroStrategy products is subject to all applicable Third Party Terms.
## CONTENTS

**Book Overview and Additional Resources**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>xiii</td>
</tr>
<tr>
<td>MicroStrategy evaluation products</td>
<td>xiv</td>
</tr>
<tr>
<td>Description of this guide</td>
<td>xiv</td>
</tr>
<tr>
<td>About this guide</td>
<td>xvi</td>
</tr>
<tr>
<td>How to find business scenarios and examples</td>
<td>xvii</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>xvii</td>
</tr>
<tr>
<td>Who should use this guide</td>
<td>xvii</td>
</tr>
<tr>
<td>Resources</td>
<td>xviii</td>
</tr>
<tr>
<td>Documentation</td>
<td>xviii</td>
</tr>
<tr>
<td>Education</td>
<td>xxvi</td>
</tr>
<tr>
<td>Consulting</td>
<td>xxvii</td>
</tr>
<tr>
<td>Technical Support</td>
<td>xxvii</td>
</tr>
<tr>
<td>Feedback</td>
<td>xxvii</td>
</tr>
</tbody>
</table>

1. **Recommended Evaluation Processes for MicroStrategy**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Checklist for fast proof-of-concept evaluations using MicroStrategy Visual Insight</td>
<td>2</td>
</tr>
<tr>
<td>Checklist for evaluating the full MicroStrategy platform and product line</td>
<td>3</td>
</tr>
</tbody>
</table>

2. **Evaluate Quick Proofs-of-Concept with Visual Insight**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>Installing MicroStrategy components to support Visual Insight dashboards</td>
<td>7</td>
</tr>
<tr>
<td>Installing MicroStrategy Web, Intelligence Server, Developer, and the Analytics Module</td>
<td>7</td>
</tr>
<tr>
<td>Importing your data from a file</td>
<td>9</td>
</tr>
</tbody>
</table>
## Contents

Best practices for importing data from a file .................................................. 10
Importing data from a file ........................................................................... 11

Creating a Visual Insight dashboard ............................................................ 14
Selecting a visualization: The Heat Map ...................................................... 14
Evaluating other commonly used visualizations ......................................... 17
Formatting a visualization ........................................................................... 18
Adding and editing filters in a dashboard .................................................... 20

Analyzing your data ................................................................................... 26
Filtering, sorting, and drilling on data ........................................................ 26
Analyzing data in a visualization ................................................................ 27
Exporting a dashboard or a visualization .................................................... 29
Emailing a dashboard or sending it to a History List .................................. 31
Printing a dashboard .................................................................................. 33

Next steps ................................................................................................. 33

### 3. Business Intelligence and the MicroStrategy Platform

#### Introduction ........................................................................................... 35

Introduction to business intelligence .......................................................... 35
Leading national bank ............................................................................... 36
Online vehicle marketplace ........................................................................ 36
Other business intelligence applications .................................................. 36
Business intelligence trends ....................................................................... 37

MicroStrategy product overview ............................................................... 43
MicroStrategy Desktop ............................................................................... 44
MicroStrategy Analytics Enterprise ............................................................. 45
MicroStrategy Cloud ................................................................................ 50

MicroStrategy Analytics Enterprise technical architecture ....................... 51
Data layer ................................................................................................. 53
Report servers ......................................................................................... 54
Interactive reporting and analysis .............................................................. 56
Information delivery and alerting ............................................................... 59
Design ....................................................................................................... 60
Administration ........................................................................................... 61
Integration and customization .................................................................... 62

### 4. Installing the MicroStrategy Evaluation Edition

#### Introduction ............................................................................................ 63

MicroStrategy Evaluation Edition system requirements ............................ 63
Hardware requirements .............................................................................. 64
Software requirements .............................................................................. 64
Prerequisites for installation ...................................................................... 67
Installing the MicroStrategy Evaluation Edition............................ 67
Installing MicroStrategy with the MicroStrategy Installation Wizard .................................................................................................................. 68
Beginning the evaluation ........................................................................................................... 75
Activating the Evaluation Edition at a later time ............................ 77
  Requesting an activation code at a later time........................................ 77
  Activating your installation at a later time........................................ 79
Verifying your installation ........................................................................................................ 79
Uninstalling MicroStrategy components ................................................................. 80
  Uninstalling MicroStrategy Office.................................................................................. 81
  Modifying or repairing MicroStrategy components ................................................. 82

5. Viewing Reports in MicroStrategy Developer
  MicroStrategy Developer Evaluation

  Introduction ................................................................................................................................. 83
Getting started with your Developer evaluation ................................................................. 84
  Prerequisites .......................................................................................................................... 84
  Table of features ..................................................................................................................... 84
Logging in to MicroStrategy Developer ...................................................................................... 85
Getting started with reports and documents .............................................................................. 87
  Category Performance Dashboard ......................................................................................... 88
  Category Sales and Profit Performance .................................................................................. 89
  Category Sales Report .............................................................................................................. 91
  Predictive Dashboard for Churn Risk Analysis ..................................................................... 94
  Inventory by Subcategory ........................................................................................................ 96
Exploring additional reports and documents ............................................................................. 96
  Enterprise Reporting Documents .......................................................................................... 97
Creating your own reports ........................................................................................................ 104
Next steps in the evaluation ....................................................................................................... 106
Learning about report design and application development ................................................. 107
  Learning about application objects in the Business Abstraction layer ........................................ 108
  Learning about schema objects in the Schema layer ......................................................... 109
  Reviewing hierarchies .......................................................................................................... 109
System administration .............................................................................................................. 110
6. Viewing Reports in a Web Browser

   Introduction .............................................................................. 111
   Getting started ................................................................. 111
      Prerequisites ..................................................................... 112
      Evaluation features ....................................................... 112
   Logging in to MicroStrategy Web ........................................ 112
   Getting started with reports .............................................. 113
      Category Performance Dashboard ................................ 114
      Category Sales and Profit Performance ...................... 115
      Category Sales Report .................................................. 118
      Predictive Dashboard for Churn Risk Analysis ............ 121
      Inventory by Subcategory ............................................ 122
   Delivering reports .............................................................. 123
      Immediate Delivery: Sending a report via email .......... 124
      Automated Delivery: Receiving reports regularly via email ........................................................................ 126
      Automated Delivery: Automatically archiving reports .... 127
   Subscribing to reports to view on a mobile device ............ 129
   Exploring additional reports .............................................. 129
   Creating your own report ................................................... 130
      Next steps in the evaluation ........................................... 131

7. Viewing Reports in Microsoft Excel, PowerPoint, and Word

   Introduction .............................................................................. 133
   Prerequisites ............................................................................. 134
   Beginning the MicroStrategy Office evaluation for Microsoft Excel ................................................................. 134
      Performing one-click refresh of multiple reports ......... 135
      Navigating to Next Steps ............................................... 136
      Adding reports to Excel ................................................. 137
   Beginning the MicroStrategy Office evaluation for Microsoft PowerPoint ......................................................... 138
      Performing one-click refresh of multiple reports ........ 139
      Navigating to Next steps .............................................. 140
      Adding reports to PowerPoint ...................................... 141
   Beginning the MicroStrategy Office evaluation for Microsoft Word ................................................................. 142
      Performing one-click refresh of multiple reports ........ 143
Navigating to Next Steps ..................................................... 144
Adding reports to Word ...................................................... 145

8. Viewing Reports on a Mobile Device
MicroStrategy Mobile Evaluation

Introduction .............................................................................. 147
Prerequisites ........................................................................... 148
Beginning the MicroStrategy Mobile evaluation ................. 148
Evaluating MicroStrategy Mobile on an iOS device .......... 148
  Downloading and configuring MicroStrategy Mobile on an iPhone ...................................................... 149
  Getting started viewing reports on an iPhone ........ 150
  Evaluating additional reports and dashboards .... 164
  Evaluating predesigned apps built in MicroStrategy ... 166
Next steps in the evaluation process .................................... 166

Downloading MicroStrategy Mobile for Android .................. 166
Next steps in the evaluation process ......................................... 167

9. Delivering Reports
MicroStrategy Distribution Services Evaluation

Introduction .............................................................................. 169
Administering report delivery .................................................. 170
  About transmitters ............................................................. 171
  About devices ..................................................................... 171
  About contacts .................................................................... 171
Evaluating Distribution Services ............................................. 172
Next steps in the evaluation process ......................................... 172

10. Building a Reporting Application
MicroStrategy Architect Evaluation

Introduction .............................................................................. 175
About MicroStrategy Architect ............................................... 176
Evaluating projects and their objects .................................. 177
  Starting MicroStrategy Architect ..................................... 178
  Building the schema layer using Architect .................. 181
  Building the business abstraction layer using Developer .. 190
  Building the reporting layer using Developer .............. 195
Next steps in the evaluation process ......................................... 198
# Contents

11. Viewing Business Intelligence Applications
   **Analytics Module Evaluation**
   - Introduction ................................................................. 199
     - The Human Resources Analysis Module ..................... 200
       - Viewing reports in a web browser ......................... 201
       - Viewing reports in MicroStrategy Developer ............ 203

12. Enhancing your Project and Creating Documents
   **Next Steps**
   - Introduction ................................................................. 207
     - Enhancing your project ............................................. 207
     - Creating documents .................................................. 209
       - Creating a basic document with the Document Wizard .... 211
       - Refining a document using the Document Editor .......... 213

A. Troubleshooting the Evaluation Edition
   - Introduction ................................................................. 221
     - Troubleshooting installation and configuration of the evaluation ........................................ 221
       - Using the installation log file ................................. 221
       - Next button grayed out on Customer Information screen .... 222
       - Missing Requirements screen opens ....................... 223
     - Troubleshooting the MicroStrategy Developer evaluation .............. 223
       - Link on Welcome screen is not active ..................... 223
       - Cannot log in .......................................................... 223
     - Troubleshooting the MicroStrategy Web evaluation ........... 224
       - Link on Welcome screen is not active ..................... 224
       - MicroStrategy Web page cannot be displayed .......... 224
       - MicroStrategy Web is running, but there are no projects .... 225
     - Troubleshooting the MicroStrategy Office evaluation ........ 226
       - Links on Welcome screen are not active ................. 226
       - There is no MicroStrategy Office toolbar ............. 227
     - Troubleshooting the MicroStrategy Mobile evaluation ... 227
       - Link on Welcome screen is not active ..................... 227
     - Troubleshooting the MicroStrategy Architect evaluation .... 227
       - Link on Welcome screen is not active ..................... 227

Glossary ................................................................................. 229
BOOK OVERVIEW AND ADDITIONAL RESOURCES

Introduction

Thank you for your interest in MicroStrategy Analytics Enterprise. This manual provides you with all the information you need for a successful evaluation of MicroStrategy. If you are new to MicroStrategy—or to business intelligence applications in general—and want to learn more about the MicroStrategy platform and what it can do for you, see Introduction to business intelligence, page 35.

This guide introduces you to a variety of products that represent the full functionality of MicroStrategy Analytics Enterprise. For a feature comparison and details about specific features included in each product, see the following MicroStrategy website:

http://www.microstrategy.com/platforms/analytics/business-intelligence
MicroStrategy evaluation products

All MicroStrategy evaluation products provide access to fully functional versions of the award-winning MicroStrategy business intelligence reporting features. The evaluations provide a special interface that walks you through a step-by-step experience. The evaluations make use of the specially designed MicroStrategy Tutorial BI application and its sample data, sample reports, and other sample reporting objects.

MicroStrategy offers the following evaluation products:

- **MicroStrategy Evaluation Edition software**: This evaluation software provides an evaluation of MicroStrategy functionality in a Microsoft Windows environment.

  This evaluation software is available from MicroStrategy, Inc. and can be downloaded free from:

  http://www.microstrategy.com/free/developers#evaluation-edition

  Detailed instructions for this evaluation software are included in this guide.

- **MicroStrategy SDK Evaluation for SIs, VARs, and OEMs**: Many MicroStrategy customers want the power and sophistication of the MicroStrategy platform but have specific requirements that require a customized solution. For example, you may want to create an application that is consistent with your corporate standards, or you may want to embed MicroStrategy functionality into your existing systems. You may even want to build and resell MicroStrategy-based products or applications suited to particular industries. All of these types of customizations are possible using the MicroStrategy Software Development Kit (SDK).

  To experience the SDK evaluation, see the MicroStrategy Developer Library (MSDL) section called What Can You Do With The MicroStrategy SDK. The MSDL is part of the SDK product.

Description of this guide

This guide walks you through the evaluation process by providing:

- An outline of the overall, recommended evaluation process.
• Steps to install and configure the Evaluation Edition.

• The purpose of each of the MicroStrategy platform products and steps to learn key functionality of each product using the MicroStrategy Tutorial sample project.

• Steps on how to create your own simple reporting applications.

• Information on how you can evaluate the Human Resources Analytics Module.

• Additional MicroStrategy resources with which you can perform a wide range of business intelligence tasks.

• Information on what you need to do to embed or resell MicroStrategy technology in your own applications.

The chapters provide the following information:

• *Chapter 1, Recommended Evaluation Processes for MicroStrategy*, discusses the business intelligence market and trends. It also provides a technically detailed description of the MicroStrategy platform, the products that it contains, and the interactions between them.

• *Chapter 2, Business Intelligence and the MicroStrategy Platform*, provides a short, high-level overview of the evaluation process.


• *Chapter 4, Viewing Reports in MicroStrategy Developer*, introduces you to MicroStrategy Developer, a product that lets you create projects and design reports and documents.

• *Chapter 5, Viewing Reports in a Web Browser*, introduces you to MicroStrategy Web, a product that provides query and reporting functionality using a browser.

• *Chapter 6, Viewing Reports in Microsoft Excel, PowerPoint, and Word*, introduces you to MicroStrategy Office, which lets you integrate MicroStrategy with Microsoft Office products like Excel, PowerPoint, and Word. You can execute MicroStrategy reports and documents directly from the Microsoft Office applications.

• *Chapter 7, Viewing Reports on a Mobile Device*, introduces you to MicroStrategy Mobile, a product that allows you to receive reports and documents on your Apple® iPhone® or iPad™, or Android™ smartphone or tablet and analyze the data.
• *Chapter 8, Delivering Reports*, introduces you to MicroStrategy Distribution Services, which performs high-volume and high-efficiency distribution of reports, documents, and dashboards with low administrative overhead.

• *Chapter 9, Building a Reporting Application*, shows you the process of creating your own business intelligence application based on the MicroStrategy Tutorial sample project. You learn how to create some of the functionality explored in other chapters of this guide.

• *Chapter 10, Viewing Business Intelligence Applications*, describes how you can use the Analytics Module to add best-of-breed analytics to your existing data warehouses without needing to build or standardize on a vendor-specified data model or warehouse schema.

• *Chapter 11, Enhancing your Project and Creating Documents*, provides some guidance about what to do after you have completed the evaluation; where to learn how to build applications using your own data; where to learn how to configure a larger, production-ready environment; and so on.

• *Appendix A, Troubleshooting the Evaluation Edition*, helps you troubleshoot issues you may encounter while working with the Evaluation Edition.

### About this guide

This guide is divided into chapters that begin with a brief overview of the chapter's content.

The following sections provide the location of examples, list prerequisites for using this guide, and describe the user roles the information in this guide was designed for.

The sample documents and images in this guide, as well as some example steps, were created with dates that may no longer be available in the MicroStrategy Tutorial project. If you are re-creating an example, replace the year(s) shown in this guide with the most recent year(s) available in the software.
**How to find business scenarios and examples**

For examples of reports and reporting functionality, see the MicroStrategy Tutorial sample project, which is MicroStrategy’s sample warehouse and project. Information about the MicroStrategy Tutorial can be found in *Viewing Reports in MicroStrategy Developer, page 83* of this guide. For complete details on every object in the Tutorial project, see the *MicroStrategy Project Design Guide* (see *Resources, page xviii*).

Additional examples of basic report analysis and functionality, with detailed explanations, can be found in the *MicroStrategy Basic Reporting Guide*. Detailed examples of advanced reporting functionality can be found in the *MicroStrategy Advanced Reporting Guide*.

**Prerequisites**

This manual is written with the assumption that you understand standard Microsoft® Windows® terminology and usage, such as using a mouse, opening a menu, selecting options in a dialog box, and so on.

Knowledge of relational databases and data modeling is helpful, depending on the depth of the evaluation experience you intend to explore.

**Who should use this guide**

The MicroStrategy Evaluation Edition software is for first-time users who would like to evaluate MicroStrategy Analytics Enterprise for their business intelligence needs. Anyone who is interested in evaluating and using the MicroStrategy platform can use this guide to learn about the products in the platform and use evaluations that demonstrate their functionality.

Audiences include:

- Administrators who install and configure information technology (IT) systems, define users and user groups, and assign login accounts and privileges. They typically monitor, analyze, and tune the systems to ensure the smooth and balanced operation of the IT environments.
- Project designers who are familiar with the application model and functionality of system tools, and access the business intelligence environment on a daily basis. They create and update the system objects.
• Knowledge analysts who access the business intelligence systems and may slice and dice, manipulate, and format the information to further their business intelligence needs.

• Application developers who build customized applications that reflect enterprise-wide IT requirements.

Resources

This section provides details on how to access books, online help, MicroStrategy Education and Consulting resources, and how to contact MicroStrategy Technical Support.

Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

• Manuals: MicroStrategy manuals provide:
  ▫ Introductory information and concepts
  ▫ Examples and images
  ▫ Checklists and high-level procedures to get started

The steps to access the manuals are described in Accessing manuals and other documentation sources, page xxiv.

Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

• Help: MicroStrategy online help provides:
  ▫ Detailed steps to perform procedures
  ▫ Descriptions of each option on every software screen

Additional formats

MicroStrategy manuals are available as electronic publications, downloadable on the Apple iBooks Store or Google Play, and can be read on
your iOS or Android device respectively. To download a book, search for the book’s title in the iBookstore or Google Play. To view a list of manuals that are currently available, scan the following QR codes using your device’s camera:

- For iOS devices, scan the following QR code:

  ![QR Code for iOS devices]

- For Android devices, scan the following QR code:

  ![QR Code for Android devices]

For new MicroStrategy releases, it may take several days for the latest manuals to be available on the iBookstore or Google Play.

**Translations**

For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

**Finding information**

You can search all MicroStrategy books and Help for a word or phrase, with a simple Google™ search at [http://www.google.com](http://www.google.com). For example, type “MicroStrategy derived metric” or “MicroStrategy logical table” into a Google search. As described above, books typically describe general concepts and
examples; Help typically provides detailed steps and screen options. To limit your search to MicroStrategy books, on Google’s main page you can click More, then select Books.

**Manuals for MicroStrategy overview and evaluation**


  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide includes a walkthrough of MicroStrategy features so you can perform reporting with the MicroStrategy Tutorial project and its sample business data.


  Overview of the installation and evaluation process, and additional resources.

**Resources for security**

- *Usher Help*

  Steps to perform mobile identity validation using the Usher mobile security network to issue electronic badges for identifying users.

**Manuals for query, reporting, and analysis**

- *MicroStrategy Installation and Configuration Guide*

  Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, and basic maintenance guidelines.

- *MicroStrategy Upgrade Guide*

  Steps to upgrade existing MicroStrategy products.

- *MicroStrategy Project Design Guide*

  Information to create and modify MicroStrategy projects, and create the objects that present your organization’s data, such as facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.
• **MicroStrategy Basic Reporting Guide**
  Steps to get started with MicroStrategy Web, and how to analyze and format data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

• **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**
  Steps to create Freeform SQL reports, Query Builder reports, complex filters and metrics, use Data Mining Services, and create custom groups, consolidations, and complex prompts.

• **Document and Dashboard Analysis Guide**
  Steps to execute, analyze, and format a dashboard in MicroStrategy Web.

• **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**
  Steps to create Report Services documents, add objects, and format the document and its objects.

• **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for Your Data**
  Steps to create MicroStrategy Report Services dashboards and add interactive visualizations.

• **MicroStrategy In-memory Analytics Guide**
  Information to use MicroStrategy OLAP Services features, including Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

• **MicroStrategy Office User Guide**
  Instructions to use MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, and Word, to analyze, format, and distribute business data.

• **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**
  Steps to use MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.
• **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

Information and instructions to install and configure MicroStrategy Mobile, as well as steps for a designer working in MicroStrategy Developer or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.

• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting Your MicroStrategy Business Intelligence System**

Steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

Steps for administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

• **MicroStrategy Operations Manager Guide**

Instructions for managing, monitoring, and setting alerts for all of your MicroStrategy systems from one console. This guide also includes instructions for setting up and using Enterprise Manager to analyze your MicroStrategy system usage.

---

**Manual for the Human Resources Analytics Module**

• **Human Resources Analytics Module Reference**
Software Development Kits

- **MicroStrategy Developer Library (MSDL)**
  
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.

- **MicroStrategy Web SDK**
  
  The Web SDK is available in the MicroStrategy Developer Library, which is part of the MicroStrategy SDK.

Documentation for MicroStrategy Portlets

- **Enterprise Portal Integration Help**
  
  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

  This resource is available from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp).

Documentation for MicroStrategy GIS Connectors

- **GIS Integration Help**
  
  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

  This resource is available from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp).
Help

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- Help button: Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- Help menu: From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- F1 key: Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.

Accessing manuals and other documentation sources

The manuals are available from http://www.microstrategy.com/producthelp, as well as from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Reader is required to view these manuals. If you do not have Adobe Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the MicroStrategy Basic Reporting Guide.

To access the installed manuals and other documentation sources, see the following procedures:

- To access documentation resources from any location, page xxv
- To access documentation resources on Windows, page xxv
To access documentation resources from any location

1 Visit http://www.microstrategy.com/producthelp.

To access documentation resources on Windows

1 From the Windows Start menu, choose Programs (or All Programs), MicroStrategy Documentation, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2 Click the link for the desired manual or other documentation source.

   If bookmarks are not visible on the left side of a product manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Reader.

To access documentation resources on UNIX and Linux

1 Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy, or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Help folder.

3 Open the Product_Manuals.htm file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source.

   If bookmarks are not visible on the left side of a product manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Reader.
Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>• Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions.</td>
</tr>
<tr>
<td></td>
<td>Example: Click <strong>Select Warehouse</strong>.</td>
</tr>
<tr>
<td><strong>italic</strong></td>
<td>• Names of other product manuals and documentation resources.</td>
</tr>
<tr>
<td></td>
<td>• When part of a command syntax, indicates variable information to be replaced by the user.</td>
</tr>
<tr>
<td></td>
<td>Example: <strong>Type</strong> copy <code>c:\filename d:\foldername\filename</code></td>
</tr>
<tr>
<td><strong>Courier font</strong></td>
<td>• Calculations</td>
</tr>
<tr>
<td></td>
<td>• Code samples</td>
</tr>
<tr>
<td></td>
<td>• Registry keys</td>
</tr>
<tr>
<td></td>
<td>• Path and file names</td>
</tr>
<tr>
<td></td>
<td>• URLs</td>
</tr>
<tr>
<td></td>
<td>• Messages displayed in the screen</td>
</tr>
<tr>
<td></td>
<td>• Text to be entered by the user</td>
</tr>
<tr>
<td></td>
<td>Example: <strong>Sum(revenue)/number of months.</strong></td>
</tr>
<tr>
<td></td>
<td>Example: <strong>Type</strong> <code>cmdmgr -f scriptfile.scp</code> and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td><strong>+</strong></td>
<td>A keyboard command that calls for the use of more than one key (for example, <code>SHIFT+F1</code>).</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>A note icon indicates helpful information for specific situations.</td>
</tr>
<tr>
<td><strong>Warning</strong></td>
<td>A warning icon alerts you to important information such as potential security risks; these should be read before continuing.</td>
</tr>
</tbody>
</table>

Education

MicroStrategy Education Services provides a comprehensive curriculum and highly skilled education consultants. Many customers and partners from over 800 different organizations have benefited from MicroStrategy instruction.

Courses that can help you prepare for using this manual or that address some of the information in this manual include:

- MicroStrategy Developer: Reporting Essentials
• MicroStrategy Web for Reporters and Analysts
• MicroStrategy Visual Insight Essentials
• MicroStrategy Report Services: Documents and Dashboards

For a detailed description of education offerings and course curriculums, visit www.microstrategy.com/Education.

**Consulting**

MicroStrategy Consulting Services provides proven methods for delivering leading-edge technology solutions. Offerings include complex security architecture designs, performance and tuning, project and testing strategies and recommendations, strategic planning, and more. For a detailed description of consulting offerings, visit http://www.microstrategy.com/services-support/consulting.

**Technical Support**

If you have questions about a specific MicroStrategy product, you should:

1. Consult the product guides, Help, and readme files. Locations to access each are described above.

2. Consult the MicroStrategy Knowledge Base online at https://resource.microstrategy.com/support.

   A technical administrator in your organization may be able to help you resolve your issues immediately.


**Feedback**

Please send any comments or suggestions about user documentation for MicroStrategy products to:

documentationfeedback@microstrategy.com
Send suggestions for product enhancements to:

support@microstrategy.com

When you provide feedback to us, please include the name and version of the products you are currently using. Your feedback is important to us as we prepare for future releases.
Introduction

Use the high-level checklist in this chapter to determine your evaluation experience of the MicroStrategy Evaluation Edition software.

The following evaluation approaches are presented, depending on your goals:

• If you want to achieve a fast proof-of-concept or quick demonstration of reporting capabilities using MicroStrategy Visual Insight features, see Checklist for fast proof-of-concept evaluations using MicroStrategy Visual Insight, page 2.

• If you want to evaluate the full MicroStrategy product line, or you want to evaluate products other than Visual Insight, see Checklist for evaluating the full MicroStrategy platform and product line, page 3.
Checklist for fast proof-of-concept evaluations using MicroStrategy Visual Insight

1 Install and activate the evaluation software. It describes the minimum hardware and software requirements to ensure adequate product performance during the evaluation. It also provides steps to install and activate each product.

Be aware of the following:

- The license key for the Evaluation Edition expires 30 days from the time you install MicroStrategy software. If you need to continue your evaluation beyond 30 days, you can renew your evaluation license. To do this, contact MicroStrategy via telephone at 1-888-537-8135 (US) or 44(0) 208 396 0000 (worldwide) or via email at info@microstrategy.com.

- After your MicroStrategy installation is complete, you have seven days to activate your installation.

2 Create a dashboard by importing your data from a file. Display your data in the Heat Map visualization. Save your dashboard.

3 Analyze your data using filtering, sorting, and drilling functionality. You can also group data, export or email it to other users, print it, and schedule it to be delivered automatically to your History List folder in MicroStrategy Web.
Checklist for evaluating the full MicroStrategy platform and product line

Each step in the evaluation process covers a specific area of MicroStrategy functionality. Depending on your particular business needs, you can skip some areas and concentrate on others.

The following steps describe the recommended evaluation process to evaluate the full MicroStrategy product line.

To evaluate the MicroStrategy platform

1. Install and activate the evaluation software. *Installing the MicroStrategy Evaluation Edition, page 63* helps you with the installation and activation process. It describes the minimum hardware and software requirements to ensure adequate product performance during the evaluation. It also provides steps to install and activate each product.

   Be aware of the following:

   – The license key for the Evaluation Edition expires 30 days from the time you install MicroStrategy software. If you need to continue your evaluation beyond 30 days, you can renew your evaluation license. To do this, contact MicroStrategy via telephone at 1-888-537-8135 (US) or 44(0) 208 396 0000 (worldwide) or via email at info@microstrategy.com.

   – After your MicroStrategy installation is complete, you have seven days to activate your installation.

2. Explore the MicroStrategy platform using the guided evaluation that displays after you install the evaluation software. The chapters in this guide walk you through each product.

3. Build your own reporting application using the sample data warehouse provided with the evaluation software. *Building a Reporting Application, page 175* walks you through the process of creating your own application.

4. *Viewing Business Intelligence Applications, page 199* describes how you can explore the Human Resources Analytics Module, which you can use as a starter kit to begin developing your own custom analytic applications.
5 When you have finished learning about the different products, *Enhancing your Project and Creating Documents, page 207* directs you to other resources for creating a production-ready application using your own data.

6 Finally, the *MicroStrategy Developer Library (MSDL)* describes where you can learn about integrating, extending, and fully exploiting the power of the MicroStrategy platform through a set of rich APIs that expose all the functionality of the platform.
EVALUATE QUICK PROOFS-OF-CONCEPT WITH VISUAL INSIGHT

Introduction

MicroStrategy Visual Insight empowers you to discover insights from your data using compelling visualizations. Quickly and easily explore any data contained in personal spreadsheets, databases, a Salesforce.com report, or Hadoop. Investigate and analyze the data further by defining new metric calculations, zooming into details with filters, and color-coding the results with thresholds. Create multiple visualizations to get additional insights and perspectives that enhance data comprehension. Combine your findings into a dashboard you can save and share with your colleagues.

Visual Insight provides incredible speed-of-interactivity and a highly graphical interface. Visual Insight is designed specifically to allow business people to explore data sets, simply and without needing direct support from IT.

A Visual Insight dashboard is a customized, interactive display that you can use to explore your business data using standard MicroStrategy functionality. For example, you can sort and rearrange data in an interactive grid, perform manipulations on the data to display only the information you are interested in, and display visual representations of the data in the dashboard to make the data easier to interpret.
Dashboards can be viewed in MicroStrategy Web in the Dashboard Editor, in Express Mode, or in Flash Mode. They can also be viewed on an iPad with MicroStrategy Mobile.

A dashboard displays data from an underlying dataset in a streamlined interface designed to enable you to explore your data quickly and easily. Visual representations of the data, called visualizations, are added by the designer of the dashboard and are stored with the dashboard.

In the image below, data in a dashboard is displayed using a Grid visualization, which contains revenue, cost, and profit data for each Call Center in a Region. Total profit data is calculated and displayed for each region in the grid. Profit values of less than $300,000 are displayed using a red background, while values of greater than $800,000 are displayed in green.

You can sort and pivot data in a visualization, filter your data by selecting elements of business attributes (for example, New York and London are elements of the attribute City) or business metric values (for example, revenue and profit are metrics), display the data in interactive visualizations, quickly switch between different visual representations of the data, and so on.
Installing MicroStrategy components to support Visual Insight dashboards


Installing MicroStrategy Web, Intelligence Server, Developer, and the Analytics Module

The steps below show you how to install the MicroStrategy components required to evaluate Visual Insight.

Prerequisites

- Review the prerequisites provided in *Prerequisites for installation, page 67*.
- Internet access so that you can register your MicroStrategy Evaluation Edition.
- The steps below assume that you are evaluating Visual Insight on a Windows environment. You need a Windows account with administrative privileges. The MicroStrategy Intelligence Server service requires a Windows account with administrative privileges under which to run.

To install the MicroStrategy components required to evaluate Visual Insight

1. Log on to the machine where you are installing one or more MicroStrategy products.
2. Exit all Windows applications before beginning the installation process.
3. Begin the installation process in one of the following ways:
   - **From the disk**: Insert the disk into the disk drive and wait for the MicroStrategy Main Menu window to display automatically.
     
     If the MicroStrategy Main Menu does not display, locate and run the MicroStrategy.exe file.
• **From the download site:** Download the files from the MicroStrategy download site. Locate and run the `MicroStrategy.exe` file.

  Note the following:
  
  – Contact your MicroStrategy sales representative to determine the location and login credentials for the MicroStrategy download site.
  
  – You may have to extract the downloaded files to locate the `MicroStrategy.exe` file.

4 **Click Evaluate Software.**

  • If you do not have a license key, click *Request Evaluation License Key* to obtain one. This takes you to the MicroStrategy website where you can register your MicroStrategy Evaluation Edition. Provide your email address and the promotion code found on the inside of the evaluation disk mailer. If you downloaded the Evaluation Edition, the promotion code can be found in the Welcome communication from MicroStrategy.

  If you do not have a promotion code, contact MicroStrategy Technical Support (see *Consulting, page xxvii*).

5 **Click Install MicroStrategy Platform.**

  • If this is the first time you have installed MicroStrategy, you are prompted to choose the language for the wizard. Select the appropriate language from the drop-down list and click **OK**.

6 **The MicroStrategy Installation Wizard opens and walks you through the rest of the installation process. Provide all necessary information and keep all default settings until you reach the Select Features page.**

7 **Select the check box next to each MicroStrategy product you want to include in the installation. To evaluate Visual Insight, install the following MicroStrategy components:**

  • **MicroStrategy Intelligence Server,** including:
    
    ▪ MicroStrategy Report Services
    
    ▪ MicroStrategy OLAP Services
  
  • **MicroStrategy Web,** including:
    
    ▪ MicroStrategy Web Server
    
    ▪ MicroStrategy Web Professional
• MicroStrategy Developer Products, including:
  □ MicroStrategy Developer

The MicroStrategy Analytics Module and Tutorial projects are sample projects containing sample data. They are not listed among the components you can select to install, but are automatically installed.

8 Continue the installation steps, providing all necessary information and keeping all default settings until you reach the MicroStrategy Intelligence Server Settings page.

9 Select the check box to have the service run under the local system account.

10 Complete the installation steps, providing all necessary information and keeping all default settings until you click **Finish** to complete the installation.

### Importing your data from a file

You use MicroStrategy Web to import data from different data sources, such as an Excel file, the results of a custom database query (called a Freeform script), or a Salesforce.com report, into MicroStrategy metadata. You can perform this easy import with minimum project design requirements.

Some common uses for this quick import feature include:

• Quickly integrating data into MicroStrategy as part of a proof-of-concept

• Importing and reporting on personalized data from various data sources

• Immediately building reports, documents, and analyses without having to “model” the data source

• Modifying the data in your data source, then republishing the data to quickly update your reports, documents, and analyses

Attributes, metrics, and other objects that are mapped to imported data are created in the MicroStrategy software as managed objects.

This evaluation process provides steps to import a file from your computer. For detailed steps on other types of file import such as importing a file using a URL or UNC path, see the *MicroStrategy Web Help*. 

© 2015 MicroStrategy, Inc.
Best practices for importing data from a file

Consider the following best practices when importing data from a file:

• Be sure that your system has enough free memory to accommodate the file. In general, your browser requires memory that is an additional 1.1 times the size of the file you want to upload. For example, to upload a 75 MB file, be sure to have at least 83 MB for the browser to use.

• If you use the default web server, which is Microsoft Internet Information Services, only 4 MB of data can be imported at a time.

• When importing data from an Excel, CSV, or text file, keep in mind the suggested maximum file size of 100 MB.

  For optimum performance, be sure your file sizes and system requirements match the recommendations in the System Administration Guide.

If you adhere to the system tuning best practices and increase various governing options as described in the MicroStrategy Web Help, you can support maximums of up to 750 MB when using Mozilla Firefox to import data, and 400 MB when using Microsoft Internet Explorer to import data.

• Depending on the type of file you are importing, you must meet the following requirements:
  
  □ For Excel files:

  – Multiple worksheets can be included in the file, but only one worksheet can be uploaded at a time.

  – The first worksheet for the file cannot be empty.

  – Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

  – Leave cells or data empty to represent NULL values rather than using the text NULL.

  – Determine whether the data for a column is numeric or textual. If there are any non-numeric values in a column, use a text data type. If all values are numeric, a numeric data type can be used.

  □ For CSV files:
- Use commas to separate values. No other characters, such as tabs or semicolons, should be used to separate values in the file.

- The file must use either UTF-8 or UTF-16 encoding.

- Avoid leaving more than 20 empty rows between column headers and data on the worksheet, so that you will see an accurate preview of your data.

- Leave cells or data empty to represent NULL values rather than using the text NULL.

- Determine whether the data for a column is numeric or textual. If there are any non-numeric values in a column, use a text data type. If all values are numeric, a numeric data type can be used.

  For text files:

  - Use commas to separate values. No other characters, such as tabs or semicolons, should be used to separate values in the file.

  - The file must use either UTF-8 or UTF-16 encoding.

  - Leave cells or data empty to represent NULL values rather than using the text NULL.

  - Determine whether the data for a column is numeric or textual. If there are any non-numeric values in a column, use a text data type. If all values are numeric, a numeric data type can be used.

**Importing data from a file**

You can import data from different data sources, such as an Excel spreadsheet or a text file, then create a dashboard using the imported data.

The following file types can be used to import data:

- .xls
- .xlsx
- .txt
- .csv

For text/CSV files, Web uses English (United States) localization settings to import data. For example, a comma is used as the separator symbol for every three digits.
For Excel files, Web uses the localization settings specified in the MicroStrategy Web User Preferences.

**Prerequisites**

- You must have Adobe Flash Player to import data. For specific version requirements, see the *MicroStrategy Readme*.

---

**To import and publish data from a file**

1. In MicroStrategy Web, log in to the project in which you want to import data.

2. Click the arrow next to the *Create Dashboard* icon, and select *Import Data* from the menu.

3. On the left, click *File*. The File Upload options are displayed.

4. To import data from a file on your computer or network, select the *From My Computer/Network* option.

5. Click *Browse*. The Select a File to Upload dialog box is displayed.

6. Navigate to the file you want to import, select it, then click *Open*.

7. Click *Next*. A preview of the imported data is displayed on the Preview page.

8. If the file is an Excel workbook with more than one sheet of data, from the *Sheet Name* drop-down list, select the name of the sheet from which you want to import data.

9. By default, Web assumes that your data is stored in a simple tabular layout, with each column in the table containing a separate attribute or metric. You can also choose to import data stored in a cross-tabbed layout. This evaluation assumes you have your data in a simple tabular layout.

   To import data from a simple tabular layout:
   
   a. Select *Tabular*. 
b By default, Web uses the first row of data as headers for the imported data columns. These column headers are then displayed as the names of the attributes and metrics you define:

- **Metrics**: A metric is a business measure or key performance indicator, such as Revenue, Profit, Employee Headcount, Probability of Purchase, and so on.

- **Attributes**: An attribute is a business concept, such as Product, Employee, Month, and so on. Attributes provide a context for metrics.

If the data in the imported file does not provide column headers for the data columns, you can specify the column headers manually by doing the following:

a Select the **Insert new column headers** check box. A default column header is automatically inserted for each data column.

b To specify a name for a column header, hover the cursor over the column header and click the arrow icon in the top right. Select **Rename**, then type a name for the header in the field and press **Enter**.

10 You can select options to define a data column as an attribute or metric, choose not to import a column of data, rename data columns, and so on. MicroStrategy also offers more detailed options, such as assigning attributes with the Date data type so you can create analyses over time. You can also assign a geo role to an attribute which allows you to create mapping and image layout types of analyses. This evaluation assumes your attributes will have data types automatically assigned. For details to define your data in more specific detail, see the **MicroStrategy Web Help**.

To define the data column as a metric, select **Metric**.

- To avoid including the data column in the imported data, select **Do Not Import**.

- To rename the data column, select **Rename**. Type a name in the field and press Enter.

- To change the data type of the column, point to **Data Type**, then select the data type you want to use.

11 Repeat the appropriate steps above for each data column you want to define.

12 Click **Publish**. The Save Dataset dialog box opens.
13. Browse to the location to save the imported data, then type a name and description for the set of data in the Name and Description fields.

14. Click OK.

15. Select Create Dashboard to have your new dashboard created. Then move to the next section to add a visualization to the dashboard.

Creating a Visual Insight dashboard

MicroStrategy automatically assesses your data and assigns it to one of several objects within MicroStrategy. These objects are then used on your dashboard to display your data.

Selecting a visualization: The Heat Map

A visualization is a visual representation of the data in a dashboard. A single dashboard can contain many visualizations, each containing information from a different set of data.

Because understanding a business takes more than a single perspective, MicroStrategy offers a large library of interchangeable visualizations. You can choose the visualization that makes the most sense for your data and for the goals of your end users. You can also quickly duplicate and switch visualizations to get a different view in seconds.

You can add visualizations to a dashboard, to provide multiple ways for a user to view and interact with the data in the dashboard. A dashboard can contain many visualizations, each containing data from a different set of data. Rendering even very complex business analyses in easy-to-understand visualizations means more people can use them.

A Heat Map visualization is superb for identifying performance patterns. Attention is drawn instantly to color-coded results, and it’s easy to understand area size and location. Rendering even very complex business analyses in easy-to-understand visualizations means more people can use them.
Creating a Heat Map visualization

A Heat Map visualization is a combination of nested, colored rectangles, each representing an attribute element. A Heat Map visualization allows you to quickly grasp the state and impact of a large number of variables at one time. Heat Maps are often used in the financial services industry to review the status of a portfolio.

The rectangles contain a wide variety and many shadings of colors, which emphasize the weight of the various components. In a Heat Map visualization:

- The size of each rectangle represents its relative weight. In the example above, Profit determines the size of the rectangles.

- The color of each rectangle represents its relative value. For example, in the image above, larger values of Cost are green and smaller values are red.

- The large areas, such as the Mid-Atlantic area of rectangles in the image above, represent different groups of data.

- The small rectangles, such as New York in the image above, represent individual attribute elements.

A Heat Map visualization requires one to two attributes and two metrics.

To create a Heat Map visualization on a dashboard using your imported data

1. Click Create Dashboard.
2 Select Import Data.

3 Hover over your newly imported data, and click Create. Then select Create Dashboard. The Select a Visualization dialog box opens.

4 Select the Heat Map icon. The Heat Map automatically populates the visualization based on its understanding of your imported data.

5 To add data to the visualization, display the Dataset Objects panel by clicking Show, then selecting Dataset Objects.

6 From the Dataset Objects panel, click and drag the following objects to the Heat Map panel:

   • Drag at least one attribute to the Grouping area. The elements of the attribute are displayed in the visualization. For example, if the attribute is Year, a rectangle for each year is displayed in the visualization.

   You can drag additional attributes to the Grouping area to group the rectangles in the visualization in a larger area. For example, the Region attribute contains the element South and the Call Center attribute contains the elements New Orleans and Memphis. If Region is placed above Call Center in the Grouping area, a rectangle called South is displayed in the visualization, with the rectangles New Orleans and Memphis inside. You can add additional attributes to further group the rectangles in the Heat Map.

   • Drag a metric to the Size By area. This metric determines the size of each rectangle, with rectangles for large metric values displayed as larger than rectangles for small metric values.

   • To have the rectangles colored automatically based on the value of a metric, drag the metric to the Color By area.

7 To display additional metrics in a tooltip when a user hovers the cursor over a graph element, place the metrics you want to display on the Tooltip area.

8 To save your dashboard, click the Save As icon. The Save As dialog box opens.

9 Navigate to the location in which you want to save the dashboard, then type a name and description in the appropriate fields.

10 Click OK. The dashboard is saved.
Evaluating other commonly used visualizations

Creating a Network visualization

The Network visualization allows analysts to quickly view data about individual items and the relationships between them in a visual format. Business attributes are represented by circular nodes, while the lines between the nodes (called edges) represent relationships between the nodes.

You can view additional information about an item in the visualization by hovering the cursor over a node or edge. A tooltip is automatically displayed in the visualization, showing the attribute and metric values associated with the node or edge. To zoom in or out on the visualization, click and drag the thumb on the slider in the top left of the visualization.

By default, a legend is displayed on the right side of the visualization, which contains information on node size, edge size, edge color, and so on.

If you filter or drill on a visualization, filter conditions are automatically added to the visualization’s local filter to customize your view. Because each visualization on a dashboard has its own separate local filter, these filter conditions are only used to filter the display of data in the selected visualization, and do not affect any other visualizations in the dashboard. You can easily remove these filter conditions to undo your changes.
A Network visualization requires a From attribute and a To attribute between which to draw the edges.

**Compare many charts side by side with a Graph Matrix visualization**

Visualizations such as a Graph Matrix make it easy to compare many charts side by side on one page. Each Graph Matrix square is an individual scatter plot. Now it is easy to compare performance in seconds, even from very large volumes of data.

A Graph Matrix visualization allows you to view your data in a chart containing multiple graphs. A designer can create the visualization to display the data in different graph styles. In the example below, the designer chose the vertical bar graph style.

A Graph Matrix visualization can be as simple or complex as you wish to make it. MicroStrategy can automatically place attributes and metrics on this visualization for you, or if you have a specific goal in mind you can follow the steps in the *MicroStrategy Web Help* and achieve that goal.

**Formatting a visualization**

Once you have added visualizations to an analysis, you can format a visualization by choosing whether to display its title bar, determine the format in which to display numeric values in the visualization, decide whether to apply banding to values in a grid, and so on. Individual
visualizations provide distinct formatting to enhance an analyst’s ability to view and read the data.

**Formatting a Heat Map visualization**

You can format several aspects of a Heat Map visualization. You can allow users to delete rectangles from the visualization, you can choose the algorithm used to size and position rectangles, and so on.

---

**To format a Heat Map visualization**

1. If the dashboard is not already open, click the name of the dashboard to run it.
2. Click the visualization you want to format.
3. If the Properties panel is not displayed, from the toolbar, click **Show**, then click **Edit Visualization**. Hover the cursor over the panel, then click the arrow icon in the top right and select the **Show Properties** option.
4. You can enable deleting rectangles from the visualization. If this option is enabled, users will be able to delete rectangles from the visualization by hovering over a rectangle and clicking the X icon. To allow rectangles to be deleted from the visualization, select the **Delete** check box.
5. You can enable zooming in and out of rectangles in the visualization by clicking them. To enable zooming, select the **Zoom** check box.
6. You can choose whether to display the metric values for each rectangle in the visualization. For example, you add Region, Profit, and Revenue to the visualization. The visualization displays rectangles for each customer region. You can select the **Show metric values** check box to display the profit and revenue data for the Mid-Atlantic region in the Mid-Atlantic rectangle, the profit and revenue data for the Northeast region in the Northeast rectangle, and so on. To show the metric values, select the **Show metric values** check box.
7. You can choose whether to label each rectangle with the name of the attribute element it represents. From the **Show Labels** drop-down list, select one of the following options:
   - To show the rectangle labels, select **On**.
• To display the rectangle labels with the size of each label reflecting the size of the rectangle, select Proportional. Rectangles that contain large values will be displayed with larger labels than rectangles that contain small values.

8 To determine the algorithm used to size and position rectangles, select one of the following options under Layout:

• To size the rectangles to make them as easy to read as possible, select Keep readability, not element order.

• To size and position the rectangles to make them as easy to read as possible, while still attempting to display them in the same order in which they appear in the visualization’s Drop Zones panel, select Balance readability and order.

• To position the rectangles in the same order in which they appear in the visualization’s Drop Zones panel, select Keep element order, not readability.

Adding and editing filters in a dashboard

An intuitive filter panel makes it easy to see the exact data you need. Filter on any business dimension and metric to change your view and better understand your data. Simple check-boxes, sliders, and radio buttons make it easy to use, and your selections are made instantly visible.

For example, a dashboard displays sales data for several different product categories, from 2007 to 2010. An analyst can filter the data in the analysis to only display sales data for books and movies in 2010. Add a few filters to your visualization to see this functionality in action.

To add a filter to the Filters panel

1 If the dashboard is not already open, click the name of the dashboard to run it.

2 From the Dataset Objects panel on the left, click and drag the attribute you want to use to filter data to the Filters panel.

3 Hover the cursor over the name of the filter you just added, then click the arrow icon. A list of options is displayed.
4 Point to **Display Style**, then select the style you want to use to display the filter:

- Check boxes
- Searchbox
- Slider
- Radio buttons
- Drop-down

5 You can include or exclude data using elements selected in the filter. Do one of the following:

- To display data in the dashboard only for selected elements, select **Include**.
- To display data in the dashboard for all elements except for the elements that are selected, select **Exclude**.

Once you have added an attribute filter to the Filters panel, you can create a new qualification filter based on the ranking of each element in the attribute. For example, you can add an attribute filter based on Category, then create a filter that displays data for the top three product categories by sales.

---

**To add a Top N qualification filter to the Filters panel**

1 If the dashboard is not already open, click the name of the dashboard to run it.

2 From the Filters panel, hover the cursor over the name of the attribute filter, then click the arrow icon. A list of options is displayed. Point to **Top N**.

3 From the first drop-down list, select one of the following:

- To create a qualification filter to display data for the top N elements in the filter, select **Highest**.
- To create a qualification filter to display data for the bottom N elements in the filter, select **Lowest**.

4 In the field, type the number of elements you want to include in the filter.
5 From the **Ranked By** drop-down list, select the report object you want to use to rank each element.

6 Click **OK**. Your filter is added to the Filters pane.

---

**To add a metric filter to the Filters panel**

1 If the dashboard is not already open, click the name of the dashboard to run it.

2 From the Dataset Objects panel, click the metric you want to use to filter data, and drag it onto the Filters panel. You can place the metric above or below the filters already displayed in the panel.

3 Hover the cursor over the name of the metric you just added, then click the arrow icon. Point to Display Style and select one of the following:
   - To filter data by creating a qualification based on a metric, select **Qualification**.
   - To filter data by choosing values on a slider, select **Slider**.

4 Hover the cursor over the name of the metric you just added, then click the arrow icon and select one of the following:
   - To filter on the metric’s values, select **Qualify on Value**. For example, you can display data only for stores with profit data greater than or equal to $1,000,000.
   - To assign a numeric rank to the metric values, where 1 is the highest metric value, and then filter by rank, select **Rank Highest**. For example, you can display data for the ten employees with the longest tenure in years.
   - To assign numeric rank to the metric values, where 1 is the lowest metric value, and then filter by rank, select **Rank Lowest**. For example, you can display data for the ten stores with the lowest costs.
   - To filter by the top N % of metric values, select **Rank % Highest**. For example, if eight items are displayed in a visualization, **Rank % Highest = 25** displays the top two items.
   - To filter by the bottom N % of metric values, select **Rank % Lowest**. For example, if eight items are displayed in a visualization, **Rank % Lowest = 25** displays the bottom two items.
5 Do one of the following:

- To allow users to filter data by creating a qualification on a metric, perform the following steps:
  
  a. Click Greater than or equal to. From the drop-down list, select the operator you want to use to compare data, such as Less Than or Equals.
  
  b. In the field, type the value you want to use to filter data, then press ENTER. The qualification is created.

- To allow users to filter data by choosing values on a slider, perform the following steps:
  
  a. Click and drag the endpoints of the slider to cover the range of values for which you want to filter data.
  
  b. You can choose to include or exclude data using the values selected in the slider. Hover the cursor over the metric name and click the arrow icon, then do one of the following:
     
     – To display data in the dashboard only for metric values selected in the slider, select Include.
     
     – To display data in the dashboard for all metric values except the values selected in the slider, select Exclude.

Determine whether to allow filters to restrict other filters.

Once you have created a dashboard, you can determine whether making selections in one filter in the Filters panel should affect the choices displayed for any other filter.

For example, you create a dashboard, then add the Category and Subcategory attributes to the Filters panel. You can enable selections in the Category filter to affect which product subcategories are displayed under Subcategory. If an analyst selects Books in the Category filter, the items in the Subcategory filter are restricted, and only product subcategories within Books are displayed.

To determine whether or not selections in one filter affect items in any other filter

1. Hover the cursor over the Filters panel, then click the arrow icon displayed in the top right of the panel. A list of options is displayed.
2 Point to Filter, then select one of the following:

- **No Filtering**: Elements selected in one filter do not change the items available in any other filter.
- **Filter All Below**: Making a selection in one filter restricts the items displayed in all the filters below it in the Filters panel (or to its right if the Filters panel is displayed at the bottom of the dashboard). This includes filters that are hidden.
- **Filter All**: Selecting an element in one filter restricts the elements displayed in every other filter.

### Allow a visualization to update the data displayed in another visualization

If you have multiple visualizations on a dashboard, you can enable users to filter or select elements in one visualization (the source) to automatically update the data displayed in another visualization (the target) on the same panel. You can:

- Enable users to filter or drill on data in the source visualization to update the data displayed in one or more target visualizations. For example, the source visualization may contain a list of product categories. When a user chooses the filter data in the source to include only data for the Movies category, the data in the target is automatically updated to display only data for Movies. Similarly, if the user drills to Subcategory in the source, the target will be updated to display data at the Subcategory level. Filtering or drilling on data in the target does not affect the data displayed in the source. Users can perform the following data manipulations in the source to automatically update the data in the target:
  - Filter data in the source to display only data for selected elements.
  - Filter data in the source to display all data, except the data for selected elements.
  - Drill on data in the source.
  - Edit the source visualization’s local filter.
- Enable users to select elements in the source visualization to restrict the data displayed in one or more target visualizations. For example, if the
target displays revenue data across several years and a user selects 2012 in the source, the data in the target is automatically updated to display only revenue data for 2012.

To enable a visualization to update the data displayed in another visualization

1 Click the arrow icon in the top right of the visualization you want to use as the source, then select Use as Filter. The Filtering Options dialog box is displayed.

2 You can enable users to update the data displayed in one or more targets by filtering or drilling on data in the source. Under Apply filtering to the following targets, select the check box next to each visualization you want to use as a target.

3 Once you have designated at least one visualization as a target, you can allow users to filter data in the target by selecting elements from a report object in the source visualization. From the Also filter targets when selecting elements of drop-down list, select one of the following:

   • To allow users to filter the data in the target by selecting elements in the source, select the name of the report object whose elements the users will select to filter data.

   • To disable filtering the data in the target by selecting elements in the source, select None.

4 Once you have enabled users to filter data displayed in the target by selecting elements in the source, you can allow users to clear any selections they have made in the target. Do one of the following:

   • To allow users to clear the selections in the source, select the Allow users to clear all selections check box. When a user clears their selection by deselecting all elements in the source, the target is updated to display data for all elements at once. For example, if the source is a Grid visualization that allows users to select from elements of Year to filter data in the target, the user can click the Year header to display data for all years in the target.

   • To disable clearing selections, clear the Allow users to clear all selections check box.

5 Click OK to apply your changes.
Analyzing your data

You can analyze data by manipulating the information in a visualization in multiple ways. For example, you can sort, drill, choose to include or exclude data for specific elements in a visualization, and so on. Users can customize their view of the data, update it, and display it instantly, using the following features.

Filtering, sorting, and drilling on data

You can filter the data displayed in a dashboard to display only the information that you require. For example, a dashboard displays sales data for several different product categories, from 2007 to 2010. You can filter the data in the grid to only display sales data for books and movies in 2010.

You can filter data based on:

- The elements of an attribute. The elements of a business attribute are the unique values for that attribute. For example, 2006 and 2007 are elements of the Year attribute, while New York and London are elements of the City attribute. You can filter based on a list of attribute elements belonging to an attribute. For example, the attribute Customer has elements which are individual customer names. If your data includes customer incomes, you can filter the data to display income for only those customers you specify in your filter’s list.

- The value of a metric. You can filter data by restricting the attributes in the filter based on the value of a metric. For example, a store manager wants to see sales numbers for products whose current inventory count falls below a certain level. You can filter the data to restrict what is displayed based on a specific inventory count Less Than 100 units, based on a given attribute, in this case certain products.

You can filter data on the entire dashboard, or only on a specific visualization on the dashboard.

When you filter data on the entire dashboard, your selections are applied to every visualization on the dashboard.

When you filter or drill on a specific visualization within the dashboard, filter conditions are automatically added to the visualization’s local filter to customize your view. Because each visualization has its own separate local filter, these filter conditions are only used to filter the display of data in the
selected visualization, and do not affect any other visualizations in the analysis. You can also remove these filter conditions to undo your changes.

To drill to or filter data in a Heat Map visualization

1. Click the name of the dashboard to run it.

2. Select one or more rectangles in the visualization by doing one of the following:
   - To select individual rectangles, hover the cursor over a rectangle in the visualization. You can select multiple rectangles by pressing CTRL, then clicking additional rectangles to select them. Click the arrow icon at the top of the selected rectangles.
   - To select all the rectangles in a lasso shape, click and drag over an area of the visualization to choose all the rectangles in the area. Click the arrow icon at the top of the selected rectangles.

3. From the context menu, select one of the following:
   - To drill to an object, select the attribute that you want to drill to. For example, to drill to the data at the Category level, select Keep Only and Show, then select the appropriate attribute. Only the rectangles you selected are displayed, and the attribute you selected is used to group rectangles in the visualization.
   - To display only the rectangles you have selected and remove all other rectangles from the visualization, select Keep Only.
   - To display all rectangles in the visualization except the rectangles you have selected, select Exclude.

Analyzing data in a visualization

You can sort attributes or metric values in a dashboard in ascending or descending order, or perform a more complex sort using multiple conditions. You can also rename an attribute or metric to help other users more easily identify appropriate information.
To analyze data in a visualization

1 In the visualization’s Drop Zones panel, hover the cursor over the name of the attribute or metric you want to use to sort data, then click the arrow icon on the right. A list of options is displayed.

2 Do any of the following:
   • To edit the visualization’s filter, point to **Edit Filter**, then do one of the following:
     □ To remove all filter conditions from the visualization at once, select **Clear All**. All filter conditions in the local filter are removed, and are no longer used to filter data in the visualization.
     □ To remove filter conditions one at a time, hover the cursor over each filter condition you want to remove, then click the X icon next to each condition. The filter conditions you delete are no longer used to filter data in the visualization.
   • To sort the attribute or metric values in ascending order, select **Sort Ascending**.
   • To sort the attribute or metric values in descending order, select **Sort Descending**.
   • To perform an advanced sort, select **Advanced Sort**. The Sort dialog box opens.
     a Do one of the following:
       – To sort by data in the rows, click the **Rows** tab.
       – To sort by data in the columns, click the **Columns** tab.
     b From the **Sort by** drop-down list, select the attribute form or metric to use to sort data.
     c Do one of the following:
       – To sort the data in ascending order, select **Ascending**.
       – To sort the data in descending order, select **Descending**.
     d Specify additional sorting criteria using the appropriate steps above.
     e Click **OK** to apply changes.
• To rename an attribute or metric, select **Rename**. A field displaying the name of the attribute or metric is displayed. Type a new name, then press **ENTER**. The object is renamed.

**Exporting a dashboard or a visualization**

You can export your whole dashboard to share it with others, or select just one visualization from your dashboard to export.

You can export a visualization to the following formats:

- **PDF file**: Export the visualization to a PDF file. You can view the PDF on any device with a PDF reader, such as another computer, a Linux machine, a Nook, or a Kindle. This option is available for Grid and Graph visualizations.

- **Excel file**: Export the visualization to a stand-alone Excel file, to view and interact with the data outside of MicroStrategy. This option is available for Grid and Graph visualizations.

- **Image**: Export the visualization as an image, similar to taking a screenshot.

- **Data**: Save the data in a visualization as a tabular CSV file. For example, a Graph visualization contains a line graph that displays revenue data across several different product categories. You can save the data in the visualization as a CSV file, with revenue data for each product category displayed in a tabular format, with values separated by commas.

To **export a dashboard**

1. Click the name of the dashboard to run it.

2. Perform one of the following, depending on the format you want to export to:

   - **PDF**: To export the dashboard as a PDF file, from the **PDF** drop-down list at the top of the dashboard, select **PDF**. The dashboard is exported to the PDF format and displayed in a browser window.
• **Flash**: To export the dashboard as a Flash file, from the PDF drop-down list at the top of the dashboard, select **Flash**, then perform the following steps:

  a A message is displayed informing you that you need to save a copy of the Flash file before opening it. Click **OK**.
  
  b Click **Save**. The Save As dialog box opens.
  
  c Type a name for the Flash file in the **File name** field, then click **OK**. Your file is saved.

• **Image**: To export the dashboard as an image, from the **Tools** menu, select **Export as Image**. The Select Location for Download dialog box opens. Navigate to the location in which you want to save the image, then specify a name for the image in the **File Name** field. Click **OK**. The image is saved.

---

**To export a specific visualization within the dashboard**

1 Click the name of the dashboard to execute it.

2 Hover the cursor over the title bar of the visualization you want to export, then click the arrow icon at the top right. Point to **Export**, then select one of the following:

  • **CSV**: To export the visualization as a CSV file, select **Data**. The Select Location for Download dialog box opens. Navigate to the location in which you want to save the CSV file and specify a name for the file in the **File Name** field. Click **OK**. The CSV file is saved.
  
  • **Image**: To export the visualization as an image, select **Image**. Navigate to the location in which you want to save the image and specify a name for the image in the **File Name** field. Click **OK**. The image is saved.
  
  • **Excel**: To export the visualization as an Excel file, select **Excel**. The File Download dialog box is displayed. Do one of the following:

    ▪ To open the Excel file, click **Open**. The visualization is exported and displayed.
    
    ▪ To save a copy of the Excel file, click **Save**. The Save As dialog box opens. Navigate to the location in which you want to save the Excel file and specify a name for the file in the **File Name** field. Click **OK**. The Excel file is saved.
• **PDF**: To export the visualization as a PDF file, select PDF. The visualization is exported and displayed.

### Emailing a dashboard or sending it to a History List

You can send a dashboard to any email address, to allow users to view it even when offline.

You can also send an emailed dashboard to the emailed user’s History List within MicroStrategy Web. The History List is a folder where you can have report and dashboard executions automatically sent, to be viewed later. This is a useful feature for very large reports or dashboards that may take some time to execute.

#### To email a dashboard or send one to a History List

1. Click the name of the dashboard to run it.
2. From the toolbar, click the **Send Now** icon. The Send Now dialog box opens.
3. Click **To** to locate the email address of the recipient. The Recipients Browser opens.
4. Choose an address from the **Available** list, then click > to add it to the **To** field. If you do not see the email address you want, you can specify a new email address using the following steps:
   a. Type a name for the email address in the **Address Name** field.
   b. Type the email address in the **Physical Address** field.
   c. From the **Device** drop-down list, select the email client type of the email address.
   d. Click **Add to Recipients**. The new email address is added to the To list.
5. Click **OK** to return to the Send Now dialog box.
6. From the **Send** drop-down list, specify where to deliver the dashboard by choosing one of the following options:
To display the dashboard in the email, select **Data in email**. The analysis is displayed in the email, but is not delivered to the History List.

To display the dashboard in the email and also deliver the dashboard to the History List, select **Data in email and to History List**. No link to the dashboard is provided in the email.

To display the dashboard in the email, deliver the dashboard to the History List, and provide a link to the History List location of the dashboard in the email, select **Data and link to History List in email**.

To deliver the dashboard to the History List, and provide a link to the location of the dashboard in the History List in the email, select **Link to History List in email**. The dashboard is not displayed in the email.

From the **Delivery Format** drop-down list, select the format in which you want to send the dashboard. Select one of the following:

- To deliver the dashboard as an HTML file, select **HTML**.
- To deliver the dashboard as a PDF file, select **PDF**.
- To deliver the dashboard as an interactive Flash file, select **Flash**.

Type a description for the emailed dashboard in the **Subject** field.

Type a message to be displayed in the body of the email in the **Message** field.

If you chose to send the dashboard in a zip file, you can specify options for the zip file, such as whether to password-protect its contents. Perform the following steps:

a. Click the **Show** icon to expand the **Advanced Options**.

b. To protect the zip file by providing a password, select the **Password Protect Zip File** check box, then type a password for the zip file in the field.

c. Type a name for the zip file in the **Zip File Name** field.

By default, if you have selected a contact group as the recipient of the dashboard, MicroStrategy uses the security filter of the contact group as a whole when delivering the dashboard. To use the separate security filters for each member of the subscribed contact group instead, select the **Use contact security for each group member** check box.

Click **OK**. The dashboard is sent to the designated email addresses.
Printing a dashboard

Dashboards are printed by converting them to a PDF file, and then printing the PDF file.

You must have Adobe Acrobat Reader version 4 or later installed on your computer.

To print a dashboard

1. Click the name of the dashboard to run it.
2. From the toolbar, select the Print icon. The dashboard opens in a PDF preview window.
3. Print the dashboard from the PDF preview.

Next steps

After you have completed your proof-of-concept or demo dashboard, you can use MicroStrategy Visual Insight along with the rest of the MicroStrategy platform products to achieve efficient and effective data discovery. For example, you can:

- Offer Visual Insight as an Enterprise Service to your organization’s business people: Build an array of subject-area data marts designed specifically for Visual Insight data discovery by your business users using MicroStrategy’s OLAP Services Intelligent Cubes.

- Offer Visual Insight as a better solution for personal BI and departmental BI: Find areas in your business where Excel and Microsoft Access are being used as personal databases or workgroup databases, and encourage users to upload data into MicroStrategy in order to explore their data in a much more powerful way using Visual Insight’s data discovery capabilities. Users can share sophisticated, visual analyses of their data with their workgroups.

For steps to install the rest of the MicroStrategy platform and evaluate other MicroStrategy products, see Chapter 3, Installing the MicroStrategy Evaluation Edition.
Introduction

This chapter discusses trends in the business intelligence market, introduces the MicroStrategy product suite, and describes the architecture of MicroStrategy Analytics Enterprise. It shows how the platform meets the needs of modern business intelligence applications.

This chapter covers:

• *Introduction to business intelligence, page 35*
• *MicroStrategy product overview, page 43*
• *MicroStrategy Analytics Enterprise technical architecture, page 51*

Introduction to business intelligence

Business intelligence (BI) is the insight gained from your business intelligence system. It allows you to fully leverage your data warehouse investment to facilitate informed decisions that benefit your business and your customers.
Many companies are using their data warehouse to make mission-critical decisions. The following customer profiles describe just two of the many success stories using the MicroStrategy platform.

**Leading national bank**

Before using a business intelligence system, a leading bank was unable to determine which of its 16 million customers were most valuable. To solve this common business problem, the company built reports against their 27-terabyte data warehouse. With the insight gained from these reports, they have more than doubled responses to their direct mail campaigns. They expect over $100 million in returns.

**Online vehicle marketplace**

One of the world’s largest online vehicle marketplaces sells advertising packages to auto dealers across the country. The company’s large mobile sales force spent hours preparing spreadsheets and printouts for each customer meeting. To improve sales force productivity, the company developed a mobile business intelligence app that provides comprehensive, real time access to information from anywhere in the field. This interactive mobile app enables sales representatives to instantly show customers the impact of their advertising campaigns. Not only are sales representatives more productive during each customer meeting, they have more time to spend pursuing additional sales opportunities.

**Other business intelligence applications**

Companies have discovered limitless ways in which business intelligence applications can help them run their businesses more efficiently. The following table lists some of the more common applications in which companies are using their business intelligence systems:

<table>
<thead>
<tr>
<th>Category</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer relationship management</td>
<td>Customer segmentation</td>
</tr>
<tr>
<td></td>
<td>Customer profitability</td>
</tr>
<tr>
<td>Supply chain management</td>
<td>Inventory analysis</td>
</tr>
<tr>
<td></td>
<td>Trade fund analysis</td>
</tr>
</tbody>
</table>
Business intelligence trends

Current trends in information technology (IT), specifically in business intelligence, affect your system requirements. Companies are placing heavy emphasis on how their business intelligence products meet the following challenges:

- Data and user proliferation
- Visual data discovery that allows for self-service analytics, while retaining the ability for data governance
- Seamless integration with mobile devices
- Cloud computing

MicroStrategy meets all of these challenges in the following ways.

<table>
<thead>
<tr>
<th>Category</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset management</td>
<td>Capital budgeting</td>
</tr>
<tr>
<td></td>
<td>HR allocations</td>
</tr>
<tr>
<td>Vendor performance analysis</td>
<td>Service level agreement</td>
</tr>
<tr>
<td></td>
<td>Charge-back analysis</td>
</tr>
<tr>
<td>Financial analysis</td>
<td>P&amp;L reporting</td>
</tr>
<tr>
<td></td>
<td>Profitability analysis</td>
</tr>
<tr>
<td>Sales performance analysis</td>
<td>Market basket analysis</td>
</tr>
<tr>
<td></td>
<td>Store/geographic analysis</td>
</tr>
<tr>
<td>Risk analysis</td>
<td>Risk management</td>
</tr>
<tr>
<td></td>
<td>Fraud detection</td>
</tr>
<tr>
<td>Operations analysis</td>
<td>Compliance reporting</td>
</tr>
</tbody>
</table>

Data and user proliferation

As time passes, both your data warehouse and the number of users on your system grows. The data warehouse grows because new days or months of data are added, or because new sources of data are added. With many companies, the data warehouse quickly reaches the multi-terabyte size. This is especially true for companies interested in analyzing web logs, which
generate massive amounts of data every day. The diagram below shows a few of the potential sources of data feeding into a data warehouse.

The number of users using the system also grows. Although the initial users of a business intelligence system may be within one department, more departments may be added. Sales people or managers across the country or the world may be added. Suppliers may be added. Even customers or consumers may be given access to the system.
To fully realize the potential of the data warehouse, a business intelligence platform must have a scalable architecture, one that can handle the addition of data and users without affecting the performance or quality of reporting.

**Visual data discovery**

A business intelligence system that includes powerful tools for visual data discovery—such as highly interactive charts, graphs, and visualizations—enables even non-technical users to quickly focus on business problems, discover information, and make decisions.

A central requirement to visual data discovery is the idea of governed self-service. As a company’s use of a business intelligence system matures, the primary users are more likely to be users without specialized technical skills. Visual data discovery tools should be designed from a user’s perspective, with a focus on interactivity and ease of use. At the same time, data discovery tools must remain accountable for the accuracy and consistency of data, across all platforms and all users.

A well-designed data discovery tool can include many features that improve business insights and increase user productivity, such as:

- Interactive data exploration, at levels commensurate with the various skill sets of users
- Rich functionality for creating and manipulating sophisticated reports, dashboards, calculations, and more
- Real time or near real time updates to information
- Shareable and reusable reports, documents, and dashboards
- Flexibility to add new data sources and join information from multiple data sources
- Collaboration with other users
- Integrated security and privacy controls
- Data governance capabilities to ensure a “single version of the truth”
- Deployment at scale
- Easy integration with an existing business intelligence platform
**Seamless integration with mobile devices**

Mobile devices are a ubiquitous feature of the workforce. A well-built mobile application available on a smartphone or tablet can provide a huge advantage to a company whose analytics and reporting needs extend beyond the desks at headquarters—to remote employees or supervisors on a factory floor, to customer service representatives and sales people in the field, to suppliers and partners, to customers, even to people without ready Internet access.

For a mobile application to satisfy its many users, the business intelligence platform must meet several requirements:

- Support for thousands of users or more
- 24/7 access to up-to-date information
- Fast performance and rich functionality for viewing and manipulating sophisticated reports, documents, and dashboards
- Familiar gesture-based interactions, such as tapping and swiping
- Compatibility with almost any mobile operating system
- Ability to write information back to a data source
- Access to cached data even without cellular or WiFi access
- Support for multimedia content
- Tightly integrated security and data privacy infrastructure
- Easy development and rapid deployment, with little or no coding required
- Integration with an existing business intelligence platform

**Cloud computing**

Companies seeking a rapid, affordable entry point to business intelligence are increasingly looking towards business intelligence platforms delivered through the cloud. A cloud-based platform can free a company from major up-front IT investments, as well as the ongoing cost and headache of maintaining this IT infrastructure. This allows you to instead focus your efforts on developing business intelligence tools to solve your users’ business problems.
A cloud-based platform should provide the same rich functionality as a traditional business intelligence platform. In addition, a cloud-based infrastructure must meet several unique requirements:

- Fast performance, preferably on an architecture optimized for speed and scalability
- Reliable, on-demand service
- Easy connection to multiple data sources, whether on-site or in the cloud
- Data integration and database services
- Access to the latest features and functionality
- Maintained by experienced technical personnel
- Tightly integrated security and data privacy infrastructure

**Summary**

Many companies already have some pieces of the business intelligence puzzle in place, and a well-constructed business intelligence platform easily fits in with your existing IT infrastructure. The following diagram shows how
the different layers of BI technology fit together to form a complete business intelligence framework.

- **Operational systems** collect and store business data. These systems usually are databases or mainframes, and the data that they store is typically limited to recent or current data.

- **Extraction, transformation, and loading (ETL)** software combines, cleanses, and moves data from the different operational systems to an integrated data warehouse.

- The **data warehouse** is a relational database that stores a long-term history of data, usually two to five years or more.

- The **BI platform** is where applications are created to analyze and manipulate the data in the data warehouse. The business intelligence platform requirements described in the previous sections are necessary for a well-designed, complete business intelligence solution.

- **BI applications** used to analyze the data are constructed using the business intelligence platform. Business analysts are fast to reap the benefits from creating their applications with the MicroStrategy platform, starting with the many prebuilt analytics available from MicroStrategy in diverse areas such as customer, sales, financial, or human resources analysis. For more information about the prebuilt analytics that
MicroStrategy offers, see *Viewing Business Intelligence Applications, page 199*.

MicroStrategy designed and built its MicroStrategy platform from the ground up with the goal of easy Internet and mobile accessibility, rapid deployment, intuitive visual data discovery capabilities, fast responses to report requests, and sophisticated analysis and reporting functionality.

The following diagram shows the rich set of business intelligence functionality that the MicroStrategy platform provides.

---

**MicroStrategy product overview**

The MicroStrategy Analytics Platform is designed to support a full range of analytic functionality, from interactive business dashboards to sophisticated statistical analysis and data mining. The comprehensive range of products
within MicroStrategy’s business intelligence platform provides the flexibility to start small, yet scale to an enterprise deployment as your needs grow.

This section describes the various products that make up the MicroStrategy Analytics Platform:

- MicroStrategy Desktop
- MicroStrategy Analytics Enterprise, consisting of the following products:
  - MicroStrategy Web
  - MicroStrategy Mobile
  - MicroStrategy Architect
  - MicroStrategy Server
- MicroStrategy Cloud

Each product is briefly described below.

**MicroStrategy Desktop**

MicroStrategy Desktop is a fast, user-friendly data discovery tool that is designed for self-service analytics. It empowers you to analyze and understand data without help from IT.

You can import data directly from spreadsheets, online sources, or a variety of supported databases, then simply drag and drop objects to create interactive dashboards. A rich set of capabilities for visual data discovery and reporting allow for robust analysis. Dashboards can be shared with MicroStrategy Web users.

MicroStrategy Desktop combines the powerful architecture of the MicroStrategy platform with MicroStrategy’s Visual Insight data discovery tool, to create a stand-alone product that is quick to install on your computer. Data is stored on-premises, and can be imported or analyzed even while offline.

MicroStrategy Desktop can be a compelling tool for a business department or small company that has business analysis needs but lacks the IT resources to support a traditional business intelligence platform. Companies with an existing MicroStrategy platform installation can also use MicroStrategy Desktop as a prototyping tool, to develop and refine dashboards before deploying them to Analytics Enterprise users.
MicroStrategy Desktop is not part of the evaluation provided in this guide; however, for a quick introduction to the features of MicroStrategy Desktop, see the *MicroStrategy Desktop Quick Start Guide*.

**MicroStrategy Analytics Enterprise**

MicroStrategy Analytics Enterprise is MicroStrategy’s enterprise-grade business intelligence platform. It provides support for a wide range of data sources, sophisticated capabilities for data modeling and reporting, and a comprehensive suite of administrative tools. The primary products available with Analytics Enterprise are described below.

**MicroStrategy Server**

MicroStrategy Intelligence Server is the architectural foundation of the MicroStrategy platform. Intelligence Server ensures the scalability and fault tolerance required for sophisticated analysis of terabyte databases and deployments to millions of users. MicroStrategy Intelligence Server is specifically optimized for all major relational databases and contains the load distribution, prioritization, and system tuning capabilities required for large-scale implementations. It also handles all communication with the relational data warehouse.

Report Services is part of MicroStrategy Intelligence Server and delivers the most flexible report layout, with drag-and-drop simplicity, and provides comprehensive formatting capabilities. Designers and Web Professionals (these are user roles in MicroStrategy) can build Pixel Perfect documents such as scorecards and dashboards, operational reports, invoices and statements, managed metrics reports, and more. These documents and dashboards can be distributed to MicroStrategy Web, Mobile, and Developer users. Designers can also quickly build visual, highly interactive dashboards, then distribute them to MicroStrategy Web and Mobile users.

OLAP Services is another part of MicroStrategy Intelligence Server that allows MicroStrategy Web and Developer users to manipulate shared, in-memory sets of data called Intelligent Cubes™. End users can add or remove report objects, add derived metrics, and modify filters—all with speed-of-thought response time using Intelligent Cubes. OLAP Services enables full multi-dimensional OLAP analysis within Intelligent Cubes, while retaining users’ ability to seamlessly drill through to the full breadth and depth of the data warehouse.
An additional Intelligence Server component is clustering, which lets you join multiple individual servers together without any additional software or hardware components. Built-in failover support ensures that if a server experiences a hardware failure, the remaining MicroStrategy Intelligence Servers pick up the failed jobs.

**MicroStrategy Web and MicroStrategy Web Universal**

MicroStrategy Web is a powerful and user-friendly environment for interactive analysis. A full set of capabilities for data browsing, drilling, and reporting development enable stream-of-consciousness navigation. Boardroom quality reports can be generated using a wide range of graphing and formatting options. Visual data discovery and analysis is made simple by creating interactive, presentation-quality dashboards using compelling visualizations with MicroStrategy Visual Insight.

MicroStrategy Web Universal is a version of MicroStrategy Web that provides Web-based query and reporting from a platform-independent architecture. MicroStrategy Web Universal runs on Microsoft® Windows®, Oracle® Solaris™, IBM® AIX®, Red Hat® Linux®, SUSE® Linux®, and HP-UX® operating systems and on a variety of application servers including IBM® WebSphere®, Oracle®, SAP NetWeaver® Application Server, JBoss Enterprise Application Platform, and Apache Tomcat.

All functionality for MicroStrategy Web and MicroStrategy Web Universal is exposed via a J2EE-compliant web API. Application logic is packaged in Java Beans for easy integration of MicroStrategy’s business intelligence functionality into websites, portals, and other applications.

MicroStrategy Web and MicroStrategy Web Universal come in the following versions:

- **Web Professional or Web Universal Professional**: Full-featured version lets you create Intelligent Cubes and reports for user consumption. Full reporting, ad hoc analysis, and OLAP capabilities are integrated with seamless ROLAP analyses.

- **Web Analyst or Web Universal Analyst**: Simplified version provides ad hoc analysis from Intelligent Cubes with interactive OLAP.

- **Web Reporter or Web Universal Reporter**: Enterprise reporting version allows you to view scheduled reports and interactively analyze data, with printing, exporting, and email subscription to reports.
For details about the specific features that each version includes, review the feature comparison chart at:

http://www.microstrategy.com/software/products/web/versions/

MicroStrategy Web and Visual Insight are part of the evaluation provided in this guide.

**MicroStrategy Office**

MicroStrategy Office brings business intelligence to the Microsoft Office productivity suite. With simple, one-click access to corporate data, MicroStrategy Office users can run any report from within Excel, Word, or PowerPoint for visually pleasing reports in a familiar environment. MicroStrategy Office also offers simple, one-click bulk refresh that repopulates multiple reports within one Office file. MicroStrategy Office, just like all of MicroStrategy’s integrated user interfaces, inherits all the MicroStrategy platform benefits such as security, prompting, centralized metadata, and scalability.

MicroStrategy Office provides access to MicroStrategy business intelligence functionality through Microsoft Office products, as described below:

- MicroStrategy Office browses and runs reports in a MicroStrategy project.
- MicroStrategy Office uses web services to request and display MicroStrategy reports in Microsoft Office products.
- Microsoft Office integration uses standard worksheets and tables as well as pivot tables/charts.

MicroStrategy Office is part of the evaluation provided in this guide.

**MicroStrategy Mobile**

MicroStrategy Mobile enables users to access business intelligence from devices such as iPhones, iPads, and Android phones and tablets.

You can quickly create mobile apps using the rich set of design capabilities in MicroStrategy Web or Developer, with no need for coding. Business analysts
can browse, drill, and interact with data displayed in a familiar, intuitive mobile app interface. You can also interact with the mobile device itself, such as using the camera to scan barcodes and take pictures, or using the device’s GPS capabilities for location-based analysis.

MicroStrategy Mobile inherits all the MicroStrategy platform benefits such as security, prompting, centralized metadata, and scalability.

Transaction Services is an available extension that allows MicroStrategy Mobile users to input information on their mobile devices and save it back to the data warehouse.

MicroStrategy Mobile is part of the evaluation provided in this guide.

**MicroStrategy Architect**

MicroStrategy Architect is a rapid development environment for business intelligence systems. The information-mapping module separates underlying information structures from project design applications, providing flexibility and a simplified visual environment for modeling your data.

Architect includes MicroStrategy Developer, MicroStrategy Architect (the tool), MicroStrategy Object Manager, and MicroStrategy Integrity Manager, all described below.

**MicroStrategy Developer**

MicroStrategy Developer is the business intelligence software component that provides integrated query and reporting, powerful analytics, and decision support workflow on the personal computing desktop. It provides a wide variety of features for online analysis of data.

Developer also contains all of the administrative tools and features available to configure, manage, and monitor MicroStrategy software. The interface itself is customizable to different users’ skill levels and security profiles.

MicroStrategy Developer comes in the following versions:

- **Developer**: Full-featured version for power analysts and application developers. With a full range of analytical functionality, a rich function library, and intelligent workflow, Developer is well suited for both report developers and power users.
• **Analyst**: Simplified version providing the basic interactive functionality required by managers.

MicroStrategy Developer is part of the evaluation provided in this guide.

**Audit, manage, and migrate changes from one environment to another**

An administrator can connect to multiple environments using a single graphical interface, monitor system and report usage, audit reports and documents for discrepancies, automate administrative tasks, migrate object changes through simple drag-and-drop functionality, and so on. These features are described individually below.

**MicroStrategy Object Manager**

You can easily migrate objects from one environment to another using drag-and-drop, copy-and-paste, and so on, using MicroStrategy Object Manager. Object Manager includes a tool called the Project Merge Wizard that lets you perform bulk object copying. Object Manager also supports bulk internationalization and object name customization of the metadata through the MicroStrategy Repository Translation Wizard. Object Manager is available as part of the MicroStrategy Architect product license.

**MicroStrategy Enterprise Manager**

As business intelligence usage increases, it becomes important for any organization to identify business intelligence usage patterns to deliver the right customer satisfaction level to the organization. MicroStrategy Enterprise Manager lets administrators monitor system and report usage, which in turn allows them to develop tuning strategies that can maximize performance. Enterprise Manager is available as part of the MicroStrategy Server product license.

**MicroStrategy Command Manager**

MicroStrategy Command Manager provides the ability to create text-based scripts and automate common administrative functionality. These text-based scripts can also run from the command line and are therefore available from inside third-party applications. MicroStrategy comes with hundreds of
default text scripts. Command Manager is available as part of the MicroStrategy Server product license.

**MicroStrategy System Manager**

Administrators can combine multiple sequential administrative tasks into a single workflow, then deploy the workflow at a scheduled time or on demand, with MicroStrategy System Manager. These workflows can be deployed using a standard interface, an interactive command line process, or a completely silent configuration process. System Manager is available as part of the MicroStrategy Server product license.

**MicroStrategy Integrity Manager**

As a business intelligence system grows to encompass multiple production and development environments, it becomes important to ensure that changes to an environment do not alter any of your results. MicroStrategy Integrity Manager is an automated comparison tool that lets administrators compare reports and documents across environments, streamlining the process of identifying and resolving discrepancies. Integrity Manager is available as part of the MicroStrategy Architect product license.

**MicroStrategy SDK**

MicroStrategy SDK creates an open architecture that enables developers to integrate, extend, and fully exploit the power of the MicroStrategy platform through a set of rich APIs that fully expose all platform functionality. Businesses can leverage this powerful development environment to rapidly deploy custom applications and embed intelligence into any website. For more information about customizing and embedding MicroStrategy functionality, see the MicroStrategy Developer Library (MSDL).

**MicroStrategy Cloud**

MicroStrategy Cloud delivers business intelligence as a service, providing the comprehensive functionality of Analytics Enterprise—including sophisticated reporting, analysis, and mobile analytics capabilities—through the cloud.
Subscribers have the option to host their data warehouse on-premises or in MicroStrategy’s secure cloud. MicroStrategy maintains the software and hardware infrastructure, hosts metadata, and performs most administrative tasks, enabling companies to implement their business intelligence solution more quickly and simply than through a traditional platform.

MicroStrategy Cloud is configured for high performance and consistent reliability. In addition, MicroStrategy Cloud is engineered with a robust security framework based on industry-standard physical, technical, and operational controls, to ensure your sensitive data remains secure.

For more information about the features, architecture, and security of MicroStrategy Cloud, visit http://www.microstrategy.com/cloud.

**MicroStrategy Analytics Enterprise technical architecture**

With all of the requirements of an enterprise class business intelligence system in mind, MicroStrategy has produced a tightly integrated platform solution written in C++ and Java with Visual Basic, J2EE, and .NET interfaces. There are two front end layers—one built using JSP, the other using ASP.NET— which provides the flexibility to run on a variety of operating systems.

The platform uses a COM-compliant, parallel processing architecture that conveys the ability to reallocate processor and computing resources based on the nature of the current reporting load. COM is a Microsoft standard software architecture that allows applications and systems to be built from different components. COM components are:

- Built using interoperability standards
- Programming language-independent
- Available on different operating systems
- Easy to troubleshoot
- Easy to upgrade

As described above, Analytics Enterprise consists of a number of tightly integrated products, shown in the following diagram, which provide the following functionality:
• Report servers
• Interactive reporting and analysis
• Information delivery and alerting
• Design
• Administration
• Database write-back
• Integration with other applications
**Data layer**

The MicroStrategy business intelligence system rests atop a data layer, highlighted in the following diagram.

This layer includes the following systems or databases:

- Metadata repository
- Relational data warehouse(s)
- Non-relational data stores
- OLTP (online transaction processing) systems
- Web systems

The metadata repository contains information used by all the MicroStrategy products to operate. The rest of the data layer consists of different systems, which contain data that can be passed to clients in MicroStrategy reports or delivery services. MicroStrategy supports a wide range of data sources,
including relational data warehouses such as Oracle, DB2, SQL Server, Sybase, Teradata, Informix, Salesforce.com, and Hadoop, as well as non-relational data stores such as Excel, text, and flat files.

The platform can also write data back to these systems, enabling what-if analysis and closed-loop transactions.

MicroStrategy was the first to provide Query Tone™—a concept similar to a dial tone, where data is available at your fingertips, anytime and anywhere. With Query Tone, MicroStrategy users can perform advanced analysis and high-performance queries to get exactly the information they need, where they need it, to improve performance across the enterprise.

**Report servers**

MicroStrategy Intelligence Server (highlighted in the diagram below) is the primary report server, providing on-demand interactive reports and
scheduled or triggered proactive reports to users in a variety of formats and interfaces.
Interactive reporting and analysis

The interactive reporting and analysis interfaces (highlighted in the diagram below) allow users to perform on-demand reporting and data manipulation.

The interactive interfaces include standard and customized solutions, and are accessible through a web browser, a mobile app using a smartphone or tablet, or a client/server interface. The following table shows the options:
The web browser applications such as MicroStrategy Web and MicroStrategy Web Universal access MicroStrategy’s reporting functionality and the MicroStrategy Intelligence Server through a web server (highlighted in the diagram below).

Similarly, mobile apps such as the MicroStrategy Mobile client application access MicroStrategy’s reporting functionality and the MicroStrategy
Intelligence Server through the MicroStrategy Mobile Server (highlighted in the diagram below).

Users of the Microsoft Office productivity suite can browse and run all MicroStrategy reports from within Excel, Word, and PowerPoint with simple, one-click access to corporate data through MicroStrategy Office.
Information delivery and alerting

The proactive information delivery and alerting interfaces (highlighted in the diagram below) allow users to receive information delivered on a schedule or only when a certain condition is triggered.
Design

The MicroStrategy business intelligence platform comes with design products (highlighted in the diagram below) to speed project development.

Project designers can:

Administration

A suite of administration products (highlighted in the diagram below) enable fast, simple, and centralized administration.

Administrators can:

- Analyze business intelligence usage patterns, then develop performance tuning strategies to deliver the highest business intelligence satisfaction, with MicroStrategy Enterprise Manager.

- Automate and schedule routine administrative tasks through scripted commands and run them either from the interface or from the command line, with MicroStrategy Command Manager.

- Manage and migrate object changes across multiple environments with MicroStrategy Object Manager.

- Automatically detect the impact of changes to the business intelligence ecosystem with MicroStrategy Integrity Manager.
• Combine multiple, sequential administrative tasks into a single workflow, then deploy the workflow at a scheduled time or on demand, with MicroStrategy System Manager.

Integration and customization

Integration with existing systems and the ability to build customized applications is possible through the MicroStrategy Software Development Kit (SDK), and the set of open APIs and supporting API documentation that come with every MicroStrategy product (highlighted in the diagram below).

Each of the MicroStrategy products—such as MicroStrategy Server and MicroStrategy Web—is built using the MicroStrategy SDK and APIs, and the products can be customized, extended, and integrated with other products using the SDK and APIs.
Introduction

This chapter tells you how to install and activate the MicroStrategy Evaluation Edition on your machine.

It also provides the hardware and software requirements for the MicroStrategy Evaluation Edition and steps to install and uninstall MicroStrategy products.

MicroStrategy Evaluation Edition system requirements

Although the MicroStrategy platform can be deployed across multiple machines that are networked together, the most convenient configuration for evaluating MicroStrategy is to install and run the products on your laptop or desktop computer. The following sections describe the system requirements for the MicroStrategy Evaluation Edition. For information about sizing a production installation, refer to the Installation Considerations section in
Installing the MicroStrategy Evaluation Edition

Introduction to MicroStrategy

the Planning Your Installation chapter of the Installation and Configuration Guide (see Resources, page xviii).

Although you will run the entire MicroStrategy platform on one machine for this evaluation, you should never do this in a production environment. In production, you should distribute the products across multiple machines that are networked together.

For the evaluation, it is assumed that one to four users are using the system.

Hardware requirements

For the most up-to-date hardware requirements, view the Readme. To access this file, from the Windows Start menu point to Programs, then MicroStrategy Documentation, and then select Readme.

The following hardware recommendations ensure that you should see acceptable performance while evaluating the MicroStrategy platform. For the evaluation, it is assumed that one to four users are using the system.

• Processor: x64-compatible
• Memory (RAM): 4 GB or more
• Minimum storage space required: Three times the amount of RAM available to Intelligence Server. For example, an Intelligence Server that has 4 GB of RAM requires 12 GB of hard drive space.

Regardless of where you choose to install the Evaluation Edition, you must have at least 1 GB of free space on your C: drive for a set of system files that MicroStrategy installs. For example, even if you choose to install the entire Evaluation Edition on your D: drive, 1 GB of system files will still be installed on your C: drive. This storage requirement is in addition to the minimum storage space described in the list above.

Software requirements

For the most up-to-date software requirements, view the Readme. To access this file, from the Windows Start menu point to Programs, then MicroStrategy Documentation, and then select Readme.
The following software is required for the MicroStrategy Evaluation Edition:

- **Microsoft Windows operating system:**
  - Windows 2008 Standard Edition SP2 (on x64)
  - Windows 2008 Enterprise Edition SP2 (on x64)
  - Windows 2008 Standard Edition R2 SP1 (on x64)
  - Windows 2008 Enterprise Edition R2 SP1 (on x64)
  - Windows Server 2012 Standard (on x64)
  - Windows Server 2012 Standard R2 (on x64)
  
  It is recommended that, if you install MicroStrategy server products on Windows 7 or Windows 8, you do so for evaluation purposes only. For a production environment, install MicroStrategy server products on one of the other MicroStrategy-certified operating systems.

- Windows fonts display set to small fonts (96 dpi)
- Microsoft Internet Information Services (IIS) version 7.x or 8.x
- Browser:
  - Microsoft Internet Explorer version 8.x, 9.x, 10.x, or 11.x
  - Firefox version 36.x or 37.x
  - Google Chrome 41.x or 42.x
- Microsoft .NET Framework 4.0 or 4.5. This must be installed before installing MicroStrategy.
- Display set to 16 bit colors or higher
- Adobe Reader version 10.x or 11.x
- Adobe Flash Player version 15.x, 16.x, or 17.x
- For evaluating MicroStrategy Office, Microsoft Office (Microsoft Excel, Microsoft PowerPoint, or Microsoft Word):
  - Microsoft Office 2007 SP3
  - Microsoft Office 2010 SP2
  - Microsoft Office 2013 SP1
  - Microsoft Office 365
• For evaluating MicroStrategy Mobile:
  ▪ MicroStrategy Mobile for iPhone:
    – iPhone iOS 7.x or 8.x
    – iPhone 6 Plus, iPhone 6, iPhone 5S, iPhone 5C, iPhone 5, iPhone 4S, iPhone 4, or iPod Touch 5th generation devices
  ▪ MicroStrategy Mobile for iPad:
    – iPad iOS 7.0.x, 7.1.x, or 8.x
    – iPad 3 Wi-Fi or iPad 3 Wi-Fi + Cellular devices (New iPad)
    – iPad 4 Wi-Fi or iPad 4 Wi-Fi + Cellular devices (iPad with Retina display)
    – iPad Mini Wi-Fi or iPad Mini Wi-Fi + Cellular devices
    – iPad Mini 2Wi-Fi or iPad Mini 2 Wi-Fi + Cellular devices
    – iPad Air Wi-Fi or iPad Air Wi-Fi + Cellular devices
  ▪ MicroStrategy Mobile for Android:
    – Android OS 4.1 or later
    – Android devices with the following Graphics Processing Units (GPU):
      – Adreno 2xx
      – Adreno 3xx
      – ARM Mali-4xx MP4
      – ARM Mali-T6xx
      – GeForce
      – PowerVR SGX 5xx

Refer to the third-party documentation for your Android device vendor to determine the GPU for your device.
Prerequisites for installation

Use the following checklist to ensure that you are prepared to install the MicroStrategy Evaluation Edition:

- If you have not uninstalled previous versions of MicroStrategy products, you will be prompted during the installation process to overwrite them. You should click Yes to ensure that all evaluation products are installed properly. To retain any existing MicroStrategy Tutorial metadata repository and warehouse, rename it or move it to another location before you start the installation process.

- Although MicroStrategy supports Windows Terminal Services, using Windows Terminal Services is not recommended for installation. It can affect the functionality of some MicroStrategy components.

- To install MicroStrategy products, you must log on to your machine using a domain account with Windows administrative privileges for the domain or target machine. The domain must include your database servers.

- Review the hardware and software requirements listed above to ensure that the machine you intend to install the MicroStrategy Evaluation Edition on is sufficient.

- During the installation registration process, you need to provide your email address and the promotion code:
  - If you received the disk for the Evaluation Edition, the promotion code can be found on the inside of the evaluation disk mailer.
  - If you downloaded the Evaluation Edition, the promotion code can be found in the Welcome communication from MicroStrategy.
  - If you do not have a promotion code, contact MicroStrategy Technical Support (see Consulting, page xxvii).

Installing the MicroStrategy Evaluation Edition

This section helps you install the evaluation version of the MicroStrategy platform in a Windows environment using the MicroStrategy Installation Wizard.
For the most up-to-date installation information, view the ReadMe file. To access this file, from the Windows Start menu point to Programs, then MicroStrategy Documentation, and then click Readme.

Installing MicroStrategy with the MicroStrategy Installation Wizard

During the installation process for the Evaluation Edition, it is recommended that you accept all default selections.

To install MicroStrategy Evaluation Edition

1. Log on to the machine where you are installing one or more MicroStrategy products.

2. Exit all Windows applications before beginning the installation process.

3. Begin the installation process in one of the following ways:

   • From the disk: Insert the disk into the disk drive and wait for the MicroStrategy Main Menu window to display automatically.
     
     If the MicroStrategy Main Menu does not display, locate and run the MicroStrategy.exe file.

   • From the download site: Download the files from the MicroStrategy download site. Locate and run the MicroStrategy.exe file.
     
     Note the following:
     
     – Contact your MicroStrategy sales representative to determine the location and login credentials for the MicroStrategy download site.
     
     – You may have to extract the downloaded files to locate the MicroStrategy.exe file.

4. Click Evaluate Software.

   • If you do not have a license key, click Request Evaluation License Key to obtain one. This takes you to the MicroStrategy website (you need Internet access) where you can register your MicroStrategy Evaluation Edition. Provide your email address and the promotion code found on the inside of the evaluation disk mailer. If you
downloaded the Evaluation Edition, the promotion code can be found in the Welcome communication from MicroStrategy.

If you do not have a promotion code, contact MicroStrategy Technical Support (see *Consulting, page xxvii*).

5 Click **Install MicroStrategy Platform**.

- If this is the first time you have installed MicroStrategy, you are prompted to choose the language for the wizard. Select the appropriate language from the drop-down list and click **OK**.

6 The MicroStrategy Installation Wizard opens and walks you through the rest of the installation process.

- If any services are running for previously installed MicroStrategy products, you are prompted to stop them. Click **Yes** to proceed. If you click **No**, you cannot install MicroStrategy products until you stop all MicroStrategy services.

7 Click **Next** at the Welcome screen.

8 Read the license agreement, and accept or decline the agreement by clicking the appropriate button. If you choose to decline, you cannot install MicroStrategy products.

- Click **Print** to print a copy of the license agreement for your records.

The license key for the Evaluation Edition expires 30 days from the time you install MicroStrategy software.

9 Enter the required customer information and license key, and click **Next**.

If you do not have a license key for the Evaluation Edition, contact Technical Support to obtain a license key (see *Consulting, page xxvii*).

10 Specify the locations where the MicroStrategy products and MicroStrategy common files are to be installed. For the evaluation, you can use the default locations. Click **Next**.

11 If you are prompted to stop your MicroStrategy Web server, click **Yes**. If you click **No**, you cannot continue with the installation until you stop your MicroStrategy Web server.

12 Select the check box next to each MicroStrategy product you want to include in the installation. Clear a check box to uninstall or exclude that
MicroStrategy product from the installation. Each product is described below. Click **Next** when you have selected the products to install.

For this evaluation, it is recommended that you accept all default product selections. This ensures that all the components necessary for this evaluation are installed.

- **MicroStrategy Developer** lets you create projects and design reports and documents. MicroStrategy Developer products include MicroStrategy Architect, which is used to build reporting applications.

- **MicroStrategy Command Manager, Object Manager, and Enterprise Manager** are a suite of tools that facilitate specific administrative tasks. These tasks include handling large numbers of system users, user groups, and other system-level objects; tracking and analyzing system traffic; replicating project information; and upgrading distributed projects. These tools are not covered in this guide. For detailed information about these tools and their capabilities, refer to the *MicroStrategy Supplemental Reference for the System Administration Guide* (see *Resources, page xviii*).

- **MicroStrategy Intelligence Server** is an industrial-strength analytical server optimized for enterprise querying, reporting, and OLAP analysis. For more information about Intelligence Server and its capabilities, see the *MicroStrategy System Administration Guide* (see *Resources, page xviii*).

- **MicroStrategy Web** provides query and reporting functionality using a browser. For information about this product and its capabilities, see *Viewing Reports in a Web Browser, page 111*.

- **MicroStrategy Office** allows you to integrate the MicroStrategy platform with Microsoft® Office products as described in *Viewing Reports in Microsoft Excel, PowerPoint, and Word, page 133*. Since this application is built using MicroStrategy Web Services, you must also install Web Services if you want to evaluate this product.

- **MicroStrategy Web Services** is required to evaluate MicroStrategy Office. Web Services integrates MicroStrategy Web with the Simple Object Access Protocol (SOAP) and Web Services Description Language (WSDL) Internet technologies.

- The **Analytics Module** is a set of predesigned reports and documents built using the MicroStrategy platform. You can use the reports and documents as examples for designing your own. The module can also be mapped directly to your existing data warehouse as opposed to being hard-coded to a vendor-provided data model and data warehouse.
MicroStrategy Tutorial is included as part of the Analytics modules. MicroStrategy Tutorial is a sample MicroStrategy project (metadata and warehouse are included) with a set of demonstration reports and documents designed to illustrate the rich functionality of the MicroStrategy platform.

The MicroStrategy Analytics Module and Tutorial projects are installed automatically as part of any evaluation. They are not listed among the components you can select to install, but are automatically installed.

For more details about each of these products, see the *MicroStrategy Installation and Configuration Guide*.

**To activate the MicroStrategy Evaluation Edition**

If you have installed one or more MicroStrategy Server products, it is recommended that you request an Activation Code to activate your MicroStrategy Server products before the installation process ends. MicroStrategy Server products include:

- MicroStrategy Intelligence Server
- MicroStrategy Web or Web Universal

You have seven calendar days to activate your installation. If you do not complete the activation before this period expires, your MicroStrategy products stop functioning until you activate the installation.

13 Read the information on the Welcome screen and click **Next**.

14 On the Server Information page, specify information about your Intelligence Server installation. Enter the following characteristics and click **Next**:

- **Name**: The name of this Intelligence Server installation. This distinguishes it from any other Intelligence Server installations in your company.
- **Location**: The physical location of the machine on which this Intelligence Server is installed.
- **Use**: A description of how Intelligence Server is used.

   Click **Privacy Statement** to view the MicroStrategy Privacy Statement.
15 On the Installer Information page, specify contact information for the person installing the evaluation software and click Next. For descriptions of what information to include in the text fields, press F1 to view the MicroStrategy Help. (After your installation is complete, an email containing the activation code is sent to the email address you specify in this step.)

16 If you indicated that you are not an employee of the company licensed to use this software, and are installing the software on behalf of that company, the Contact Information page appears.

Specify contact information for the employee licensed to use the evaluation software and click Next. For descriptions of what information to include in the text fields, press F1 to view the MicroStrategy online help.

17 Select whether you want to request an activation code now or at a later time and click Next:

- Select Yes, I want to request an Activation Code now to request an activation code. The activation code is sent to the email addresses specified in the Installer Information and Contact Information pages.

- Select No, I will request the Activation Code at a later time to request an activation code at a later time.

If you choose to request an activation code at a later time, a message is displayed that instructs you how to request an activation code after the installation procedure is completed. For more instructions on requesting an activation code at a later time, see Requesting an activation code at a later time, page 77.

To install MicroStrategy Web and MicroStrategy Office

18 If you chose to install MicroStrategy Web, the MicroStrategy Web page appears.

- This page does not appear if you have a previous version of MicroStrategy Web installed.

Accept the default, MicroStrategy, as the home location for the ASP.NET pages used by MicroStrategy.

This is the Internet Information Services (IIS) virtual directory to be created for MicroStrategy Web pages. In IIS, a virtual directory is the home location for a set of Web pages that the Web server hosts.

Be aware of the following:
– The name provided for a virtual directory must be unique. You cannot use the same name as the default for other MicroStrategy products.

– If you have a previous version of MicroStrategy Web installed on the machine, the new version you install uses the same virtual directory the previous version is using. Therefore, you are not prompted to specify the name of the virtual directory.

19 Click Next.

20 If you chose to install MicroStrategy Web Services (a required component to evaluate MicroStrategy Office), the MicroStrategy Web Services page appears.

• This page does not appear if you have a previous version of Web Services installed.

Accept the default, MicroStrategyWS, as the IIS virtual directory to be created for MicroStrategy Web Services pages.

This is the name of the IIS virtual directory to be created for the Web Services pages. In IIS, a virtual directory is the home location for a set of Web pages that the Web server hosts.

The name provided for a virtual directory must be unique. You cannot use the same name as the default for other MicroStrategy products.

To learn more about MicroStrategy Web Services, refer to the MicroStrategy Web Services Administration Guide (see Resources, page xviii).

21 Click Next.

22 If you chose to install Intelligence Server, the MicroStrategy Intelligence Server page opens.

• This page does not appear if you have a previous version of Intelligence Server installed.

Select the check box to have the service run under the local system account.

The MicroStrategy Intelligence Server service requires a Windows account with administrative privileges under which to run.

23 Click Next.
If you chose to install MicroStrategy Office, the MicroStrategy Office URL page opens.

- This page does not appear if you have a previous version of MicroStrategy Office installed.

Assuming that you kept the default value on the MicroStrategy Web Services page and you are installing on the same Web server machine that is hosting MicroStrategy Web, click **Next** to use the default URL provided: http://localhost/MicroStrategyWS/MSTRWS.asmx

The MicroStrategy Office client requires the MicroStrategy Web Services URL to access MicroStrategy projects. The URL depends on the name of the IIS virtual directory that you specified on the MicroStrategy Web Services page above. The default virtual directory name is MicroStrategyWS.

If you chose to install MicroStrategy Office, the MicroStrategy Office configuration page appears.

- This page does not appear if you have a previous version of MicroStrategy Office installed.

Select all of the check boxes to enable MicroStrategy Office in Microsoft Excel, PowerPoint, and Word.

This enables MicroStrategy Office for the associated Microsoft applications. You can configure MicroStrategy Office to integrate with Microsoft® Excel, Microsoft® PowerPoint®, or Microsoft® Word. The MicroStrategy Office toolbar is added to the Microsoft Office applications that you select.

Click **Next**.

The Start Copying Files page displays a summary for your installation.

- To print a copy of this information for your records, click **Print**.

Click **Install** to continue with the installation process, which may take several minutes depending on your computer’s hardware configuration.

**To complete your installation**

When the installation process is finished, click **Yes** to read the readme file or **No** to go to the MicroStrategy Install Wizard Complete page.
29 If the option to restart your machine appears, it is recommended that you select **Yes I want to restart my computer now** to ensure that the installation process finishes correctly.

30 Click **Finish** to complete the installation.

---

**Activating your installation**

Once you request an activation code and installation is complete, an email is sent to the email address you specified in the Installer Information or Contact Information pages during installation. The email provides instructions on how to use the requested activation code to activate your software.

This procedure assumes that you have requested an activation code and received an email from MicroStrategy containing the activation code.

1 Start License Manager. From the Windows **Start** menu, point to **Programs**, then **MicroStrategy Tools**, and then select **License Manager**. License Manager opens.

2 Select the **License Administration** tab. Under Server Activation select the **Activate Server Installation** option and click **Next**.

3 Select the **Server Activation using Activation Code** option and enter your activation code in the text field.

   The activation code can be found in the email sent by MicroStrategy upon request of an activation code.

4 Click **Next** to activate your software installation.

5 A verification message is displayed. Click **OK**.

You must restart your Web server and MicroStrategy Intelligence Server to update the activation status.

---

**Beginning the evaluation**

When you are finished installing the evaluation software, your computer restarts, and you log back in, the Installation Wizard completes the
installation and the MicroStrategy Welcome screen opens automatically as shown in the following image.

If the Welcome screen does not open, you can open it from the Windows Start menu. Point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

To begin the guided tour of the MicroStrategy platform, from the Welcome Screen click View reports in a Developer application and skip to Viewing Reports in MicroStrategy Developer, page 83.

Alternative evaluation experiences include the following:

- To evaluate MicroStrategy Architect, click Build your own reporting application and skip to Building a Reporting Application, page 175.

- To explore the Analytics Module, click View other Business Intelligence Applications and skip to Viewing Business Intelligence Applications, page 199.
Activating the Evaluation Edition at a later time

If you did not submit an activation code during installation, then you have seven calendar days after your MicroStrategy installation is complete to activate your installation.

To activate your installation you must obtain an activation code from MicroStrategy. If you did not complete this when you installed MicroStrategy, you can do so using the MicroStrategy License Manager.

For answers to commonly asked questions about activation, see the activation FAQ in the Activating Your Installation chapter of the MicroStrategy Installation and Configuration Guide.

This section provides the two procedures you must complete to activate your installation:

- Requesting an activation code at a later time, page 77
- Verifying your installation, page 79

Requesting an activation code at a later time

If you did not request an activation code during the installation process of your MicroStrategy evaluation software, you can request the code at a later time using the procedure below.

When you request an activation code you supply MicroStrategy with important information related to your installation. The information you provide helps MicroStrategy understand how you plan to use MicroStrategy software. With this information MicroStrategy can provide better information and technical support for your software configuration.
To request an activation code

If you requested an activation code during installation, you can skip this procedure and activate your installation by following the instructions in the next procedure, *Verifying your installation, page 79.*

1 Start License Manager.

- In Windows: From the Windows *Start* menu, point to *Programs*, then *MicroStrategy Tools*, and then select *License Manager*. License Manager opens.

2 Select the *License Administration* tab. Under Server Activation select the *Activate Server Installation* option and click *Next*.

3 Select the *Generate Activation File and Request Activation Code* option and click *Next*.

4 Enter the characteristics of your server installation and click *Next*.

5 Enter the contact information for the person who installed the software. Make sure to correctly select whether you are an employee of the licensed company or installing the software on the licensed company's behalf:

- If you are an employee of the licensed company, select that option and click *Next*. Once you complete the following step, the activation code is sent to the email address given; therefore it is important that the email address is valid and entered correctly.

- If you are not an employee of the licensed company, select that option and click *Next*. Enter the contact information for the licensed company on the next page and click *Next*. Once you complete the following step, the activation code is sent to the email address given; therefore it is important that the email address is valid and entered correctly.

6 Select *Yes, I want to request an Activation Code now* and click *Next*.

An email containing the activation code is sent to the email address or addresses you specified in the steps above. Follow the instructions in that email to activate your MicroStrategy installation.
Activating your installation at a later time

Once you request an activation code, an email is sent to the email address you specified in the Installer Information or Contact Information pages during installation. The email provides instructions on how to use the requested activation code to activate your software.

This procedure assumes that you have requested an activation code and received an email from MicroStrategy containing the activation code.

To activate your installation

1. Start License Manager. From the Windows Start menu, point to Programs, then MicroStrategy Tools, and then select License Manager. License Manager opens.

2. Select the License Administration tab. Under Server Activation select the Activate Server Installation option and click Next.

3. Select the Server Activation using Activation Code option and enter your activation code in the text field.

   The activation code can be found in the email sent by MicroStrategy upon request of an activation code.

4. Click Next to activate your software installation.

5. A verification message is displayed. Click OK.

You must restart your Web server and MicroStrategy Intelligence Server to update the activation status.

Verifying your installation

During the installation process, the MicroStrategy Installation Wizard gathers and records information about your system and your installation selections. You can verify installation setup information through the installation log file (install.log), located by default in C:\Program Files\Common Files\MicroStrategy.
The installation log file includes the following information:

- Installation date
- Target directories
- Program folder name
- Operating system identification
- Hardware specifications
- Selected installation options
- Registry paths
- List of registered files

The installation log file can be helpful if you encounter errors during the installation process. For example, the log can tell you if a registry key or path was not added or if a critical file was not registered successfully.

**Uninstalling MicroStrategy components**

This section describes the procedure to uninstall MicroStrategy products. The uninstallation of MicroStrategy Office must be performed separately. The procedure for uninstalling MicroStrategy Office is explained in *Uninstalling MicroStrategy Office, page 81.*

**To uninstall MicroStrategy components**

To uninstall MicroStrategy products, you must log on to your computer using an account that has Windows administrative privileges for that computer.


2. From the Windows **Start** menu, select **Settings**, and then **Control Panel**. The Control Panel window opens.

3. Double-click **Add/Remove Programs**. The Add/Remove Programs dialog box opens.
4 Select **MicroStrategy** and click **Change/Remove**. The MicroStrategy Setup Maintenance program opens.

5 Select **Remove** and click **Next**.

6 Click **Yes** to any prompts that appear.

7 If you are prompted to stop your Web server, click **Yes**.

8 After the uninstall routine is complete, select **Yes** to restart your computer, or **No** to restart it later.

9 Click **Finish** to close the maintenance program.

---

**Uninstalling MicroStrategy Office**

MicroStrategy office must be uninstalled separately from other MicroStrategy products. This section describes the uninstallation procedure for MicroStrategy Office.

---

**To uninstall MicroStrategy Office**

1 Close all MicroStrategy products.

2 From the Windows **Start** menu, select **Settings**, and then **Control Panel**. The Control Panel window opens.

3 Double-click **Add/Remove Programs**. The Add/Remove Programs dialog box opens.

4 Select **MicroStrategy Office** and click **Change/Remove**. The MicroStrategy Office Setup Maintenance program opens.

5 Select **Remove** and click **Next**.

6 Select **Yes** to continue with the uninstallation procedure. To stop the uninstall process, select **No**.

7 After the uninstallation routine is complete, click **Finish** to close the maintenance program.
Modifying or repairing MicroStrategy components

You can modify or repair MicroStrategy components by selecting the appropriate options in the MicroStrategy Setup Maintenance window.

- When you modify an installation, you can select components to add or installed components to remove.
- When you repair an installation, you can reinstall all program components that are currently installed.

For information about modifying or repairing MicroStrategy components, see the Adding or Removing MicroStrategy Components chapter of the MicroStrategy Installation and Configuration Guide (see Resources, page xviii).
Introduction

MicroStrategy Developer is a MicroStrategy software product that lets you create projects and design reports and documents. MicroStrategy Developer products include MicroStrategy Architect, which is used to build reporting applications.

In this chapter you access a set of predesigned reports and documents from the MicroStrategy Tutorial project using MicroStrategy Developer. The reports and documents demonstrate some of the sophisticated capabilities of the MicroStrategy platform.

For an overview of Developer functionality, review Table of features, page 84. To ensure that you have your MicroStrategy system configured correctly, review the Prerequisites below.
Getting started with your Developer evaluation

Review the list of prerequisites below. If you are interested in reviewing the features available in MicroStrategy Developer, see Table of features, page 84.

Prerequisites

• To use this product evaluation, you must have installed MicroStrategy Developer and MicroStrategy Intelligence Server. If you have not installed these, see Installing the MicroStrategy Evaluation Edition, page 63 for instructions.


Table of features

This chapter describes features that represent the full functionality of MicroStrategy Developer, in the Developer Edition. Developer is also available in an Analyst Edition, which has a simplified feature set.

Both MicroStrategy Web and Developer offer a variety of query and reporting features; you can see many of these features demonstrated throughout this book. The following table is a brief summary of the major query and reporting features that MicroStrategy provides. This is not an exhaustive feature list, and you may not use all of the features listed in the table while following this book.


<table>
<thead>
<tr>
<th>Feature</th>
<th>Allows You To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add and remove objects</td>
<td>Add objects to a report and remove objects from a report.</td>
</tr>
<tr>
<td>Aliasing</td>
<td>Change the name of an object header in a report for display purposes.</td>
</tr>
<tr>
<td>Conditional formatting, also called a threshold</td>
<td>Automatically customize the appearance of certain values depending on the results returned from the warehouse.</td>
</tr>
</tbody>
</table>
Logging in to MicroStrategy Developer

To evaluate the MicroStrategy Developer product, you must log in to MicroStrategy Developer. Use the following steps to log in.

To log in to MicroStrategy Developer

1. If the MicroStrategy Welcome screen is not already open, from the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2. On the left, click View reports in a Developer application. A reminder is displayed to log in as User with a blank password. Click Continue.

3. In the Login dialog box, you can log in using either the User, Developer, or Administrator user name. Each login ID grants you a specific level of access to the MicroStrategy platform:

   • If you log in as User, you can perform most tasks in MicroStrategy that include creating and executing reports.

---

<table>
<thead>
<tr>
<th>Feature</th>
<th>Allows You To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Derived metrics</td>
<td>Add a new metric to a report based on other metrics and data already present in the report.</td>
</tr>
<tr>
<td>Exporting</td>
<td>Export report data to a variety of other applications, such as Microsoft Excel, Microsoft Access, an HTML file, a PDF file, and so on.</td>
</tr>
<tr>
<td>Formatting</td>
<td>Format the appearance of report data, headers, background, and so on.</td>
</tr>
<tr>
<td>Outline mode</td>
<td>Create an indented grouping of report elements to make reports neater and easier to read.</td>
</tr>
<tr>
<td>Page-by</td>
<td>Display report results as separate pages or subsets of data, based on the objects you are paging by.</td>
</tr>
<tr>
<td>Pivoting</td>
<td>Reorganize report data by swapping objects within an axis or by moving objects from one axis to another.</td>
</tr>
<tr>
<td>Printing</td>
<td>Print your report.</td>
</tr>
<tr>
<td>Sorting</td>
<td>Choose the order in which data is displayed.</td>
</tr>
<tr>
<td>Subtotals</td>
<td>Display quantified calculation results for subsets of data in a report.</td>
</tr>
<tr>
<td>View filters</td>
<td>Restrict the data displayed in a report, without querying the warehouse.</td>
</tr>
</tbody>
</table>
• If you log in as Developer, you can view objects that are required to design and create reports.

• If you use the Administrator login ID, you are granted super-user access, which includes the ability to create and delete schema objects such as project attributes.

If you log in as Administrator and delete any objects, they are permanently lost.

This chapter assumes you are logging in as User. Leave the password blank and click OK. The User Home page is displayed.

The image above shows a customized home page (called a project home page) that is custom-fit to the user login User. Any login can have its own project home page. To see an image of the Developer user’s project home page, see Learning about report design and application development, page 107. To see an image of the Administrator user’s project home page, see System administration, page 110.
Getting started with reports and documents

A report is a visual presentation of data. A report sends a query to and accesses data from a relational database and presents it in a visually pleasing manner, so that you can analyze the resulting information. A Report Services document (called a document) is a type of report that presents a broader set of information by including data from multiple reports in a boardroom-quality presentation.

The following steps let you see reports and documents that illustrate some of the key reporting features offered by MicroStrategy Developer.

To access the sample evaluation reports and documents

1. From the User Home page, click Get Started with 5 Styles of Business Intelligence.

2. The Get Started with 5 Styles of Business Intelligence page opens, displaying links to the evaluation reports and documents described in the following sections.
Category Performance Dashboard

Click **Category Performance Dashboard** on the Get Started page. The Category Performance Dashboard opens, as shown below.

The Category Performance Dashboard evaluates product categories based on geographical regions. It includes revenue and profitability details by product subcategory and supplier.

This type of report is a Report Services document. A document is a larger-scale report that provides boardroom-quality presentations of information. Documents are used to create the highest-quality, Pixel Perfect displays of information such as scorecards and dashboards, managed metrics documents, production and operational documents, and more.

Notice the variety of different types of information on this document, including headers, static text, bar graphs, and page numbers.

Dashboards also provide KPIs - key performance indicators. In this document, KPIs allow users to quickly identify key performing and non-performing geographical regions and product subcategories.

Close the document when you have finished looking at it. Click **No** if prompted to save the document.
Category Sales and Profit Performance

Click **Category Sales and Profit Performance** on the Get Started page. The Category Sales and Profit Performance document opens, as shown below.

<table>
<thead>
<tr>
<th>Category: Electronics</th>
<th>Quarter Sales $2,552,210</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subcategory: Computers</td>
<td>Quarter Sales $288,559</td>
</tr>
<tr>
<td>Region: Central</td>
<td>Quarter Sales $34,373</td>
</tr>
<tr>
<td><strong>Current Month</strong></td>
<td><strong>Last Month</strong></td>
</tr>
<tr>
<td><strong>Sales Cost</strong></td>
<td><strong>Profit Margin</strong></td>
</tr>
<tr>
<td><strong>Oct 2008</strong></td>
<td>$12,347</td>
</tr>
<tr>
<td></td>
<td>9,657</td>
</tr>
<tr>
<td><strong>Nov 2008</strong></td>
<td>$11,606</td>
</tr>
<tr>
<td></td>
<td>10,040</td>
</tr>
<tr>
<td><strong>Dec 2008</strong></td>
<td>$10,221</td>
</tr>
<tr>
<td></td>
<td>8,712</td>
</tr>
<tr>
<td>Region: Mid-Atlantic</td>
<td>Quarter Sales $27,086</td>
</tr>
<tr>
<td><strong>Current Month</strong></td>
<td><strong>Last Month</strong></td>
</tr>
<tr>
<td><strong>Sales Cost</strong></td>
<td><strong>Profit Margin</strong></td>
</tr>
<tr>
<td><strong>Oct 2008</strong></td>
<td>$9,209</td>
</tr>
<tr>
<td></td>
<td>7,346</td>
</tr>
<tr>
<td><strong>Nov 2008</strong></td>
<td>$10,270</td>
</tr>
<tr>
<td></td>
<td>8,036</td>
</tr>
<tr>
<td><strong>Dec 2008</strong></td>
<td>$7,667</td>
</tr>
<tr>
<td></td>
<td>6,455</td>
</tr>
<tr>
<td>Region: Northeast</td>
<td>Quarter Sales $57,531</td>
</tr>
<tr>
<td><strong>Current Month</strong></td>
<td><strong>Last Month</strong></td>
</tr>
<tr>
<td><strong>Sales Cost</strong></td>
<td><strong>Profit Margin</strong></td>
</tr>
<tr>
<td><strong>Oct 2008</strong></td>
<td>$18,475</td>
</tr>
<tr>
<td></td>
<td>14,778</td>
</tr>
</tbody>
</table>

The Category Sales and Profit Performance document shows a classic production and operational report that lists the sales cost and profit margins for various product categories across different geographical regions.

Notice the use of conditional formatting and graphical indicators that highlight the data in this document.

Conditional formatting, also called a threshold, automatically changes the appearance of certain values in your document or report depending on the data returned when the report is executed. You can highlight particular data that meets specific conditions with different cell formats, symbols, images, or replacement text.

One useful way to highlight the data is to assign colors to different ranges of values in a report, for example, displaying values in green that are performing above a certain percentage, and in red for values performing below a certain percentage. Colors allow you to understand basic
information at a glance. You can base conditional formatting definitions on the data displayed, on data that is not displayed, and even on additional calculations on the data.

For more information about thresholds and how to apply conditional formatting, see the Formatting a Report chapter of the MicroStrategy Basic Reporting Guide (see Resources, page xviii).

This document also features grouping, which allows users to see data based on Category, Subcategory, and Region:

• Grouping records of data together helps people who read the document to understand the data better. Grouping sets up a type of hierarchy of data within the document, and an implied sort order for the data.

• Grouping also allows metrics to be subtotaled for each group, as shown at the top of the document in the first three rows. In this document, sales are aggregated for each geographical region, for all regions that sell a product subcategory, and for all subcategories in a product category.

Close the document when you have finished looking at it. Click No if prompted to save the document.
Category Sales Report

Click **Category Sales Report**. The Category Sales Report opens, as shown below.

<table>
<thead>
<tr>
<th>Month</th>
<th>Subcategory</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Forecast</th>
<th>Revenue</th>
<th>Revenue Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Art &amp; Architecture</td>
<td></td>
<td>$1,783</td>
<td>$1,410</td>
<td>$6,918</td>
<td>$6,570</td>
</tr>
<tr>
<td>Jan 2008</td>
<td>Business</td>
<td></td>
<td>$1,410</td>
<td>$1,283</td>
<td>$8,738</td>
<td>$5,451</td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td></td>
<td>$937</td>
<td>$534</td>
<td>$4,278</td>
<td>$3,333</td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td></td>
<td>$911</td>
<td>$701</td>
<td>$4,718</td>
<td>$4,785</td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td></td>
<td>$2,705</td>
<td>$2,380</td>
<td>$10,767</td>
<td>$11,528</td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td></td>
<td>$1,184</td>
<td>$1,164</td>
<td>$4,749</td>
<td>$5,266</td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td></td>
<td><strong>$8,890</strong></td>
<td><strong>$7,773</strong></td>
<td><strong>$37,161</strong></td>
<td><strong>$37,114</strong></td>
</tr>
<tr>
<td>Feb 2008</td>
<td>Art &amp; Architecture</td>
<td></td>
<td>$1,953</td>
<td>$1,582</td>
<td>$7,771</td>
<td>$7,582</td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td></td>
<td>$1,885</td>
<td>$1,542</td>
<td>$6,883</td>
<td>$6,583</td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td></td>
<td>$1,192</td>
<td>$866</td>
<td>$5,448</td>
<td>$5,330</td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td></td>
<td>$1,018</td>
<td>$1,081</td>
<td>$5,308</td>
<td>$4,571</td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td></td>
<td>$3,295</td>
<td>$3,384</td>
<td>$13,175</td>
<td>$13,570</td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td></td>
<td>$1,522</td>
<td>$1,477</td>
<td>$6,225</td>
<td>$6,061</td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td></td>
<td><strong>$10,677</strong></td>
<td><strong>$10,032</strong></td>
<td><strong>$44,810</strong></td>
<td><strong>$45,106</strong></td>
</tr>
<tr>
<td>Mar 2008</td>
<td>Art &amp; Architecture</td>
<td></td>
<td>$2,006</td>
<td>$2,169</td>
<td>$8,009</td>
<td>$8,409</td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td></td>
<td>$1,636</td>
<td>$1,521</td>
<td>$6,629</td>
<td>$5,236</td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td></td>
<td>$1,002</td>
<td>$1,092</td>
<td>$4,550</td>
<td>$3,913</td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td></td>
<td>$1,040</td>
<td>$1,134</td>
<td>$5,405</td>
<td>$5,521</td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td></td>
<td>$3,086</td>
<td>$2,304</td>
<td>$12,411</td>
<td>$11,294</td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td></td>
<td>$1,405</td>
<td>$1,002</td>
<td>$6,595</td>
<td>$5,200</td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td></td>
<td><strong>$10,189</strong></td>
<td><strong>$9,462</strong></td>
<td><strong>$42,598</strong></td>
<td><strong>$40,581</strong></td>
</tr>
<tr>
<td>Apr 2008</td>
<td>Art &amp; Architecture</td>
<td></td>
<td>$1,536</td>
<td>$1,104</td>
<td>$7,308</td>
<td>$6,066</td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td></td>
<td>$1,499</td>
<td>$1,579</td>
<td>$7,281</td>
<td>$6,526</td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td></td>
<td>$994</td>
<td>$568</td>
<td>$3,927</td>
<td>$5,434</td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td></td>
<td>$830</td>
<td>$501</td>
<td>$5,151</td>
<td>$5,459</td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td></td>
<td>$2,874</td>
<td>$2,506</td>
<td>$13,665</td>
<td>$12,436</td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td></td>
<td>$1,216</td>
<td>$1,156</td>
<td>$5,048</td>
<td>$4,570</td>
</tr>
<tr>
<td></td>
<td><strong>Total</strong></td>
<td></td>
<td><strong>$8,911</strong></td>
<td><strong>$8,154</strong></td>
<td><strong>$45,042</strong></td>
<td><strong>$40,598</strong></td>
</tr>
</tbody>
</table>

The Category Sales Report displays revenue and profit information by month for a particular product category and subcategory. The category of interest is selected using the page-by feature, which is the drop-down button at the top left of the report.

This report highlights a useful feature available within MicroStrategy reports and documents: page-by, the ability to page through a large amount of data and narrow the information to just the section of data you need.

Page-by is one way to slice and dice data in a report to see the information you need to see. Slice and dice is one of the five styles of business
intelligence. Managers can drill, pivot, and page-by on report data, thereby analyzing information beyond the static enterprise report.

**Exploring additional related data: Drilling on a report**

The Category Sales Report, which is a standard grid report, currently shows monthly revenue and profit for products. To have this report display the daily revenue and profit for each product subcategory, you can drill on this report to view the information.

Drilling is how you look at related data at levels other than that of the originally displayed grid or graph. With the drilling feature, you can drill down, up, or across attributes, custom groups, and consolidations displayed in a report. (Attributes are the business concepts reflected in your stored business data in your data source, for example, Month, Year, Region, or Store. An attribute is made up of elements, for example, the attribute Customer might have the elements John Smith, Jane Doe, William Hill, and so on. Attributes are often placed on the rows of a grid report. Custom groups and consolidations are more advanced, customized attributes that you can create. For details on and examples of attributes, see the Basic Reporting Guide. For details on and examples of custom groups and consolidations, see the Advanced Reporting Guide.)

Drilling down provides access to data at progressively lower levels within an attribute’s hierarchy. (A hierarchy is simply a group of attributes that are conceptually related—for example, the Year hierarchy consists of the attributes Day, Month, Quarter, and Year.) In the Geography hierarchy, if the attribute level displayed in the report is Region, drilling down can display information at the State, City, or Store level.

You can also drill up to see higher levels of data and drill across to see related information from other hierarchies. Additionally, you can drill to your own custom-made templates of specific attributes.

---

**To drill from Month to Day**

2 Point to **Drill**, then **Down**, then click **Day**. A new report is executed. This report displays daily sales data for product subcategories, as shown below.

![Table showing daily sales data](image)

For more information about drilling, see the *Exploring Data* chapter of the *MicroStrategy Basic Reporting Guide* (see *Resources, page xviii*).

### Adding calculations to a report: derived metrics

Most reports have one or more metrics included on them during the report design process. Metrics can also be created on the fly, called derived metrics. Derived metrics can be calculated quickly on the report without redesigning the report. For example, while the conditional formatting highlights key
points of interest on this report, you may want to see the numbers for a Percent to Total based on the Revenue metric.

To display the Percent to Total of Revenue

1  In the Category Sales report, right-click the Revenue metric’s column header.

2  Point to Insert, then point to Percent to Total, and then select Grand Total.

   Notice the new metric column created in the report, called Percent to Grand Total (Revenue).

Percent to Total metrics are one kind of derived metric available in MicroStrategy. Percent to Total metrics display the percent, in relation to a selected total of each item affected by the metric. The total can be by column, by row, by page, for each value of the attribute, or the grand total.

For more information about derived metrics, see the MicroStrategy OLAP Services Guide (see Resources, page xviii).

Close any open reports when you have finished looking at them. Click No if prompted to save the reports.

Predictive Dashboard for Churn Risk Analysis

Click Predictive Dashboard for Churn Risk Analysis on the Get Started page. After the initial dashboard opens, from the View menu select Flash.
The Predictive Dashboard for Churn Risk Analysis is displayed, as shown below.

The Predictive Dashboard for Churn Risk Analysis analyzes certain demographic factors about each customer to further analyze customers who are likely to churn. A heat map is used to identify the most likely churners, based on geographical region and income bracket.

This dashboard contains the following features:

- The Segmentation tab at the top left. You can add as many of these tabs on a document as you need; tabs allow users to switch between different views of the data on a dashboard.
- The heat map to display data, which is one of many MicroStrategy widgets. A heat map helps you quickly grasp the state and impact of a large number of variables at one time.
- The tables on the right side show predicted revenue that is at risk. Tables present a large quantity of data in a compact, easy-to-read format.
- The scaled bar at the bottom provides a graphical overview of data in the table, so that you can take in the most important information at a glance.

When you are ready, close the report. Click **No** if prompted to save the report.
Inventory by Subcategory

Click **Inventory by Subcategory**. The prompt wizard opens. Accept the default selections by clicking **Next**, and then click **Finish**. The report is displayed, as shown below.

**Inventory by Subcategory**

<table>
<thead>
<tr>
<th>Category: Electronics</th>
<th>Subcategory: Video Equipment</th>
<th>1/30/2009 4:00:54 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td># Items: 15</td>
<td>$250,724</td>
<td>$50,756 $50,369</td>
</tr>
<tr>
<td># Items &gt; 2 months of supply: 15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value of Excess Inventory: ($53,455)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value of Inventory on Hand: $52,190</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALERT: Inventory value increased from previous month – identify target products for a market campaign</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SKU</td>
<td>Item Description</td>
<td>Units on Hand</td>
</tr>
<tr>
<td>166</td>
<td>Ergolite Elite Wireless Keyboard</td>
<td>14</td>
</tr>
<tr>
<td>167</td>
<td>Panasonic 4-Head Hi-Fi VCR</td>
<td>6</td>
</tr>
<tr>
<td>168</td>
<td>Panasonic Home Theater Stereo VCR</td>
<td>14</td>
</tr>
<tr>
<td>169</td>
<td>Panasonic Multiformat DVD Player</td>
<td>9</td>
</tr>
<tr>
<td>170</td>
<td>Panasonic Hi-Fi Stereo VCR</td>
<td>21</td>
</tr>
<tr>
<td>171</td>
<td>Panasonic 27&quot; TV/DVD Player Combo</td>
<td>14</td>
</tr>
<tr>
<td>172</td>
<td>Sony DVD/CD Player</td>
<td>8</td>
</tr>
<tr>
<td>173</td>
<td>Sony DVD Player w/Remote</td>
<td>6</td>
</tr>
<tr>
<td>174</td>
<td>Sony DVD/CD/Videocassette Player</td>
<td>9</td>
</tr>
<tr>
<td>175</td>
<td>Sony Portable DVD Player</td>
<td>10</td>
</tr>
</tbody>
</table>

This graphical business report shows detailed inventory information for product subcategories. Notice that an alert appears when certain business conditions are not met.

When you are ready to move on, close any open reports. Click **No** if prompted to save the reports.

Exploring additional reports and documents

Now that you have been introduced to some of the reporting capabilities that Developer offers, you can explore other reports on your own. The steps below show you how to access additional sample reports and documents. Each
report or document is described in detail after the steps, so you can choose to look at reports or documents that are pertinent to your organization.

To explore more reports

1. Click the Home icon in the upper right corner of the page to return to the User Home page.

2. Click Explore Additional Reports. A new page opens, listing several report types.

3. Click any report type to see a list of the available reports or documents within that folder.

   For example, click Enterprise Reporting Documents. A list of enterprise reporting documents appears in Developer.

4. To run a report or document, double-click it. Be sure to close each report or document when you finish using it. Click No if prompted to save the report or document.

5. To return to the User Home page, click the Home icon at the top of Developer.

The following sections provide brief descriptions of each report and document available to you from the Explore Additional Reports page.

Enterprise Reporting Documents

The Enterprise Reporting Documents folder on the left side of Developer contains various types of documents. These include scorecards and dashboards; managed metrics reports; production and operational reports; invoices and statements; and business reports.

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced Scorecard</td>
<td>Shows a complete balanced scorecard, with a graphical strategy map at the bottom. The targets for the key performance indicators come from an external data mart and are incorporated using a report built in MicroStrategy Query Builder.</td>
</tr>
<tr>
<td>Document</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Category Sales and Profit Performance</td>
<td>Presents a classic production and operational report that lists the sales cost and profit margins for various categories across different regions. This is a stacked version of the other document which has the same name.</td>
</tr>
<tr>
<td>Enterprise Performance Management Dashboard</td>
<td>Presents a classic Enterprise Performance Dashboard with gauges. The HTML links work over MicroStrategy Web only and result in the reports being executed.</td>
</tr>
<tr>
<td>Inventory by Subcategory</td>
<td>Lists detailed inventory information for various subcategories of products.</td>
</tr>
<tr>
<td>Invoice Statement(s) by Selected Customers</td>
<td>Presents an invoice for purchases made for each customer. In this document, the subtotal always appears in the bottom of the page at the same location.</td>
</tr>
<tr>
<td>Sales and Profitability and Inventory Report</td>
<td>Displays various features of a document, including multi-layout display, table of contents, and a watermark.</td>
</tr>
<tr>
<td>Wireless Phone Bill</td>
<td>Shows an example of a consumer wireless phone bill, showcasing multi-layout display, table of contents, and a watermark.</td>
</tr>
<tr>
<td>Operational Performance Scorecard</td>
<td>Shows a managed metric report with a quantitative focus on operational metrics within a corporation, such as revenue, profit, and margin.</td>
</tr>
<tr>
<td>Performance by Customer Region</td>
<td>Illustrates revenue and profit performance against forecast by customer region.</td>
</tr>
<tr>
<td>Product Performance Detailed Analysis</td>
<td>Shows a classic production and operational report that lists sales cost and profit margins for various product categories across different geographical regions.</td>
</tr>
<tr>
<td>Regional Performance Management Dashboard</td>
<td>Shows a classic Enterprise Performance Dashboard with gauges. The HTML links work over MicroStrategy Web only and result in report executions.</td>
</tr>
<tr>
<td>Shipping Analysis</td>
<td>Shows a classic production and operational report that focuses on how effectively distribution centers fulfill orders.</td>
</tr>
<tr>
<td>Store Performance Management Dashboard</td>
<td>Shows a classic Enterprise Performance Dashboard with gauges. The HTML links work over MicroStrategy Web only and result in report executions.</td>
</tr>
<tr>
<td>Store Performance Management Dashboard (For a specific Region)</td>
<td>Shows a classic Enterprise Performance Dashboard with gauges. The HTML links work over MicroStrategy Web only and result in report executions.</td>
</tr>
<tr>
<td>Store-Level Performance Analysis</td>
<td>Shows a classic production and operational report that lists sales cost and profit margins for various product categories across different geographical regions.</td>
</tr>
<tr>
<td>Supply Chain Management Report</td>
<td>Shows a supply chain report that visually examines interesting supply chain metrics for a particular region, which can be selected using page-by.</td>
</tr>
</tbody>
</table>
Customer Analysis

In the Subject Areas folder on the left side of Developer, the Customer Analysis folder contains reports that analyze the customer base. The reports focus on areas such as customer income, customer counts, revenue per customer and revenue growth.

<table>
<thead>
<tr>
<th>Report/Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Income Analysis</td>
<td>Breaks out revenue by year, region, and customer income bracket.</td>
</tr>
<tr>
<td>Customer Segmentation by Profile</td>
<td>Segments the customer base using several characteristics. User can select a set of customers at run time based on customer characteristics, and the customer attribute to group-by results.</td>
</tr>
<tr>
<td>Customers Summary</td>
<td>Provides a collection of key customer metrics analyzing average revenue, customer count, comparison vs. forecast, and variance vs. previous month.</td>
</tr>
<tr>
<td>Eastern Region Average Revenue per Customer</td>
<td>Compares the average revenues for the three eastern regions (Northeast, Mid-Atlantic, and Southeast) on a quarterly basis.</td>
</tr>
<tr>
<td>Number of Customers by Region</td>
<td>Depicts the number of customers in each region.</td>
</tr>
<tr>
<td>Performance by Customer Region</td>
<td>Illustrates revenue and profit performance against forecast by customer region.</td>
</tr>
<tr>
<td>Yearly Revenue Growth by Customer Region</td>
<td>Shows Revenue and Percent Growth at the Regional level.</td>
</tr>
</tbody>
</table>
Enterprise Performance Management

In the Subject Areas folder on the left side of Developer, the Enterprise Performance Management folder contains reports that focus on revenue amounts; trends and forecasts; profits; profit margins; and profit forecasts.

<table>
<thead>
<tr>
<th>Report/Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced Scorecard</td>
<td>Shows a complete balanced scorecard, along with a graphical strategy map at the bottom. The targets for the key performance indicators come from an external data mart and are incorporated using a report built in Query Builder.</td>
</tr>
<tr>
<td>Balanced Scorecard Strategy Map</td>
<td>Shows a balanced scorecard strategy map comparing metric values today with the values on the prompted date. It also has indicators showing how today’s metric values compare with the forecasted values.</td>
</tr>
<tr>
<td>Enterprise Performance Dashboard</td>
<td>Shows a classic Enterprise Performance Dashboard with gauges. The HTML links work over MicroStrategy Web only and result in the reports being executed.</td>
</tr>
<tr>
<td>Operational Performance Scorecard</td>
<td>Shows a managed metric report with a quantitative focus on operational metrics such as revenue, profit, and margin within a corporation.</td>
</tr>
<tr>
<td>Profit Forecast</td>
<td>Shows the profit forecast for all categories and subcategories over a one year period.</td>
</tr>
<tr>
<td>Quarterly Call Center Operations</td>
<td>Contains call center revenue and profit data pertaining for each quarter in a selected year. The profit and revenue forecast data comes from the main project data warehouse, while the other metrics come from a text data source.</td>
</tr>
<tr>
<td>Quarterly Profit Margins</td>
<td>Shows the Quarterly Profit Margins for each subcategory (shown within each region). Profit margins above 25% are shown in bold green, margins below 10% are shown in red.</td>
</tr>
<tr>
<td>Regional Profit and Margins</td>
<td>Shows Profit and Profit Margins at a yearly level for each call center.</td>
</tr>
<tr>
<td>Revenue Forecast</td>
<td>Shows the revenue forecast for all categories and subcategories over a one year period.</td>
</tr>
<tr>
<td>Revenue Status and Trend Analysis (Prompted)</td>
<td>Displays, for a month selected by prompt, revenue status relative to forecast and revenue trend relative to the prior month.</td>
</tr>
</tbody>
</table>

Human Resources Analysis

In the Subject Areas folder on the left side of Developer, the Human Resources Analysis folder contains reports that focus on employee
information such as headcount, birthdays, length of employment, and the top five employees by revenue.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Center Timeliness</td>
<td>Shows how timely each call center is in filling orders.</td>
</tr>
<tr>
<td>Employee Birthdays</td>
<td>Displays employee birthdays by day of year as a morale builder.</td>
</tr>
<tr>
<td>Employee Headcount by Country</td>
<td>Displays the current headcount in each country.</td>
</tr>
<tr>
<td>Employee Headcount by Region</td>
<td>Displays the current headcount in each region.</td>
</tr>
<tr>
<td>Employee Profitability Analysis</td>
<td>Shows employee contribution to profitability. A MicroStrategy user is authorized to only see data for employees directly under him in the organization chart.</td>
</tr>
<tr>
<td>Length of Employment</td>
<td>Lists all employees by hire date and length of employment with the company.</td>
</tr>
<tr>
<td>Top 5 Employees by Revenue, Select a Quarter</td>
<td>Displays the top 5 employees by the amount of revenue generated for a particular quarter. The determination of the top 5 is performed dynamically by MicroStrategy.</td>
</tr>
<tr>
<td>Yearly Salary Expenditures</td>
<td>Shows a MicroStrategy user the yearly salary expenditures for employees under him broken down by manager and region. The report runs with all levels of outline mode collapsed. To see additional detail, open various levels of the report.</td>
</tr>
</tbody>
</table>

**Inventory and Supply Chain Analysis**

In the Subject Areas folder on the left side of Developer, the Inventory and Supply Chain Analysis folder contains reports that focus on suppliers, products, costs, revenue, and profit. These reports include Inventory and Unit Sales, as well as Inventory Received from Suppliers by Quarter.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average, Maximum, and Minimum Revenue per Customer</td>
<td>Shows how much customer revenue is related to products from a particular supplier.</td>
</tr>
<tr>
<td>Cost, Price, and Profit per Unit</td>
<td>Run in outline mode with all levels collapsed. It includes average cost, price, and profit at the subcategory level.</td>
</tr>
<tr>
<td>Detailed Analysis for Top Selling Products</td>
<td>Contains revenue and profit for the top selling items in each category for the prompted time period.</td>
</tr>
<tr>
<td>Inventory and Unit Sales - TVs</td>
<td>Shows inventory (end on hand) and unit sales figures for televisions for quarters selected by the user.</td>
</tr>
</tbody>
</table>
### Sales and Profitability Analysis

In the Subject Areas folder on the left side of Developer, the Sales and Profitability Analysis folder contains reports that analyze revenue from multiple perspectives. These reports include Sales by Region, Revenue over Time, and Brand Performance by Region.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average and Maximum Revenue per Call Center Transaction</td>
<td>Shows the average and maximum revenues per call center transaction. The revenues are shown for all call centers, distributed by region.</td>
</tr>
<tr>
<td>Brand Performance by Region</td>
<td>Displays the top 5 brands by revenue from each customer region.</td>
</tr>
<tr>
<td>Call Center Performance</td>
<td>Evaluates call center performance by region.</td>
</tr>
<tr>
<td>Category Sales Report</td>
<td>Displays revenue and profit information by month for a particular category and subcategory. The category of interest is selected via page-by.</td>
</tr>
<tr>
<td>Electronics Revenue by Region</td>
<td>Shows yearly revenues at the regional level.</td>
</tr>
<tr>
<td>Electronics Revenue vs. Forecast</td>
<td>Displays actual vs. forecasted revenues for the electronics category and its subcategories. Thresholds in this report are built on the variance between Revenue and Forecast.</td>
</tr>
<tr>
<td>Electronics Sales over Time</td>
<td>Shows the pattern of monthly sales for each subcategory within electronics over a one-year period.</td>
</tr>
<tr>
<td>Individual Sales Analysis</td>
<td>Ranks each salesperson within the region based on gross sales.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Market Basket - Product Affinity</td>
<td>Shows top 10 items by product affinity, and the percentage of customers who have purchased the item compared to a selected reference item.</td>
</tr>
<tr>
<td>Market Basket Analysis</td>
<td>Shows the correlation and probability of purchase for the top 10 correlated items against a selected reference item.</td>
</tr>
<tr>
<td>Monthly Sales and Margin - Custom Categories</td>
<td>Provides sales and profit margin report at the monthly level. It includes a custom group defined by category and metric qualifications on Revenue Contribution for Top 5 Items, Revenue for Top 10% of Employees, and Revenue for Bottom 3 Suppliers.</td>
</tr>
<tr>
<td>Number of Electronics Items per Brand</td>
<td>Shows the number of electronic items carried, broken down by the product brand.</td>
</tr>
<tr>
<td>Regional Sales Management Report</td>
<td>Analyzes units sold, revenue, as well as profit by year, region and category.</td>
</tr>
<tr>
<td>Revenue and Profit Performance by Brand</td>
<td>For a selected product category and year, this report ranks brands by profit margin.</td>
</tr>
<tr>
<td>Revenue and Profit Trends by Region, Category, and Quarter</td>
<td>Analyzes revenue and profit trends by geographical region, product category, and quarter.</td>
</tr>
<tr>
<td>Revenue by Region</td>
<td>Depicts the revenue for each region in the last month of data in the project warehouse.</td>
</tr>
<tr>
<td>Revenue over Time</td>
<td>Traces store revenues over a two-year period.</td>
</tr>
<tr>
<td>Revenue Status and Trend Analysis</td>
<td>Displays, for a month selected by prompt, revenue status relative to forecast and revenue trend relative to the prior month.</td>
</tr>
<tr>
<td>Revenue vs. Forecast</td>
<td>Shows revenues vs. forecasted revenues. Users can select the region, category, and time period they are interested in viewing. Thresholds in this report are built on the variance between revenue and forecast.</td>
</tr>
<tr>
<td>Revenue vs. Last Year by Region and Quarter</td>
<td>Shows revenues and profits for all categories for the regions selected by the user over a two-year period.</td>
</tr>
<tr>
<td>Revenue, Costs, and Units Sold by Call Center</td>
<td>Shows revenues, costs, and units sold for US call centers.</td>
</tr>
<tr>
<td>Sales by Region</td>
<td>Shows revenue and units sold at the subcategory level. You are prompted to select a particular region and category for which you want to see information.</td>
</tr>
<tr>
<td>US Revenues by Call Center</td>
<td>Shows yearly revenues at the call center level in a graph display.</td>
</tr>
<tr>
<td>US Revenues by Region</td>
<td>Shows yearly revenues at the regional level in a graph display.</td>
</tr>
</tbody>
</table>
Supplier Analysis

In the Subject Areas folder on the left side of Developer, the Supplier Analysis folder contains reports that focus on suppliers, sales, profits, and revenue. These reports include Supplier Sales Report, Supplier Sell-Through Percentage, and Unit Tracking by Supplier.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electronics Supplier Sell-Through</td>
<td>Shows the sell-through percentage for each supplier in the electronics category.</td>
</tr>
<tr>
<td>Supplier Profit Margin, Percent Growth</td>
<td>Shows revenue, profit margin, and percentage growth for each supplier. Percentage growth numbers are in red if below 0 and in green if above 25%.</td>
</tr>
<tr>
<td>Supplier Sales Report</td>
<td>Calculates revenue and unit sales data by customer region and item for a particular supplier and month. The supplier and month are selected via page-by.</td>
</tr>
<tr>
<td>Supplier Sell-Through Analysis</td>
<td>Analyzes sell-through for each supplier. You can page-by year and category to view specific information about years and categories.</td>
</tr>
<tr>
<td>Supplier Sell-Through Percentage</td>
<td>Shows the sell-through percentage for each supplier.</td>
</tr>
<tr>
<td>Unit Tracking by Supplier</td>
<td>Shows each supplier and the number of units received by the store for each quarter. You can drill directly from supplier to item.</td>
</tr>
<tr>
<td>Units Sold and Profit by Supplier, Select a Category</td>
<td>Shows the number of units sold, the total revenue, and the profit for all items for a particular category, from a particular supplier.</td>
</tr>
</tbody>
</table>

Creating your own reports

So far in this Developer evaluation, you have been running predesigned reports that provide specific functionality for you to explore. This section of the evaluation describes how you can create your own reports, using a set of existing objects.

To create your own report

1. Close any reports that you have open. Click No if prompted to save any of the reports.
2. Return to the User Home page by clicking the Home icon in Developer.
3 Click **Create Your Own Report**. A new page opens with five report creation options. These options are designed to help get you started building reports in specific areas of analysis.

4 Click any option to create a report. For example, click **Customer Analysis**. A blank grid opens with the Report Objects pane displayed on the left side of the window.

   - If you do not see the Report Objects pane, from the **View** menu choose **Report Objects**.

5 To create your report, double-click items in the Report Objects pane to add them to the grid. It is recommended that you add at least one attribute and at least one metric to the grid. For example, if you double-click **Customer Region**, which is an attribute, and **Profit**, which is a metric, you get the following report.

![Customer Analysis Report](image)

6 You can also drag items from the Report Objects pane and drop them on the grid to add them. To remove an item from the grid, right-click the object and choose **Remove from Grid** or drag it from the grid and drop it back in the Report Objects pane.

To create other reports within the same area of analysis, you can repeat the last two steps above to add and/or remove objects from the report. Alternately, you can repeat the entire procedure to create reports in other areas of analysis.
Next steps in the evaluation

You have learned the basics of MicroStrategy reporting using MicroStrategy Developer. Now you are ready to explore additional features and functionality of the MicroStrategy platform.

To view the Next Steps page in the evaluation

1. Close any reports that you have opened from previous sections. Click No if prompted to save any reports.

2. To return to the User Home page, click the Home icon in Developer.


4. From here you have the following options:
   - To continue the main evaluation process and explore MicroStrategy Web and other products, close Developer and return to the Welcome screen (on the Windows Start menu, point to Programs, then to MicroStrategy Tools, and then choose Welcome Screen). Follow the instructions on the Welcome screen to access other product evaluations. See the corresponding chapters in this guide for more information and exercises for each product evaluation.
   - To learn about designing more complex reports using MicroStrategy Developer and developing applications, click Learn About Application Development. See Learning about report design and application development, page 107 for more information and exercises.
   - To learn about system administration through MicroStrategy Developer, click Learn About System Administration. See System administration, page 110 for more information and exercises.
   - To explore the Human Resources Analytics Module, see Viewing Business Intelligence Applications, page 199.

It is strongly recommended that you complete all other evaluations in this guide before evaluating the Analytics Module.
Learning about report design and application development

This section introduces you to some of the concepts and functionality that support report designers. Until now, you have been using MicroStrategy Developer as a report analyst would. In this section, you log in using a different user name to see what a report designer can do with the product.

To log in to MicroStrategy Developer as “Developer”

1. On the Next Steps page, click Learn About Application Development. A login dialog box opens, prompting you to log in as Developer with a blank password.

2. Click OK to log in. The Developer home page opens.

3. On the Developer home page, you have the following options:

   - Click Learn About Schema Layer for an overview of schema objects such as attributes and facts, and their relationship to the data warehouse schema. For details to evaluate these objects, see Learning about schema objects in the Schema layer, page 109.

   - Click Learn About Business Abstraction Layer for an overview of application objects such as reports and metrics, and their significance in a reporting application. For details to evaluate these objects, see Learning about application objects in the Business Abstraction layer, page 108.

   - Click Review Hierarchies to learn about the business model that supports the MicroStrategy Tutorial sample project. For details to evaluate hierarchies, see Reviewing hierarchies, page 109.

   - Click Next Steps to explore the following additional features and functionality of the MicroStrategy platform:

     - To explore products other than Developer, close Developer and return to the Welcome screen (on the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen). Follow the instructions on the Welcome Screen to access other product evaluations. For more information, see each evaluation’s corresponding chapter in this guide.
– To learn about system administration through the Developer interface, click Learn About System Administration. For a brief description of the system administration evaluation, see System administration, page 110.

– To explore the Analytics Module, see Viewing Business Intelligence Applications, page 199.

It is strongly recommended that you complete all other evaluations in this guide before evaluating the Analytics Module.

Learning about application objects in the Business Abstraction layer

The Learn About Business Abstraction Layer page displays the different application objects available in the MicroStrategy environment. Application objects are objects that a report designer can create and use to design reports and documents, such as metrics, filters, and prompts.

You can use each of these objects to add different types of reporting flexibility and functionality to a business intelligence application. There is a short description of each object on the screen. For a basic introduction to these application objects and the functionality that each one provides, see the Basic Reporting Guide (see Resources, page xviii). For more complex functionality related to application objects, see the Advanced Reporting Guide.

When you click a link, the Folder List opens on the left, and the contents of the selected folder are displayed on the right. For example, if you click Filters, the Folder List opens to the Filters folder, and the contents of the folder are displayed on the right. The Folder List is a Windows Explorer-like way to navigate through the contents of a MicroStrategy project. In the MicroStrategy Tutorial project, all application objects are stored in the Public Objects folder.

To view the object’s definition in the object’s editor, right-click any object and choose Edit. For example, if you clicked Filters on the Learn About Business Abstraction Layer page, you can expand the Miscellaneous Filters folder, then right-click the filter Select a Region and choose Edit to open this filter in the Filter Editor. To see the filter’s definition, in the Filter Editor double-click Region selection in the Filter Definition pane.
When you are finished, close all editors. Click **No** if prompted to save any changes. To continue with the evaluation, click the **Home** icon at the top of Developer.

## Learning about schema objects in the Schema layer

The Learn About Schema Layer page displays a list of the different schema objects available in the MicroStrategy environment. Schema objects map the physical columns, tables, and data in a data source (such as your organization’s data warehouse) to the MicroStrategy environment. For a detailed introduction to schema objects and the functionality that each one provides, see the *Project Design Guide* (see *Resources, page xviii*).

When you click one of the links, the Folder List opens on the left, and the contents of the folder are displayed on the right. For example, if you click **Facts**, the Folder List opens to the Facts folder, and the contents of the folder are displayed on the right. In the MicroStrategy Tutorial project, all schema objects are stored in the Schema Objects folder.

To view any object’s definition in the object’s editor, right-click the object and choose **Edit**. For example, in the Facts folder, right-click the fact **Cost** and choose **Edit** to open the Cost fact in the Fact Editor.

When you are finished, close all editors. Click **No** if prompted to save any changes. To continue with the evaluation, return to the Developer page by clicking the **Home** icon at the top of Developer.

## Reviewing hierarchies

On the Review Hierarchies page you see a list of the hierarchies that make up the business model for the MicroStrategy Tutorial sample project. A hierarchy is a group of attributes that are conceptually related. A hierarchy provides a meaningful path for navigating through the data in your warehouse.

Click the links to see a graphical representation of each hierarchy. To learn more about hierarchies and the MicroStrategy Tutorial business model, refer to the *MicroStrategy Project Design Guide* (see *Resources, page xviii*).

When you are finished, click the **Home** icon at the top right.
System administration

In this evaluation, you log in as an administrative user to learn about the system administration features and functionality that are available.

To log in to MicroStrategy Developer as Administrator

1. On the Next Steps page, click Learn About System Administration. A login dialog box opens, prompting you to log in as Administrator with a blank password.

2. Click OK to log in. The Administrator page opens.

3. This page displays a list of the various administrative tools that are available. To access the tools, in Developer click to expand the Administration icon in the Folder List on the left.

   • For detailed information about each of these tools and about administrative concepts in general, see the System Administration Guide (see Resources, page xviii).

   • To return to the Administrator Home page, click the MicroStrategy Tutorial project in the Folder List or click the Home icon at the top of Developer.

To continue with the evaluation, once you are finished exploring the Administrator functionality close MicroStrategy Developer and return to the Welcome screen.
VIEWING REPORTS IN A WEB BROWSER

MicroStrategy Web Evaluation

Introduction

MicroStrategy Web is a MicroStrategy software product that provides query and reporting functionality using a browser.

In this chapter you access a set of predesigned reports and documents from the MicroStrategy Tutorial sample project using MicroStrategy Web. The reports and documents demonstrate some of the sophisticated capabilities of the MicroStrategy platform.

For an overview of MicroStrategy Web functionality, review Evaluation features, page 112. To ensure that you have your MicroStrategy evaluation correctly configured, review the Prerequisites below.

Getting started

Before using MicroStrategy Web, review the list of prerequisites below. If you are interested in reviewing the features available in MicroStrategy Web, see Evaluation features, page 112.
Prerequisites

- To use this product evaluation, you must have installed MicroStrategy Web and Intelligence Server. If you have not installed these, see *Installing the MicroStrategy Evaluation Edition, page 67* for instructions.

Evaluation features

This chapter describes features that represent the full functionality of MicroStrategy Web, in the Web Professional Edition. MicroStrategy Web is also available in Web Reporter and Web Analyst editions, which have a simplified feature set. For details about the specific features that each edition includes, review the feature comparison chart located at the following website:

http://www.microstrategy.com/software/products/web/versions/

MicroStrategy Web Universal is a version of MicroStrategy Web that provides Web-based query and reporting from a platform-independent architecture. MicroStrategy Web Universal runs on Microsoft Windows, Oracle Solaris, IBM AIX, Red Hat Linux, SUSE Linux, and HP-UX operating systems and on a variety of application servers including IBM WebSphere, Oracle, SAP NetWeaver Application Server, JBoss Enterprise Application Platform, and Apache Tomcat.

Logging in to MicroStrategy Web

To use this MicroStrategy Web evaluation, use the following steps to log in to MicroStrategy Web.

---

**To log in to MicroStrategy Web**

1. If the MicroStrategy Welcome screen is not already open, from the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2. Click View reports in a Web browser. You are reminded to log in as User with a blank password. Click Continue to close the dialog box.
3 MicroStrategy Web opens and prompts you to log in. Log in as User. Leave the password blank and click Login. MicroStrategy Web opens with the User Home page displayed.

Getting started with reports

A report is a visual presentation of data. A report allows you to analyze information by querying data from a data source and presenting the data in a visually pleasing manner. A Report Services document (called a document) is a type of report that displays a broader set of information by including data from multiple reports in a boardroom-quality presentation.

The following sections provide information about reports and documents that illustrate some of the key reporting features offered by MicroStrategy Web.

To access the sample evaluation reports and documents

1 From the User Home page, click Experience the 5 Styles of Business Intelligence.

2 The Get Started With 5 Styles of Business Intelligence page opens, displaying links to the evaluation reports and documents described in the following sections.
Category Performance Dashboard

Click **Category Performance Dashboard**. The Category Performance dashboard opens, as shown below.

The Category Performance dashboard evaluates product category performance in terms of geographical region. It includes revenue and profitability details listed by product subcategory and supplier.

This type of report is a Report Services document. A document is a larger-scale report that provides boardroom-quality presentations of information. Documents are used to create the highest quality, Pixel Perfect reports such as scorecards and dashboards, managed metrics documents, production and operational reports, and so on.

For complete information, examples, and walkthroughs for dashboards, see the *Document and Dashboard Analysis Guide*.

To return to the Get Started with 5 Styles of Business Intelligence page, click your browser’s **Back** button.
Category Sales and Profit Performance

Click **Category Sales and Profit Performance**. The Category Sales and Profit Performance document opens, as shown below.

<table>
<thead>
<tr>
<th>Region: Central</th>
<th>Quarter Sales $34,373</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oct 2008</td>
<td>$12,347 $2,490</td>
</tr>
<tr>
<td></td>
<td>$8,267 20.17%</td>
</tr>
<tr>
<td>Nov 2008</td>
<td>$11,806 $1,766</td>
</tr>
<tr>
<td></td>
<td>$10,040 14.96%</td>
</tr>
<tr>
<td>Dec 2008</td>
<td>$10,221 $1,598</td>
</tr>
<tr>
<td></td>
<td>$8,712 14.77%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region: Mid-Atlantic</th>
<th>Quarter Sales $27,086</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oct 2008</td>
<td>$9,209 $1,363</td>
</tr>
<tr>
<td></td>
<td>$7,346 20.23%</td>
</tr>
<tr>
<td>Nov 2008</td>
<td>$10,270 $1,434</td>
</tr>
<tr>
<td></td>
<td>$8,036 13.96%</td>
</tr>
<tr>
<td>Dec 2008</td>
<td>$7,507 $1,153</td>
</tr>
<tr>
<td></td>
<td>$6,455 15.15%</td>
</tr>
</tbody>
</table>

The Category Sales and Profit Performance document shows a classic production and operational report that lists the sales cost and profit margins for various product categories across different geographical regions.

Notice the use of conditional formatting used to highlight certain data in this report. Conditional formatting allows you to customize the appearance of your report depending on the results returned from your data warehouse. The MicroStrategy system automatically formats particular data that meets specific conditions, using different cell formats, symbols, images, or replacement text.

One useful way to highlight the data is to assign text colors for different ranges of values in a report. You can base conditional formatting definitions on the data displayed, on data that is not displayed, and even on additional calculations on the data.
For more information about conditional formatting and how to create graphical indicators, see the *Formatting a Report* chapter of the *MicroStrategy Basic Reporting Guide* (see *Resources, page xviii*).

**Using Editable Mode**

With Editable Mode you can make a variety of changes to a Report Services document from the MicroStrategy Web interface, without needing to open a separate document editor. Editable Mode is another unique and useful feature found in MicroStrategy Web.

When you enable Editable Mode in MicroStrategy Web, you can edit a Report Services document from within the view of the document itself.

---

**To enable Editable Mode and edit a document**

1. Click the **Editable Mode** icon.

---
2. From the **Tools** menu, click the **Dataset Objects** icon to open the Dataset Objects pane on the left side of the report. The Dataset Objects pane allows you to modify objects used in this document.

3. Click the title of the document. Once you click the title, handles appear around the text. This text is now an object that you can move around the document.

4. Click in the middle of the text and drag and drop the text anywhere else in the document.

**Undoing actions**

Another useful feature found in MicroStrategy Web is the Undo feature. You can undo any action you previously performed while editing your document.
in Web. For example, assume you want the title text field to return to its original location.

To undo actions

1. From the **Home** menu, click the **Undo** icon 🔄. The title text field returns to its original position at the top of the document.

2. Now return to the original view by clicking the **Editable Mode** icon 📝. The document opens as it did at the beginning of this exercise.

Close the document when you have finished looking at it. Click **No** if prompted to save the document.

**Category Sales Report**

Click **Category Sales Report**. The report opens, as shown below.

<table>
<thead>
<tr>
<th>Month</th>
<th>Subcategory</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Forecast</th>
<th>Revenue</th>
<th>Revenue Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Art &amp; Architecture</td>
<td>$1,763</td>
<td>$1,410</td>
<td>$6,918</td>
<td>$8,570</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td>$1,410</td>
<td>$1,263</td>
<td>$5,738</td>
<td>$5,451</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td>$937</td>
<td>$834</td>
<td>$4,273</td>
<td>$3,333</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td>$911</td>
<td>$701</td>
<td>$4,718</td>
<td>$4,765</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td>$2,705</td>
<td>$2,380</td>
<td>$10,787</td>
<td>$11,823</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td>$1,164</td>
<td>$1,164</td>
<td>$4,748</td>
<td>$5,385</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$8,890</td>
<td>$7,773</td>
<td>$37,161</td>
<td>$37,114</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Month</th>
<th>Subcategory</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Forecast</th>
<th>Revenue</th>
<th>Revenue Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feb 2006</td>
<td>Art &amp; Architecture</td>
<td>$1,853</td>
<td>$1,562</td>
<td>$7,771</td>
<td>$7,382</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td>$1,695</td>
<td>$1,542</td>
<td>$6,883</td>
<td>$6,883</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td>$1,192</td>
<td>$968</td>
<td>$5,448</td>
<td>$5,933</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td>$1,019</td>
<td>$1,001</td>
<td>$5,308</td>
<td>$4,671</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td>$3,295</td>
<td>$3,304</td>
<td>$13,175</td>
<td>$13,570</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td>$1,622</td>
<td>$1,477</td>
<td>$9,225</td>
<td>$9,081</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$10,677</td>
<td>$10,032</td>
<td>$44,810</td>
<td>$45,106</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Month</th>
<th>Subcategory</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Forecast</th>
<th>Revenue</th>
<th>Revenue Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mar 2006</td>
<td>Art &amp; Architecture</td>
<td>$2,000</td>
<td>$2,169</td>
<td>$8,009</td>
<td>$8,409</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Business</td>
<td>$1,630</td>
<td>$1,621</td>
<td>$6,628</td>
<td>$6,236</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Literature</td>
<td>$1,002</td>
<td>$1,082</td>
<td>$4,550</td>
<td>$3,813</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Books - Miscellaneous</td>
<td>$1,040</td>
<td>$1,134</td>
<td>$5,405</td>
<td>$5,621</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Science &amp; Technology</td>
<td>$3,096</td>
<td>$2,364</td>
<td>$12,411</td>
<td>$11,294</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Sports &amp; Health</td>
<td>$1,405</td>
<td>$1,082</td>
<td>$5,685</td>
<td>$6,208</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$10,189</td>
<td>$9,482</td>
<td>$42,698</td>
<td>$40,681</td>
<td></td>
</tr>
</tbody>
</table>
The Category Sales report displays revenue and profit information by month for a particular product category and subcategory.

This report also highlights a useful feature available within MicroStrategy reports: the ability to group results by page, and then page through a large amount of data and narrow the information to just the section you need.

You can use the page-by axis to narrow your search. The page-by axis allows you to select the specific attribute by which you want to group data and have that specific data displayed. It allows you to analyze a slice of data.

If you do not see the page-by axis, from the Tools menu, select Page-by Axis.

For example, you can view the sales information for all the movies (Category: Movies) sold. To do so, on the Page-by axis, from the Category drop-down list, select Movies. Notice how the data in the report changes and reveals data only for Movies.

**Drilling on a report**

You can look at related data by drilling on this report down to the Item level. This means that, starting from this report, you can look at transactional sales information for any individual item.

1. On the Page-by axis, from the Category drop-down list, select Books.
2 Click on the first subcategory for Jan 2006, **Art & Architecture**. The default drill direction is down. As shown in the following image, new data appears in the document.

<table>
<thead>
<tr>
<th>Month</th>
<th>Subcategory</th>
<th>Item</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Forecast</th>
<th>Revenue</th>
<th>Revenue Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 2006</td>
<td>Art &amp; Architecture</td>
<td>100 Places to Go While Still Young at Heart</td>
<td>$407</td>
<td>$354</td>
<td>$1,425</td>
<td>$1,340</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Art As Experience</td>
<td>$88</td>
<td>$91</td>
<td>$341</td>
<td>$263</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Painted Word</td>
<td>$48</td>
<td>$40</td>
<td>$318</td>
<td>$347</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hirschfield on Line</td>
<td>$224</td>
<td>$246</td>
<td>$340</td>
<td>$332</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adirondack Style</td>
<td>$105</td>
<td>$88</td>
<td>$378</td>
<td>$295</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Architecture : Form, Space, &amp; Order</td>
<td>$134</td>
<td>$128</td>
<td>$504</td>
<td>$529</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>50 Favorite Rooms</td>
<td>$112</td>
<td>$97</td>
<td>$432</td>
<td>$350</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>500 Best Vacation Home Plans</td>
<td>$40</td>
<td>$36</td>
<td>$195</td>
<td>$168</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Blue &amp; White Living</td>
<td>$88</td>
<td>$73</td>
<td>$352</td>
<td>$370</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ways of Seeing</td>
<td>$100</td>
<td>$90</td>
<td>$396</td>
<td>$440</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Gonzo, the Art</td>
<td>$116</td>
<td>$112</td>
<td>$504</td>
<td>$528</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cabin Fever : Rustic Style Comes Home</td>
<td>$57</td>
<td>$54</td>
<td>$248</td>
<td>$238</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>American Bungalow Style</td>
<td>$127</td>
<td>$137</td>
<td>$426</td>
<td>$457</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Building With Stone</td>
<td>$74</td>
<td>$83</td>
<td>$300</td>
<td>$240</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Voyaging Under Power</td>
<td>$46</td>
<td>$46</td>
<td>$225</td>
<td>$178</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Total</strong></td>
<td><strong>$1,763</strong></td>
<td><strong>$1,671</strong></td>
<td><strong>$6,916</strong></td>
<td><strong>$6,565</strong></td>
<td></td>
</tr>
</tbody>
</table>

If you want to return to the original report: Click the Home icon in the top right corner, click **Experience the 5 Styles of Business Intelligence**, and then click **Category Sales Report**.

Close the report when you have finished looking at it.
Predictive Dashboard for Churn Risk Analysis

Click Predictive Dashboard for Churn Risk Analysis. The dashboard opens, as shown below.

The Predictive Dashboard for Churn Risk Analysis analyzes certain demographic factors about each customer to further analyze customers who are likely to churn. A heat map is used to identify the most likely churners, based on geographical region and income bracket.

This dashboard contains the following features:

- The Segmentation tab at the top left. You can add as many of these tabs on a document as you need; tabs allow users to switch between different views of the data on a dashboard.

- The heat map to display data, which is one of many MicroStrategy widgets. A heat map helps you quickly grasp the state and impact of a large number of variables at one time.

- The tables on the right side show predicted revenue that is at risk. Tables present a large quantity of data in a compact, easy-to-read format.

- The scaled bar at the bottom provides a graphical overview of data in the table, so that you can take in the most important information at a glance.
To return to the Get Started With 5 Styles of Business Intelligence page, click your browser’s Back button.

Inventory by Subcategory

Click Inventory by Subcategory. The report is displayed, as shown below.

![Graphical business report showing inventory information for product subcategories.](Image)

This graphical business report shows detailed inventory information for product subcategories. Notice that an alert appears when certain business conditions are not met.

Click the MicroStrategy icon and select Home to return to the User home page.
Delivering reports

MicroStrategy Web users can sign up to have reports automatically sent to an email address, to a printer, or to a folder on a network location. Reports can be sent on a time-based or event-based schedule.

This subscription functionality is performed by the MicroStrategy Distribution Services product. This product provides an easy and inexpensive way to send information to employees, customers, and partners.

For complete details about this functionality, see the MicroStrategy System Administration Guide (see Resources, page xviii).
To use the Distribution Services evaluation for delivering reports from MicroStrategy Web

1. On the User Home page, click **Deliver Reports**. The Deliver Reports page opens, displaying links to the steps to evaluate report delivery, as shown in the following image.

Immediate Delivery: Sending a report via email

You can immediately send MicroStrategy Web reports to an email address.

To deliver reports immediately

1. On the Deliver Reports page, click **Immediate Delivery: Send a report via email**. Then click **Run Report** at the bottom of the page. The
Inventory by Subcategory document runs. You may already be familiar with this document from other parts of this evaluation.

2 From the **Home** menu, select **Send Now**. The Send Now dialog box opens.

3 Click **To**, to create a new email address. The Recipients Browser dialog box opens.

4 In the **Address Name** field, type a display name for the recipient. This name will appear in the To field.

5 In the **Physical Address** field, type the email address for the recipient.

6 Then click **Add to Recipients**. The recipient’s display name and email address are added to the To field.

7 Click **OK** to return to the Send Now dialog box.

8 Choose an email client from the **Device** drop-down list.

   - If you do not know which email client to choose, select **Generic email**.

9 For this exercise, leave the default selection for the **Send** option.

10 You can send a report in Excel, PDF, or HTML format. For this exercise, leave the default **Delivery Format** option.

   - Selecting the **Compress Contents** check box allows you to reduce the size of the attachment. For this exercise, leave the Compress Contents check box cleared.

11 In the **Subject** field, type the subject line for the email. You can also send a message with the report by typing text within the **Message** field.

12 Leave the default selections for all **Advanced** options.

13 Click **OK**. The report is sent to the email address you specified.

14 Click the **MicroStrategy** icon and select **Home** to return to the User Home page.

Proceed to the next section, *Automated Delivery: Receiving reports regularly via email.*
Automated Delivery: Receiving reports regularly via email

You can send MicroStrategy Web reports to an email address on a scheduled basis.

**To deliver reports on a scheduled basis**

1. On the User Home page, click Deliver Reports and then click Automated Delivery: Receive reports regularly via email. The Category Sales and Profit Performance document runs.

2. From the Home menu, point to Subscribe To and then select E-mail. The Email Subscription dialog box opens.

3. Select a schedule from the Schedule drop-down list. Then select an email address from the next drop-down list.

4. Click To, to create a new email address. The Recipients Browser dialog box opens.

5. In the Address Name field, type a display name for the recipient. This name will appear in the To field.

6. In the Physical Address field, type the email address for the recipient.

7. Then click Add to Recipients. The recipient’s display name and email address are added to the To field.

8. Click OK to return to the Email Subscription dialog box.

9. For this exercise, leave the default selection for the Send option.

10. You can send a report in Excel, PDF, or HTML format. For this exercise, leave the default selection.

    Selecting the Compress Contents check box allows you to reduce the size of the attachment. For this exercise, leave the Compress Contents check box cleared.

11. You can edit the information in the Subject field. This text appears as the subject line in the email. You can also send a message with the report by typing text in the Message field.
12 To see a preview of what the email recipient will receive, select the **Send a preview now** check box, which sends the email immediately.

13 Click **OK**. The report is sent to the email address you specified on the schedule you chose.

14 Click the **MicroStrategy** icon and select **My Subscriptions**. Information about the report you just scheduled is displayed in the **E-mail Subscriptions** list.

15 Click the **Edit** icon on the right to change the schedule information (choose a different schedule or a different email address).

16 Leave the default selections for all **Advanced** options.

17 Click **OK** when you are finished.

   ![To stop the schedule from executing, on the My Subscriptions page select the check box for the scheduled report and click Unsubscribe.]

18 When you are finished, click **Close** at the top of the page and navigate back to the User Home page. (Click the **MicroStrategy** icon and select **Home**).

Proceed to the next section of this guide, *Automated Delivery: Automatically archiving reports*.

### Automated Delivery: Automatically archiving reports

You can have MicroStrategy Web automatically send reports to a file storage location (such as an archive) on a scheduled basis.

---

**To deliver reports to a file storage location on a scheduled basis**

1. On the User Home page, click **Deliver Reports**.

2. Click **Automated Delivery: Automatic archiving of reports**. The Performance by Customer Region document runs.

3. From the **Home** menu, select **Subscribe to**, and then select **File**. The Subscribe to File dialog box is displayed.
4 Select a schedule from the **Schedule** drop-down list.

5 Type an address in the **Location** field. This address is the path where you want to send the report.

Some examples of address paths include:
- `\corp\sales\username`
- `\archive-2005\forecast`
- `\servername\sharename\path`

6 Send a report in Excel, PDF, or HTML format. Accept the default selection.

Note the following:
- Selecting the **Compress Contents** check box allows you to reduce the size of the attachment. For this exercise, do not select the Compress Contents check box.
- If you want, in the **File Name** field, you can edit the file name of the report you want to send.

7 To see a preview of what you will receive, select the **Send a preview now** check box. This sends the email immediately, so you can see the scheduled email.

You can also send a delivery notification email to a specific address. To do so, click the **Send notification to email address** check box and select an address from the **Address** drop-down list.

8 Click **OK**. The report is sent to the location you specified on the schedule you chose.

If you chose to send a preview, a preview email is sent to the address you specified.

9 Click the **MicroStrategy** icon and select **My Subscriptions** to open the Subscriptions page. Information about the report you just scheduled is displayed in the File Subscriptions list.

10 Click the **Edit** icon on the right to change the schedule information (choose a different schedule or a different location). Then click **OK**.

To stop the schedule from executing, select the check box for the report and click **Unsubscribe**.
11 Click Close.

12 Click the MicroStrategy icon and select Home to return to the User Home page.

Proceed to the next section, Subscribing to reports to view on a mobile device.

Subscribing to reports to view on a mobile device

Administrators or MicroStrategy Web users can subscribe to reports that will be received on an Apple iPhone or iPad, or Android phone or tablet. This functionality is achieved through integration with MicroStrategy’s mobile device product, MicroStrategy Mobile. This integration with Mobile provides an easy way to configure which reports you receive on your mobile device.

For more details about this functionality, see Viewing Reports on a Mobile Device, page 147).

Exploring additional reports

Now that you have seen some of the reporting capabilities that MicroStrategy Web offers, you can explore some other reports on your own.

To explore more reports

1 On the User Home page, click Explore Additional Reports. A new page opens with several folders containing reports. The folders are organized into business areas.

2 Click a folder to see the reports. For example, click Enterprise Reporting Documents. The Enterprise Reporting Documents folder opens.

3 To run a report or document, click it.
4 Click the MicroStrategy icon and select Home. To view more reports or documents, click Explore Additional Reports and repeat these steps as often as you like.

The available folders and reports are identical to the ones in the previous chapter for MicroStrategy Developer. For a description of each folder and report, see Exploring additional reports and documents, page 96.

Creating your own report

So far you have been running predesigned reports that provide specific functionality for you to explore. This section of the evaluation describes how you can create your own reports using a set of existing objects.

To create your own report

1 On the User Home page, click Create Your Own Report. A new page opens with five report creation options. These options help you get started building reports in specific areas of analysis.

2 Click an option to create a report.
   For example, click Customer Analysis. An empty template for a grid report opens.

3 To create your own report, select Report Objects from the tabs at the bottom left of the page.

4 Double-click objects in the Report Objects pane on the left to add them to the grid report. It is recommended that you add at least one attribute and one metric to the grid report. For example, double-click Customer
Region, which is an attribute, and Profit, which is a metric. The following report is displayed.

You can also drag objects from the Report Objects pane and drop them on the grid to add them to the report.

To remove an object from the grid, right-click the object and choose Remove from Grid or drag it from the grid and drop it back in the Report Objects pane.

To create other reports within the same area of analysis, you can repeat the last step above. Alternatively, you can repeat the entire procedure to create reports in other areas of analysis.

Next steps in the evaluation

You have learned the basics of MicroStrategy reporting using MicroStrategy Web in a browser. Now you are ready to explore additional features and functionality of the MicroStrategy platform.

To view the Next Steps page in the evaluation

1 Return to the User Home page by clicking the MicroStrategy icon and selecting Home.
2 Click **Next Steps**. The Next Steps page opens.

3 From here, you have the following options:

- To continue the main evaluation process and explore other products, close your browser and return to the Welcome page (on the Windows Start menu, point to Programs, then to **MicroStrategy Tools**, and then choose **Welcome Screen**). Follow the instructions on the Welcome page to access other product evaluations.

- To view examples of business intelligence applications, click **View Business Intelligence Applications** and see **Viewing Business Intelligence Applications, page 199**.

It is recommended that you complete the entire evaluation process prior to exploring the Analytics Module or business intelligence applications.
Introduction

MicroStrategy Office allows you to integrate MicroStrategy with Microsoft Office products such as Excel, PowerPoint, and Word. You can run MicroStrategy reports and documents directly from the Microsoft Office applications, refresh their data, format the results, and save them to be used for offline analysis. With MicroStrategy Office, users can access a wide variety of reports and documents from different MicroStrategy projects and view them within a single Microsoft Office file. Refreshing the data assures users that the data is current, relevant, and secure.

This chapter walks you through a demonstration of MicroStrategy Office.
Prerequisites


- MicroStrategy Office uses Excel components to work so you must have Excel installed (even if you only plan to use MicroStrategy Office with PowerPoint or Word).

Beginning the MicroStrategy Office evaluation for Microsoft Excel

Use the following steps to open the Excel workbook that contains a set of MicroStrategy reports to be executed.

---

**To begin the MicroStrategy Office evaluation**

1. If the MicroStrategy Welcome screen is not already open, from the Windows *Start* menu, point to *Programs*, then *MicroStrategy Tools*, and then choose *Welcome Screen*. 

2 Click **View Reports in Microsoft Excel**. Microsoft Excel opens with the User Home page displayed, as shown in the following image.

![MicroStrategy Office Evaluation Edition](image)

**Performing one-click refresh of multiple reports**

The User Home page is a cover sheet for a collection of reports that appear on the various worksheets in the Excel workbook. Press CTRL and click **Perform One-Click Refresh of Multiple Reports** to go to the Executive Sales Analysis worksheet.

On this worksheet, click the links (or the graphics at the bottom) to view each worksheet. For example, to see the Sales Trends reports, click **Sales Trends**. The Sales Trends worksheet opens.

There is no data for any of the reports. This is because the reports need to be refreshed. Refreshing executes all MicroStrategy reports in the Excel workbook. MicroStrategy Office retrieves the data and displays it in the reports in the workbook.
**To refresh the data in the workbook**

1. On the MicroStrategy Office toolbar, click **Refresh**.
   
   If the MicroStrategy toolbar is not displayed, on the **View** menu, point to **Toolbars** and then choose **MicroStrategy Office**.

2. In the login dialog box, type **User** in the login ID field, leave the password blank, and click **OK**.
   
   The refresh may take a few minutes depending on your computer's hardware configuration.

3. All reports in the workbook are refreshed. Navigate to the various worksheets to see the reports that now display data.

To go back to the cover page, click the **Back to Executive Sales Analysis** link located at the top right of any worksheet.

**Navigating to Next Steps**

You have seen one of the common ways in which MicroStrategy Office can be used to integrate with Microsoft Excel. To learn more about MicroStrategy Office, such as how to add a MicroStrategy report to an Excel worksheet, use the steps below to navigate to the Next Steps page.

**To view the Next Steps page**

1. Click the first worksheet in the Excel workbook, and then click **Next Steps**.

2. Select one of the following options to proceed with this evaluation:
   
   - To add reports to an Excel worksheet, click **Learn More about Adding Reports in Excel**. Then continue this evaluation with **Adding reports to Excel, page 137**.
   
   - To explore products other than MicroStrategy Office, close the Excel workbook and return to the Welcome screen (on the Windows **Start** menu, point to **Programs**, then to **MicroStrategy Tools**, and then choose **Welcome Screen**). When you close the workbook, you are prompted to save your changes. If you choose to save changes, the
reports and data are saved in the workbook. Follow the instructions on the Welcome screen to access other product evaluations.

Adding reports to Excel

This workflow shows you how to add reports to an Excel workbook. This workflow may be similar to how field personnel in your organization interact with MicroStrategy Office. They may have a standard Excel workbook they want to update periodically and carry with them for offline analysis.

This section shows you how the designer places those reports in the worksheet.

To add a MicroStrategy report to an Excel worksheet


2. Open the Excel workbook that you want to add the MicroStrategy report to. Excel opens with a blank worksheet displayed.

To connect to the MicroStrategy Tutorial project


   If the MicroStrategy toolbar is not displayed, on the View menu, point to Toolbars and then choose MicroStrategy Office.

4. In the Connect to MicroStrategy Project dialog box, select MicroStrategy Analytics Modules from the list of available project sources, type User for the login ID, leave the password blank, and click Get Projects.

5. From the list of available projects, select MicroStrategy Tutorial and click OK. A browsing window opens.

6. To locate the reports, documents, and HTML documents to include in the Excel worksheet, you can navigate through a project in this window. You can add any report, HTML document, or document to the Excel spreadsheet. For this evaluation, expand the Subject Areas folder, and then the Sales and Profitability Analysis folder.
Select the Revenue vs. Forecast report and, from the Reports menu, choose Run Report.

Notice all the available options on the Reports menu. You can add the report to the Excel spreadsheet as a grid, graph, PivotTable, and so on. For details about these and other options available to you, refer to the MicroStrategy Office online help by clicking MicroStrategy on the MicroStrategy Office toolbar and then pressing F1.

Leave the default prompt answers and click Execute Report. The report runs and the results are displayed—with the report’s formatting—in the Excel worksheet.

MicroStrategy Office provides various options to determine the precise manner and location in which the report is placed in the worksheet. For details about these options, refer to the Help by clicking MicroStrategy on the MicroStrategy Office toolbar and then pressing F1.

Now that you have seen how MicroStrategy Office can be used with Excel, close any open windows (there is no need to save anything) and see Beginning the MicroStrategy Office evaluation for Microsoft PowerPoint, page 138 to learn about how MicroStrategy Office can be used with PowerPoint.

MicroStrategy Office gives you the ability to access multiple MicroStrategy projects from within a single Microsoft Office document. You can try this yourself by adding one report from the MicroStrategy Tutorial project and another from the Human Resources Analysis Module (HRAM) project. To learn about HRAM, see Viewing Business Intelligence Applications, page 199. It is recommended that you complete the entire evaluation process before you explore the Analytics Module or business intelligence applications further.

Beginning the MicroStrategy Office evaluation for Microsoft PowerPoint

To use the MicroStrategy Office evaluation, use the steps below to open the PowerPoint presentation that contains a set of MicroStrategy reports to be executed.
To begin the MicroStrategy Office evaluation

1. If the MicroStrategy Welcome screen is not already open, from the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2. Click View Reports in Microsoft PowerPoint. Microsoft PowerPoint opens and a MicroStrategy Office dialog box is displayed.

3. In the MicroStrategy Office dialog box, click Yes to refresh the document. The dialog box closes, and you are prompted to log in to the MicroStrategy Tutorial project.

4. In the login dialog box, type User in the login ID field, leave the password blank, and click OK. After the Executing Reports window closes, the Regional Performance dashboard is displayed in PowerPoint.

5. Select Slide Show from the View menu to view the data in the refreshed Regional Performance dashboard.

   To change from Slide Show mode to Normal mode at any time, press ESC.

6. To begin evaluation, scroll to slide number 2 in the PowerPoint presentation, or click Slide 2 in the refreshed dashboard. The Perform One-Click Refresh of Multiple Reports slide opens.

   To access the User Home page at any time, click the Home icon located at the top right.

Performing one-click refresh of multiple reports

Most of the slides in the presentation appear to contain blank spaces. This is because these spaces contain MicroStrategy reports that need to be refreshed. Refreshing executes all MicroStrategy reports in the PowerPoint presentation. MicroStrategy Office retrieves the data and displays it in the reports in the presentation.
To refresh the data in the presentation

1. If the presentation is currently in Slide Show mode, press ESC to return to Normal mode.

2. On the MicroStrategy Office toolbar, click Refresh 🔄. If the MicroStrategy toolbar is not displayed, on the View menu, point to Toolbars and then choose MicroStrategy Office.

3. If you are required to answer any prompts, leave the default prompt answers selected and click Execute Report. The refresh may take several minutes depending on the hardware configuration of your computer.

4. When the refresh is complete, from the View menu, select Slide Show and view the presentation. All reports in the presentation are refreshed. Navigate to the various slides to see reports displaying the latest data.

Navigating to Next steps

You have seen one of the common ways in which MicroStrategy Office can be used to integrate with Microsoft PowerPoint. To learn more about MicroStrategy Office, such as how to add a MicroStrategy report to a PowerPoint presentation, use the steps below to navigate to Next Steps.

To view the Next Steps page

1. Click the Home icon 🏡 and then click Next Steps.

2. Select one of the following options to proceed with this evaluation:
   - To add reports to a PowerPoint presentation, click Learn More about Adding Reports to PowerPoint. Then continue this evaluation with Adding reports to PowerPoint, page 141.
   - To explore products other than MicroStrategy Office, close the PowerPoint presentation and return to the Welcome screen (on the Windows Start menu, point to Programs, then to MicroStrategy Tools, and then choose Welcome Screen). When you close the presentation, you are prompted to save your changes. If you save...
changes, the reports and data are saved in the presentation. Follow the instructions on the Welcome screen to access other product evaluations.

Adding reports to PowerPoint

So far, you have used MicroStrategy Office to perform a one-click refresh of MicroStrategy reports in a PowerPoint presentation. This workflow shows you how to add reports to a PowerPoint presentation. This workflow may be similar to how field personnel in your organization interact with MicroStrategy Office. They may have a standard presentation they want to update periodically and carry with them for meetings with customers or other field personnel.

This section shows you how the designer places those reports in the presentation.

To add a MicroStrategy report to a PowerPoint presentation

1. On the Next Steps slide, click Learn More about Adding Reports to PowerPoint. The Adding Reports to PowerPoint page opens.

2. Open the PowerPoint presentation that you want to add the MicroStrategy report to.

To connect to the MicroStrategy Tutorial project

3. On the MicroStrategy Office toolbar, click MicroStrategy. If the MicroStrategy toolbar is not displayed, on the View menu, point to Toolbars and then choose MicroStrategy Office.

4. In the Connect to MicroStrategy Project dialog box, select MicroStrategy Tutorial from the list of available project sources, type User for the login ID, leave the password blank, and click Get Projects.

5. In the list of available projects, select MicroStrategy Tutorial and click OK. A browsing window opens.

6. To locate the reports, HTML documents, and Flash-enabled documents to include in the PowerPoint presentation, navigate through a project in this window. You can add any report, HTML document, or Flash-enabled document to the PowerPoint presentation. For this evaluation, expand
the **Subject Areas** folder, and then the **Sales and Profitability Analysis** folder.

7 Select the **Revenue vs. Forecast** report and, from the Reports menu, choose **Run Report**.

Notice all the available options on the Reports menu. You can add the report to the PowerPoint presentation as a grid, graph, PivotTable, and so on. For details about these and other options available to you, refer to the Help by clicking **MicroStrategy** on the MicroStrategy Office toolbar and then pressing **F1**.

8 Leave the default prompt answers and click **Execute Report**. The report runs and the results are displayed—with the report’s formatting—in the PowerPoint slide.

MicroStrategy Office provides various options to determine the precise manner in which the report is placed on the slide. For details about these options, refer to the MicroStrategy Office online help by clicking **MicroStrategy** on the MicroStrategy Office toolbar and then pressing **F1**.

Now that you have seen how MicroStrategy Office can be used with PowerPoint, close any open windows (there is no need to save anything) and see **Beginning the MicroStrategy Office evaluation for Microsoft Word, page 142** to learn about how MicroStrategy Office can be used with Word.

MicroStrategy Office gives you the ability to access multiple MicroStrategy projects from within a single Microsoft Office document. You can try this yourself by adding one report from the MicroStrategy Tutorial project and another from the Human Resources Analysis Module (HRAM) project. To learn about HRAM, see **Viewing Business Intelligence Applications, page 199**. It is recommended that you complete the entire evaluation process before you explore the Analytics Module or business intelligence applications further.

---

**Beginning the MicroStrategy Office evaluation for Microsoft Word**

Use the following steps to open the Word document that contains a set of MicroStrategy reports to be executed.
To begin the MicroStrategy Office evaluation

1 If the MicroStrategy Welcome screen is not already open, from the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2 Click View Reports in Microsoft Word.

3 Microsoft Word opens with the User Home page displayed, as shown in the following image.

Performing one-click refresh of multiple reports

The User Home page is actually a cover sheet for a collection of reports that appear on the other pages of the document. Press CTRL and click Perform One-Click Refresh of Multiple Reports to go to the Human Resources Analysis reports page. Follow the instructions to refresh the Human Resources Analysis reports within the Word document.

Most of the pages in this Word document contain blank spaces because those spaces contain MicroStrategy reports that need to be refreshed. Refreshing
executes all MicroStrategy reports in the Word document. MicroStrategy Office retrieves the data and displays it in the reports in the document.

To refresh the reports in the document


   If the MicroStrategy toolbar is not displayed, from the View menu point to Toolbars and then choose MicroStrategy Office.

2. In the login dialog box, type User in the login ID field, leave the password blank, and click OK.

   The refresh may take several minutes depending on the hardware configuration of your computer.

3. When the refresh is complete, all reports in the presentation are refreshed. Navigate to the various pages to see reports displaying data. The Employee Attrition - Quarter report refreshed in an Excel spreadsheet, as well as within the Word document.

Navigating to Next Steps

You have seen one of the common ways in which MicroStrategy Office can be used to integrate with Microsoft Word. To learn more about MicroStrategy Office, such as how to add a MicroStrategy report to a Word document, use the steps below to navigate to the Next Steps page.

To view the Next Steps page

1. Navigate to the first page in the Word document.

2. Click the Next Steps link on the right.

3. Select one of the following options to proceed with this evaluation:
   - To add reports to a Word document, click Learn More about Adding Reports to Word. Then continue this evaluation with Adding reports to Word, page 145.
   - To explore products other than MicroStrategy Office, close the Word document and return to the Welcome screen (on the Windows Start
menu, point to Programs, then to MicroStrategy Tools, and then choose Welcome Screen). Follow the instructions on the Welcome screen to access other product evaluations.

Adding reports to Word

So far, you have used MicroStrategy Office to perform a one-click refresh of MicroStrategy reports in a Word document. This workflow shows you how to add reports to a Word document. This workflow may be similar to how field personnel in your organization interact with MicroStrategy Office. They may have a standard document they want to update periodically and carry with them for meetings with customers or other field personnel.

This section shows you what the designer has to do to get those reports into the Word document.

To add a MicroStrategy report to a Word document

2. Open the Word document that you want to add the MicroStrategy report to. You can choose to either create a new document or open a saved document into which you want to add reports.

To connect to the MicroStrategy Tutorial project

3. On the MicroStrategy Office toolbar, click MicroStrategy. If the MicroStrategy toolbar is not displayed, on the View menu, point to Toolbars and then choose MicroStrategy Office.
4. In the Connect to MicroStrategy Project dialog box, select MicroStrategy Tutorial from the list of available project sources, type User for the login ID, leave the password blank, and click Get Projects.
5. In the list of available projects, select MicroStrategy Tutorial and click OK. A browsing window opens.
6. To locate the reports, HTML documents, and Flash-enabled documents to include in the Word document, navigate through a project in this window. You can add any report, HTML document, or Flash-enabled document to the Word document. For this evaluation, expand the
Subject Areas folder, and then the Sales and Profitability Analysis folder.

7 Select the Revenue vs. Forecast report and, from the Reports menu, choose Run Report.

Notice all the available options on the Reports menu. You can add the report to the Word document as a grid, graph, PivotTable, and so on. For details about these and other options available to you, refer to the Help by clicking MicroStrategy on the MicroStrategy Office toolbar and then pressing F1.

8 Leave the default prompt answers and click Execute Report. The report runs and the results display—with the report’s formatting—in the Word document.

MicroStrategy Office provides various options to determine the precise manner in which the report is placed on the slide. For details about these options, refer to the MicroStrategy Office online help by clicking MicroStrategy on the MicroStrategy Office toolbar and then pressing F1.

Now that you have finished the MicroStrategy Office evaluation, you are ready to explore other parts of the MicroStrategy platform. Close any open windows (there is no need to save anything) and proceed to Chapter 7, Viewing Reports on a Mobile Device to learn about displaying MicroStrategy dashboards on mobile devices using MicroStrategy Mobile.

MicroStrategy Office gives you the ability to access multiple MicroStrategy projects from within a single Microsoft Office document. You can try this yourself by adding one report from the MicroStrategy Tutorial project and another from the Human Resources Analysis Module (HRAM) project. To learn about HRAM, see Viewing Business Intelligence Applications, page 199. It is recommended that you complete the entire evaluation process before you explore the Analytics Module or business intelligence applications further.
VIEWING REPORTS ON A MOBILE DEVICE

MicroStrategy Mobile Evaluation

Introduction

This chapter walks you through a demonstration of MicroStrategy Mobile. You can use MicroStrategy Mobile to receive reports and documents on your Apple iPhone, iPad, or Android phone or tablet. You can analyze the data in the reports and documents in a variety of ways on your handheld mobile device.

With MicroStrategy Mobile, you and other business users receive the same reports and documents on your mobile devices as you do in MicroStrategy Web, MicroStrategy Office, or MicroStrategy Developer. You can sort data, reposition columns, group data by page, click links to see additional related data, and more.

Apple users can also use MicroStrategy as an app platform to develop apps for your iPhone or iPad. The evaluation includes steps to view some predesigned sample apps created on the MicroStrategy platform for iPhone and iPad. Steps are also included to download the MicroStrategy Mobile for Android app from Google Play.
Prerequisites

- To use this evaluation, you must have installed the MicroStrategy Mobile product, the MicroStrategy Mobile Server, the MicroStrategy Web product, and the MicroStrategy Intelligence Server. If you have not installed these, see *Installing the MicroStrategy Evaluation Edition, page 63* for instructions.

  Requirements for the Mobile Server are the same as for installing and running MicroStrategy Web.

- To evaluate MicroStrategy on a mobile device, you must have a mobile device running the requirements listed in *Software requirements, page 64*.

- For detailed support information on options such as 3rd party authentication servers, browser support, and language support, see the MicroStrategy Readme.

Beginning the MicroStrategy Mobile evaluation

Use the appropriate steps below, depending on whether you are evaluating the MicroStrategy Mobile product for use on an iPhone, iPad, or Android device:

- *Evaluating MicroStrategy Mobile on an iOS device, page 148*
- *Downloading MicroStrategy Mobile for Android, page 166*

Evaluating MicroStrategy Mobile on an iOS device

To use the MicroStrategy Mobile evaluation on an iPhone, perform the following steps.

The steps in this chapter for Apple devices are for use on an iPhone. To view reports and documents on an iPad, use the iPhone steps to download and configure MicroStrategy Mobile on your iPad. Then browse to the sample reports for the iPad at the following default location in MicroStrategy: *MicroStrategy Tutorial*:
To begin the MicroStrategy Mobile evaluation for the iPhone

1. If the MicroStrategy Welcome screen is not already open, from the Windows Start menu point to Programs (or All Programs), then MicroStrategy Tools, and then choose Welcome Screen.

2. Click View reports on iPhone, iPad, or Android. The Home page for MicroStrategy Mobile is displayed.

Downloading and configuring MicroStrategy Mobile on an iPhone

To use the MicroStrategy Mobile evaluation, you must download the MicroStrategy Mobile application to your iPhone from Apple’s App Store®.

To download and configure Mobile from the App Store

1. From the Apple App Store, download MicroStrategy Mobile onto your iPhone.

2. To configure MicroStrategy Mobile on your iPhone, open the MicroStrategy Mobile application from your iPhone.

3. Tap Settings.

4. To connect your iPhone to your MicroStrategy Mobile Server, tap Add Mobile Server and enter the connectivity information as follows:
   - Name: Type the IP address or name of the MicroStrategy Mobile Server.
   - Port: Type the port number that is used by the Mobile Server.
   - Path: Type the path to the Mobile Server.
   - Type: Select ASP.Net.
• **HTTPS**: Select ON or OFF to specify the type of encryption you use to access Mobile Server. Select ON if you use HTTPS (HTTP encryption). Select OFF if you use HTTP (no encryption).

For example, you can configure the Mobile Server and the iPhone to use the same Wi-Fi network.

5 Select the **Authentication Mode** used by your Mobile Server.

6 Tap **Add Project** and add the following connectivity information to connect to the MicroStrategy sample project called Tutorial:

• **Project Name**: For this evaluation, type `MicroStrategy Tutorial`.

• **Server Name**: Type the computer name of the Intelligence Server which hosts the project.

• **Port Number**: Type the port number that is used by the Intelligence Server. 0 indicates the default port, which is 34952 by default for Intelligence Server.

• **Authentication**: Select **Standard**.

• **User Name**: Type `user`.

• **Password**: Leave this blank.

7 Tap the Mobile Server arrow at the top of the screen to return to the previous page.

8 Tap **Settings**, and then tap the **Home** icon at the top of the screen.

Your iPhone is now configured to connect to the MicroStrategy sample Tutorial project. Tap **Shared Library** to browse to the Tutorial project and look at the reports on your iPhone. Steps to locate and view specific reports are below.

---

**Getting started viewing reports on an iPhone**

The following sections walk you through some of the most common business tasks performed using MicroStrategy Mobile.
Viewing reports and documents on an iPhone

As part of the evaluation, you are subscribed to the following reports, which provide examples of how reports and Report Services documents are displayed in MicroStrategy Mobile:

- *Product Analysis document, page 151*
- *Wireless Bill report, page 157*
- *Category Dashboard, page 160*
- *Income Analysis report, page 162*

**Product Analysis document**

This Report Services document contains an interactive grid widget that shows detailed sales, profit, and growth data for product subcategories. Thresholds are applied on each metric, enabling you to instantly identify underperforming subcategories. You can also drill down to the item level on underperforming product categories for further investigation.

To view this document on the iPhone, tap **Shared Library**, tap **MicroStrategy Platform Capabilities**, tap **MicroStrategy Mobile**, and tap **iPhone**. Tap the **Product Analysis** document to execute it. The Product Analysis document opens, as shown below.
This document displays typical MicroStrategy grid report data displayed within an Interactive Grid widget, one of the specialized iPhone widgets available to display data on an iPhone. This report shows sales data for product subcategories. Each subcategory is identified by corresponding images.

The report is grouped by quarter and call center using page-by fields, seen at the top of the report.

Swipe the report vertically to scroll through and see additional product subcategories.

To view a different quarter’s sales figures, tap **2009 Q4** at the top of the report to see the following screen:

```
<table>
<thead>
<tr>
<th>Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td>2009 Q1</td>
</tr>
<tr>
<td>2009 Q2</td>
</tr>
<tr>
<td>2009 Q3</td>
</tr>
<tr>
<td>2009 Q4</td>
</tr>
</tbody>
</table>
```

Notice that 2009 Q4 is checked. This is the default selection for this document. You can choose any other quarter that you want to see data for, by tapping that quarter. This workflow simulates the MicroStrategy page-by experience.

You can also choose a different call center to view, by tapping the call center attribute element (currently **Atlanta**) at the top of the report. This page-by allows you to view subcategory performance at the call center level of detail.
Another selection screen opens, but in this case you select a new call center to view data for:

As with quarter, the default call center that was designated during the document design process is already checked, but you can select any call center to view.
The sample report below shows Charleston as the call center and 2009 Q3 as the quarter:

Tap the Sales metric at the top right of the report to see the next metric that is on this report. The metrics available for analysis include sales, profits, and
growth. You can toggle between the three metrics by tapping whichever one is displayed:

In the example above, subcategory performance is being analyzed in terms of profit. If you choose to view the metric Growth, the following report is displayed:
Notice that the Growth metric is designed to be displayed showing thresholds. In this document, the subcategory images automatically change to reflect the product category that the subcategory belongs to. For example, the image next to the Art & Architecture subcategory indicates that this subcategory is for books, and the data reflects growth in book sales in that subcategory. The image for the Alternative subcategory shows that the data reflects sales growth for music in this subcategory.

Data shown in red identifies drops in growth for a product subcategory. Analysis of this data shows, for example, that the reported growth for the Horror subcategory has dropped in Q3 2009 by 11.6%. To explore this subcategory further, tap **Horror** to drill down to individual items in this product subcategory:

Notice that the page-by fields from the previous, drilled-from report are still displayed at the top of the drilled-to report. This helps the analyst retain the context within which he or she is viewing sales numbers. Additionally, a new page-by field has been automatically added to reflect the fact that you have drilled down into the Movies subcategory of products. This new page-by field makes it easy for the analyst to tap **Movies** and compare the Horror sales figures against other movie genres’ sales figures.

Close the report by tapping and selecting **Back** to return to the list of reports.
Wireless Bill report

This report is designed to simulate the workflow a user follows when looking through a customer’s wireless telephone bill. Like a standard wireless phone bill, this document contains a summary page, an outline of the charges owed by the customer, and details on voice calls as well as text and data usage.

To view this document on the iPhone, tap Shared Library, tap MicroStrategy Platform Capabilities, tap MicroStrategy Mobile, and tap iPhone. Tap the Wireless Bill document to execute it. The Wireless Bill document opens, as shown below:

Notice the rich graphics designed to simulate a paper effect, such as the paper clip at the top left and the shadow. This wireless bill was created as a MicroStrategy Report Services document, and it leverages the rich functionality offered with Report Services documents to simulate a real, paper bill.

Swipe up to view the next summary page. The summary page presents a breakdown of wireless usage for this customer.
Now rotate the device to view voice call and text usage details, as shown below:

<table>
<thead>
<tr>
<th>Voice Usage</th>
<th>Tap to see the Text Usage</th>
</tr>
</thead>
</table>

Rate Code: RM45=450 Rollover Min, MME0=Unlimited Expd M2M, 5KNW=5000 N&W  
Rate Period (PD): D7=Daytime, NW=Nwknd  
Feature: M2MC=EXPANDED M2M

<table>
<thead>
<tr>
<th>Item</th>
<th>Date</th>
<th>Time</th>
<th>Number Called</th>
<th>Call To</th>
<th>Min</th>
<th>Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>145</td>
<td>10/06/2008</td>
<td>12:13:00 PM</td>
<td>555-777-6327</td>
<td>LEESBURG VA</td>
<td>2</td>
<td>$0.00</td>
</tr>
<tr>
<td>146</td>
<td>10/06/2008</td>
<td>7:52:00 PM</td>
<td>555-915-4865</td>
<td>ALEXANDRI VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>147</td>
<td>10/06/2008</td>
<td>7:53:00 PM</td>
<td>555-370-7407</td>
<td>ANNAPOLIS MD</td>
<td>4</td>
<td>$0.00</td>
</tr>
<tr>
<td>148</td>
<td>10/07/2008</td>
<td>12:30:00 PM</td>
<td>555-727-5911</td>
<td>LEESBURG VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>149</td>
<td>10/07/2008</td>
<td>2:17:00 PM</td>
<td>555-727-5911</td>
<td>INCOMING CL</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>150</td>
<td>10/07/2008</td>
<td>4:24:00 PM</td>
<td>555-370-7407</td>
<td>ANNAPOLIS MD</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>151</td>
<td>10/07/2008</td>
<td>4:51:00 PM</td>
<td>555-257-2466</td>
<td>INCOMING CL</td>
<td>4</td>
<td>$0.00</td>
</tr>
<tr>
<td>152</td>
<td>10/07/2008</td>
<td>5:49:00 PM</td>
<td>555-687-6483</td>
<td>MIDDLEBUR VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>103</td>
<td>10/07/2008</td>
<td>5:50:00 PM</td>
<td>555-454-7338</td>
<td>MIDDLEBUR VA</td>
<td>14</td>
<td>$0.00</td>
</tr>
<tr>
<td>153</td>
<td>10/07/2008</td>
<td>6:04:00 PM</td>
<td>555-268-6553</td>
<td>VIENNA VA</td>
<td>2</td>
<td>$0.00</td>
</tr>
<tr>
<td>104</td>
<td>10/08/2008</td>
<td>10:10:00 AM</td>
<td>555-401-2065</td>
<td>INCOMING CL</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>154</td>
<td>10/08/2008</td>
<td>1:41:00 PM</td>
<td>555-727-5911</td>
<td>INCOMING CL</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>105</td>
<td>10/08/2008</td>
<td>5:16:00 PM</td>
<td>555-320-0108</td>
<td>INCOMING CL</td>
<td>8</td>
<td>$0.00</td>
</tr>
<tr>
<td>155</td>
<td>10/08/2008</td>
<td>5:38:00 PM</td>
<td>555-370-7407</td>
<td>ANNAPOLIS MD</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>156</td>
<td>10/08/2008</td>
<td>5:51:00 PM</td>
<td>555-952-0184</td>
<td>BALTIMORE MD</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>157</td>
<td>10/08/2008</td>
<td>7:21:00 PM</td>
<td>555-268-6553</td>
<td>VIENNA VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

You are now viewing the voice usage section of the bill, and by rotating the device you can see call details. This page of the bill shows the wireless subscriber’s call activity. You can zoom in on the data to focus on specific numbers or other information.

This wireless bill is created as a multi-layout Report Services document. A multi-layout document supports both portrait and landscape orientations.
Swipe up and down to page through the multiple page report. Notice that the page number layover at the top left shows the page you are viewing, as shown below:

<table>
<thead>
<tr>
<th>Item</th>
<th>Date</th>
<th>Time</th>
<th>Number Called</th>
<th>Call To</th>
<th>Min</th>
<th>Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>158</td>
<td>10/09/2008</td>
<td>1:35:00 PM</td>
<td>555-257-2486</td>
<td>INCOMING CL</td>
<td>9</td>
<td>$0.00</td>
</tr>
<tr>
<td>159</td>
<td>10/09/2008</td>
<td>5:57:00 PM</td>
<td>555-687-6483</td>
<td>MIDDLETOWN WA</td>
<td>12</td>
<td>$0.00</td>
</tr>
<tr>
<td>106</td>
<td>10/10/2003</td>
<td>11:45:00 AM</td>
<td>555-403-3815</td>
<td>ARLINGTON VA</td>
<td>2</td>
<td>$0.00</td>
</tr>
<tr>
<td>107</td>
<td>10/10/2003</td>
<td>5:33:00 PM</td>
<td>555-454-7338</td>
<td>ARLINGTON VA</td>
<td>9</td>
<td>$0.00</td>
</tr>
<tr>
<td>160</td>
<td>10/13/2003</td>
<td>12:54:00 PM</td>
<td>555-687-6483</td>
<td>MIDDLETOWN VA</td>
<td>7</td>
<td>$0.00</td>
</tr>
<tr>
<td>161</td>
<td>10/14/2003</td>
<td>8:25:00 PM</td>
<td>555-268-6553</td>
<td>VIENNA VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>162</td>
<td>10/14/2003</td>
<td>8:31:00 PM</td>
<td>555-268-6553</td>
<td>VIENNA VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>163</td>
<td>10/15/2003</td>
<td>9:17:00 AM</td>
<td>555-788-4800</td>
<td>FAIRFAX VA</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>164</td>
<td>10/15/2003</td>
<td>11:19:00 AM</td>
<td>555-848-4600</td>
<td>INCOMING CL</td>
<td>7</td>
<td>$0.00</td>
</tr>
<tr>
<td>108</td>
<td>10/15/2003</td>
<td>12:41:00 PM</td>
<td>555-403-3815</td>
<td>ARLINGTON VA</td>
<td>2</td>
<td>$0.00</td>
</tr>
<tr>
<td>165</td>
<td>10/15/2003</td>
<td>2:54:00 PM</td>
<td>555-788-4800</td>
<td>INCOMING CL</td>
<td>5</td>
<td>$0.00</td>
</tr>
<tr>
<td>109</td>
<td>10/15/2003</td>
<td>6:15:00 PM</td>
<td>555-989-8161</td>
<td>ARLINGTON VA</td>
<td>12</td>
<td>$0.00</td>
</tr>
<tr>
<td>166</td>
<td>10/15/2003</td>
<td>6:15:00 PM</td>
<td>555-687-6483</td>
<td>MIDDLETOWN VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
<tr>
<td>167</td>
<td>10/15/2003</td>
<td>8:26:00 PM</td>
<td>555-268-6553</td>
<td>VIENNA VA</td>
<td>3</td>
<td>$0.00</td>
</tr>
<tr>
<td>168</td>
<td>10/16/2008</td>
<td>10:43:00 AM</td>
<td>555-942-5911</td>
<td>INCOMING CL</td>
<td>2</td>
<td>$0.00</td>
</tr>
<tr>
<td>110</td>
<td>10/16/2008</td>
<td>11:43:00 AM</td>
<td>555-454-0671</td>
<td>MIDDLETOWN VA</td>
<td>1</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

Tap the screen to view layout tabs across the bottom of the report. Touch the second tab to view a detailed multi-page text usage report, as shown below:

Layovers in this document include the tabs across the bottom and the page numbers at the top, all of which provide additional page information and navigation tools to the user.
Close the report by tapping and selecting **Back** to return to the list of reports.

**Category Dashboard**

This is a standard MicroStrategy dashboard displayed on an iPhone. The dashboard is designed to provide information about KPIs (key performance indicators) to executives about different product lines.

To view this document on the iPhone, tap **Shared Library**, tap **MicroStrategy Platform Capabilities**, tap **MicroStrategy Mobile**, and tap **iPhone**. Tap the **Category Dashboard** document to execute it. The Category Dashboard opens, as shown below:

![Category Dashboard](image)

This dashboard displays KPIs such as profit margin and inventory on the first screen.
Rotate the device to view this data as a time-series graph. (This display is of a Time Series widget designed specifically for use on an iPhone.)

In this view, notice that the metric Units Sold is tracked on a time scale ranging across the month of Dec 2010. (Dates may differ, as objects are continually updated for MicroStrategy evaluation dashboards.) You can tap 1y to see time series analysis over one year, or 2y to see it over two years.

To change the KPI you are viewing, tap the arrow on the right (as shown below) to see the various combinations of attribute elements and metrics available on the dashboard:
Once the arrow has been tapped so that the list below it expands, you can see and select from the additional KPIs:

When you tap to view a new KPI, the graph is automatically refreshed to show the new attribute elements and metrics values.

This simple dashboard contains multiple metrics, multiple attribute elements, and multiple datasets, but that information is displayed in such a way that users can view one metric at a time, compare two elements at a time, and view datasets on different levels.

The workflow you have completed is similar to what an executive or manager would perform on a web browser, yet the entire workflow is performed on an iPhone. With a simple series of taps and rotations, a user can begin with a summary dashboard and quickly see detailed sales and profit margin figures trending over time. Unnecessary clicks and selections by the user are eliminated.

Close the report by rotating it back to Portrait orientation and tapping Back to return to the list of reports.

**Income Analysis report**

The Income Analysis report provides insight into customer behavior that links average revenue to the number of customers within a given income bracket. This report is a standard MicroStrategy report displayed in grid and graph view. The report is formatted to suit a landscape view.

To view this report on the iPhone, tap Shared Library, tap MicroStrategy Platform Capabilities, tap MicroStrategy Mobile, and tap iPhone. Tap the Income Analysis report to run it. Accept the default answers for any
prompts that are displayed. The Income Analysis report opens, as shown below:

This report shows both a grid report and a graph report. The grid report dissects customer behavior based on income brackets. The graph report provides a visual representation of the data shown in the grid report.

For example, the organization has just over 22,500 customers who fall into the $50,000 to $80,000 per year income bracket. On average, this group spends about $292.

Rotate the device to landscape orientation to see detailed segments of the graph. In this case, details include data for income brackets at a more granular level. A new graph is displayed which expands on the previously viewed data by showing income brackets in increments of $10,000 each, as
shown below. The image below shows the graph after the device has been rotated to show a landscape display:

![Customer Income Analysis](image)

Close the report by tapping and selecting **Back** to return to the list of reports.

## Evaluating additional reports and dashboards

You can explore the following additional dashboards for the iPhone. These dashboards are located at:

```
MicroStrategy Tutorial\Public Objects\Reports\MicroStrategy Platform Capabilities\MicroStrategy Mobile\iPhone
```

While exploring these dashboards, you can experience the following features:

- **Best Sellers dashboard**
  - A Report Services document
  - Shows KPIs for best selling product in each product category
  - Tap each section to view top and bottom 25 items for the selected category
  - Contains an Interactive Grid widget on each layout of the dashboard
Hides column headers
Contains a link at the bottom to the 25 bottom sellers

- Customer Analysis report
  - A typical grid display of data
  - Contains multiple page-by fields at the top of the report
  - Swipe vertically or horizontally to change the page-by selections
  - Row and column headings are locked, a useful feature for large reports
  - Report fits nicely in landscape mode when the device is rotated
  - Overlay of full screen mode display shows current page-by selections

- Product Trend report
  - A typical prompted, cross-tabbed report
  - Contains several prompt display styles, including a stepper prompt for choosing the year, a switch prompt for choosing promotion, a slider prompt for choosing minimum profit to display, and an element list prompt for choosing the city.
  - Rich graphics and formatting, with threshold images on metrics
  - Includes images for each product category
  - Provides subtotals
  - Swipe horizontally and vertically to view more data, or rotate the device to view data in landscape orientation
  - Several features are disabled to control the user’s experience, including drilling and zooming

- Nearby Stores dashboard
  - A multi layout dashboard showing the Map widget, with prompts
  - The Location prompt uses the iPhone’s GPS feature; click the icon to update your current location
Evaluating predesigned apps built in MicroStrategy

There are several predesigned apps available that can be viewed within MicroStrategy:

- An app to track restaurant trends
- An app to track casino gaming revenue

You can view the predesigned apps to evaluate the MicroStrategy platform’s capability to generate apps such as these.

Next steps in the evaluation process

For steps to continue with the evaluation of MicroStrategy functionality, see Next steps in the evaluation process, page 167.

Downloading MicroStrategy Mobile for Android

You can see sample dashboards and sample apps on an Android phone or tablet using MicroStrategy Mobile for Android. This section provides steps to download MicroStrategy Mobile for Android, and steps to download sample apps that can be used on an Android device.

To download the MicroStrategy for Mobile Android app, perform the following steps.

To download Mobile Universal for Android

1. If the MicroStrategy Welcome screen is not already open, from the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2. Click View reports on an iPhone, iPad, or Android. The User Home page for MicroStrategy Mobile is displayed.

3. Click Android-enabled devices.
4 Follow the steps to download the MicroStrategy Mobile app from Google Play onto your Android tablet or phone. The app comes with several sample dashboards that were built using the MicroStrategy Business Intelligence platform.

5 Explore each dashboard above and experience rich visualizations, multi-touch tables, grids, graphs, and interactive reporting.

**Next steps in the evaluation process**

You have learned the basics of analyzing MicroStrategy reports using an Apple iPhone or iPad or an Android device. You are now ready to explore additional features and functionality of the MicroStrategy platform.

Return to the User Home page and click **Next Steps**. The Next Steps page opens. From this page, you have the following options:

- To explore products other than MicroStrategy Mobile, return to the Welcome screen (on the Windows **Start** menu, point to **Programs**, then to **MicroStrategy Tools**, and then choose **Welcome Screen**). Follow the instructions on the Welcome screen to access other product evaluations.

- To view examples of business intelligence applications, click **View Business Intelligence Applications** and see **Viewing Business Intelligence Applications, page 199**.

  It is recommended that you complete the entire recommended evaluation process prior to exploring the Analytics Module or business intelligence applications.
Introduction

MicroStrategy Distribution Services is a component of the platform architecture that performs high-volume and high-efficiency distribution of reports, documents, and dashboards with low administrative overhead. Distribution Services runs on a full range of operating systems; see the MicroStrategy Readme for details.

Business users can set up information flows for themselves and other users by subscribing to report and document deliveries. Users view and change subscriptions created by or for them in their My Subscriptions page in MicroStrategy Web. Users can freely personalize deliveries by selecting delivery formats and locations, such as:

- Format: HTML, Flash, PDF, Excel, zip file, plain text, CSV, or bulk export
- Delivery location: Email, network printer, file server (including portals and PCs), or the user’s MicroStrategy History List, which serves as a report archive and immediately informs the user of the delivery by email
Users can also set up various distribution triggers so that they only need to look at reports when the situation requires it. Triggers include:

- **Send Now**
- **Time-based triggers**, for example, scheduling distribution for every Monday morning or at the end of the fiscal quarter
- **Event-based triggers**, for example, scheduling distribution for when the books are closed or when data loading is complete
- **Alert-based (exception threshold) triggers**, for example, scheduling distribution for when inventory drops below 10% or when metrics indicate projected customer churn

Reports/documents that are subscribed to for delivery can be compressed and password-protected. The standard MicroStrategy security credentials are applied for each user subscribed to receive a report or document.

From an operations perspective, Distribution Services’ scheduling feature allows you to schedule reports and documents to run overnight during off-peak hours, thereby freeing up database and server resources for interactive use during peak hours of the day.

Distribution Services is integrated with Intelligence Server’s performance and stability features including:

- Clustering, job load balancing, execution control, fail-over, object caching, Intelligent Cubes, database optimization, multisource data access, Web-based user and contact administration
- Internationalization via reporting and delivery using multiple language data sources and metadata
- Administrative tools such as Command Manager for script-based administration, Enterprise Manager for enterprise business intelligence analysis, and Object Manager for life cycle management

## Administering report delivery

The administrative tools available with Distribution Services let you set up how reports and documents are transformed into emails and files and sent to email recipients, file locations, or printers. These administrative tools include transmitters, devices, and contacts.
About transmitters

Transmitters are software components that Distribution Services uses to transform MicroStrategy reports and documents into emails and files and send those emails and files to email recipients, network file locations, or network printers. Distribution Services comes with default email, file, and print transmitters that you can use to create email, file, and print devices.

About devices

Devices are transmitters that have specific transmission and delivery properties. Devices specify the delivery format of a MicroStrategy report or document and the transmission process that sends the report or document to users who subscribe to it. For example, if you want to send a report to a file location, you can create a file device (based on a File transmitter) that specifies a particular file delivery location and file properties, such as appending the current date to the file delivery location, time out settings, and so on.

Distribution Services comes with default email, file, and print devices that are already set up, out of the box. You can use the default devices as is, modify their settings according to your requirements, or create your own devices from scratch if you require additional devices with different combinations of properties. For example, you may require one email device to send emails to Microsoft Outlook and a separate device to send emails to web-based email accounts such as Yahoo, Gmail, Hotmail, and so on.

About contacts

Contacts provide a user with a set of associated email addresses, file delivery location, and network printer delivery locations. To make it easier to manage all the addresses and delivery locations for a user, you can create a contact for each address and delivery location. Contacts allow you to group multiple addresses together by linking those contacts to a MicroStrategy user. The user linked to the contacts can have reports and documents subscribed to the contacts, and thus the reports and documents are delivered to selected addresses and delivery locations defined for those contacts. Since a contact can be linked to only one MicroStrategy user account, no other users can access or see the address in a contact.
A contact can also be used to schedule report and document delivery to people who are not MicroStrategy users and do not have user accounts. For example, company shareholders may need to receive a financial document every month. One contact is created for each recipient’s email address, and then a MicroStrategy user is created, perhaps named Shareholder Finances, and the contacts are linked to that user. The user is subscribed to the document to be delivered on a schedule, and that user’s security profile is applied to the document execution and delivery. The addresses that the document is delivered to are the individual shareholders’ email addresses that make up each contact linked to the user.

Evaluating Distribution Services

Use the Send Now and Subscribe functionalities in MicroStrategy Web to experience Distribution Services features in action. Specifically, you can evaluate Distribution Services by using the steps in the sections linked to below:

- **Immediate Delivery: Sending a report via email**, page 124
- **Automated Delivery: Receiving reports regularly via email**, page 126
- **Automated Delivery: Automatically archiving reports**, page 127

Next steps in the evaluation process

Now that you have learned about the basics of information delivery using Distribution Services, you can explore some additional features as described below:

- To explore products, return to the Welcome screen (on the Windows Start menu, point to Programs, then to MicroStrategy Tools, and then choose Welcome Screen). Follow the instructions on the Welcome screen to access other product evaluations.

- To locate additional product documentation and online resources for Distribution Services, click Find Additional Resources. Additional resources include:
  - MicroStrategy corporate website
- Distribution Services section of the System Administration Guide, and the Developer Help

Click the links on the page to access the different resources. When you are finished, proceed to *Building a Reporting Application, page 175*. 
Introduction

A MicroStrategy project is the starting place for your users to locate reports and documents, to run those reports and documents, and to analyze data and make important business decisions. A project is where report and document designers locate objects to use on the report or document they are designing, and where they save the completed report/document for analysts to access. A project holds all of the objects your organization develops that need to work together now or in the future, to develop the reports/documents you need for effective business intelligence.

Projects are listed in Developer’s Folder List, which is displayed on the left as shown in the image below. In MicroStrategy Web, projects are listed on the
Projects page when you first open Web, or immediately after you log in, depending on how Web is configured.

MicroStrategy comes with a sample project, called MicroStrategy Tutorial, shown in the image above. MicroStrategy Tutorial contains sample data you use throughout this evaluation. You can also use the Tutorial objects to test various MicroStrategy functionality before you create your own objects.

From a technical perspective, a project is a MicroStrategy object stored in the metadata. Each project represents a business intelligence reporting application. Projects store the mapping between other MicroStrategy objects, the MicroStrategy user community, and the physical data warehouse.

About MicroStrategy Architect

MicroStrategy Architect is a project design tool. Architect allows you to define all the required components of your project from a centralized
interface. Architect also provides a visual representation of your project as you create it, which helps to provide an intuitive workflow.

Architect allows you to see your project taking shape as you create it. For a detailed introduction to Architect and steps to use all of its functionality, see the *MicroStrategy Project Design Guide*.

With Architect you can perform all tasks related to initial project creation as well as modifications required over the full life-cycle of a project. Architect provides a single integrated environment in which you can make project-wide changes as well as create or modify multiple schema objects at the same time. Architect also allows you to add tables to your project and create or modify attributes, facts, and user hierarchies all from the same interface.

Modifying your project using Architect also allows you to lock the schema of your project, preventing users from encountering reporting issues or returning outdated data during periods of scheduled project maintenance.

Using the detailed instructions in the context-sensitive Help within Architect, you can rapidly build project prototypes, proof-of-concept tests, and create the foundation for any MicroStrategy project.

**Evaluating projects and their objects**

A MicroStrategy project can be considered to be divided into three layers:

1. Schema layer: The schema layer is comprised of four key objects:
   - Facts: Facts relate numeric data values from the data warehouse to the MicroStrategy reporting environment. Facts generally represent the answers to the business questions on which users want to report.
   - Attributes: Attributes provide the business model with a context in which to report on and analyze facts.
   - Tables: Tables are logical representations of physical database tables.
   - Transformations: Transformations can be used to perform time-series analysis. Transformations are schema objects created using attributes in your project.

The schema layer of a project is built using MicroStrategy Architect.
Business abstraction layer: This layer is comprised of four key objects:

- **Metrics**: Metrics represent business measures that are analytical calculations to be performed on data from a relational database. A metric equation is generally made up of facts plus arithmetic operators.

- **Filters**: A filter qualifies the report content and represents the conditions that data must meet in order to be included in the report results.

- **Templates**: Templates specify the information to be retrieved from a database and its layout, formatting, and presentation.

- **Prompts**: Prompts provide user interaction by allowing them to choose information before the report is executed. Prompts allow users to define the report, thus allowing the resulting display to be dynamic.

The business abstraction layer is built using MicroStrategy Developer or MicroStrategy Web.

Reporting layer: The reporting layer is comprised of reports, documents, and dashboards, which are built using objects from the schema layer and the business abstraction layer.

The reporting layer is built using MicroStrategy Developer or MicroStrategy Web.

This chapter walks you through the project creation process using the MicroStrategy Tutorial sample data warehouse. After you finish creating a project using Architect, you can access your project using MicroStrategy Web, MicroStrategy Developer, and MicroStrategy Office.

Details on the objects in the MicroStrategy Tutorial sample project, which showcase various aspects of MicroStrategy’s functionality, are available in the *MicroStrategy Project Design Guide*.

Starting MicroStrategy Architect

**To start Architect**

1. If the MicroStrategy Welcome screen is not already open, from the Windows **Start** menu, point to **Programs**, then **MicroStrategy Tools**, and then choose **Welcome Screen**.
2 Click **Build your own reporting application**. MicroStrategy Developer opens.

3 Log in using the **Login ID** of **Architect**, and leave the **Password** field empty. Each login ID grants you a specific level of access to the MicroStrategy platform.

4 In the Folder List on the left, expand **My First Project**.
   - If the Folder List is not visible, from the **View** menu select **Folder List**.

The project home page opens, as shown below. My First Project is designed to pull data from the sample Tutorial data warehouse that comes with MicroStrategy.

5 Right-click the **My First Project** name, and select **Architect**.

6 If a message is displayed asking if you want to open Architect in read only mode or edit mode, select **Edit** and click **OK** to open Architect in edit mode so that you can make changes to the project. MicroStrategy Architect opens.

   Note the following:
   - If you are only given the option of opening Architect in read only mode, this means another user is modifying the project’s
schema. You cannot open Architect in edit mode until the other user is finished with their changes and the schema is unlocked. If no one is editing the schema, you can change read only mode to edit mode: in Architect, from the **Schema** menu, ensure that **Read Only Mode** is cleared.

- For information on how to use read only mode and edit mode for various schema editors, see the *Project Design Guide*.

Architect displays with the following features, which are shown in the image below:

- Warehouse Tables pane: In this pane, project designers can access the data warehouse and select the tables containing data to be made available for the project. This area provides a real-time view of the data source, giving the project designer the ability to update table structures as you build the project.

- Project Tables View area: In this area, a project designer can abstract warehouse tables into physical representations in the MicroStrategy metadata repository, where MicroStrategy objects are stored. Project designers can define attributes and facts based directly on a given warehouse table.

- Hierarchy View area: In this area, a project designer can group attributes logically into hierarchies. This area provides a real-time view of the project model, allowing designers to build attributes in the Project Tables View area and combine them into logical groups in the Hierarchy View area.

- Properties pane: In this pane, project designers can view various details about the current object selected, as well as modify the object.

- Architect toolbar: This set of toolbar icons facilitate the tasks of creating and modifying a project. To review detailed information on each toolbar
option, with Architect open, press F1 to open the Architect online help and search for the topic *Architect: Toolbar options.*

Using MicroStrategy Architect, this evaluation takes you through the steps to build a business intelligence retail application (project), based on the sample Tutorial warehouse. In this application, you build the three hierarchies (sometimes called dimensions) Product, Time, and Region, and a fact table called `SUBCATEG_MNTH_CTR_SLS`.

**Building the schema layer using Architect**

A schema layer is comprised of tables, attributes, and facts. Attributes and facts are used to build the business abstraction layer that comes next in the project design process.

You begin by dragging warehouse tables that contain pertinent data into the project design tool.
To create tables in the Project Tables area

1. In Architect, from the **Design** tab, in the **Auto Recognize** area, click the arrow icon (➡️), as shown in the image below:

   ![Design Tab with Auto Recognize](image)

   The Automatic Schema Recognition dialog box opens.

2. Select the **Do not auto recognize** option, and click **OK**.

3. From the **Warehouse Tables** pane, expand the **Tutorial Data** data source to display all available tables in that data source.

4. Drag and drop the following tables into the Project Tables View area: **LU_YEAR**, **LU_QUARTER**, and **LU_MONTH**. These tables constitute the **Time hierarchy**.

5. Drag and drop the following tables into the Project Tables View area: **LU_COUNTRY**, **LU_REGION**, and **LU_CALL_CTR**. These tables constitute the **Geography hierarchy**.

6. Drag and drop the following tables into the Project Tables View area: **LU_CATEGORY** and **LU_SUBCATEG**. These tables constitute the **Product hierarchy**.

7. Drag and drop the following table into the Project Tables View area: **SUBCATEG_MNTH_CTR_SLS**. This is the **Fact table**.

8. Click **Save** to save your changes.

Next, you define the attributes to be used in your project, which are based on the tables you selected above and grouped into the hierarchies described above.
To create attributes in the Project Tables View

1. In Architect, from the Design tab, in the Auto Recognize area, click the arrow icon (➡️), as shown in the image below:

   ![Image of Design tab with Auto Recognize](image)

   The Automatic Schema Recognition dialog box opens.

2. From the Automatic Column Recognition options, select Auto Recognize. Then click OK.

   When this setting is enabled, Architect automatically creates attributes and facts based on selected table columns. You can save time during the schema creation phase of designing a project by allowing Architect to automatically map columns to attribute forms and facts already defined in your project. Architect can map columns to existing attribute forms and facts automatically when you add tables to your project.

3. Begin creating attributes by defining the attributes that make up the Time hierarchy. In the Project Tables View, in the LU_YEAR table, select the YEAR_ID column. Right-click the column and select Create Attribute. The Year attribute is created.

   Notice that the Year attribute has been created in the LU_YEAR table, based on the YEAR_ID column. This attribute is also automatically created in the LU_QUARTER and LU_MONTH tables, also based on the YEAR_ID column.

   If the Year attribute did not automatically get created in the LU_QUARTER and LU_MONTH tables, you can select the YEAR_ID column in both tables and drag them on top of the Year attribute to make sure those columns are part of the attribute’s definition.

4. Select the Year attribute.

   Notice that the Properties pane appears on the right. (If it does not, from the Home tab, in the Panels area, click Show the properties section.) This pane shows all of the properties that make up this attribute’s definition. In the Properties pane, you can modify specific properties for any attribute or fact with one click.
5 In the **Properties** pane, click the first attribute form, called **ID**. The ... (Browse) button appears. Click ... and the Modify Attribute Form dialog box opens. This dialog box displays the tables that the Year attribute’s definition is based on, as shown below:

![Modify Attribute Form](image)

6 Click **Cancel** to close the Modify Attribute Form dialog box.

7 In the **Project Tables View** area, in the **LU_QUARTER** table, select the **QUARTER_ID** column. Right-click this column and select **Create Attribute**. The Quarter attribute is created. This attribute is defined based on the **LU_QUARTER** table and the **LU_MONTH** table.

8 In the **LU_QUARTER** table, drag and drop the **QUARTER_DESC** column onto the Quarter attribute. This column is added to the Quarter attribute as a new attribute form, providing a description of the attribute.

In the **Properties** pane, you can see this new DESC form appear beneath the ID form.

9 From the **Home** tab, in the **View** area, click the **Logical View** toolbar option. This step is shown in the image below:

![Logical View](image)

Then in the same **View** area, click the arrow icon (👉) to access and select all of the following check boxes:

- **Display available columns on logical tables**
• Display used columns on logical tables

• Display attribute forms on logical tables

Your Quarter attribute should appear as shown below:

In the LU_MONTH table, right-click the MONTH_ID column and select Create Attribute. Then drag and drop the MONTH_DESC column onto the newly created Month attribute.

Notice that the Month attribute is automatically mapped to the fact table SUBCATEG_MNTH_CTR_SLS. You have now created the Time hierarchy, as shown at the bottom of the LU_MONTH table and in the image below:

Now define the Product hierarchy. From the LU_CATEGORY table, right-click the CATEGORY_ID column and select Create Attribute. The Category attribute is created. Drag and drop the CATEGORY_DESC column onto the new Category attribute.
12 In the `LU_SUBCATEG` table, right-click the `SUBCAT_ID` column and select **Create Attribute**. You have now created the Product hierarchy, as shown in the image below:

![Product Hierarchy Image]

13 Now create the Geography hierarchy, using the following definitions to create each attribute:

- **Country attribute:**
  - ID form: Right-click the `COUNTRY_ID` column in the `LU_COUNTRY` table and select **Create Attribute**.
  - Description form: Drag and drop the `COUNTRY_NAME` column onto the new Country attribute.

- **Region attribute:**
  - ID form: Right-click the `REGION_ID` column in the `LU_REGION` table and select **Create Attribute**.
  - Description form: Drag and drop the `REGION_NAME` column onto the new Region attribute.

- **Call Center attribute:**
  - ID form: Right-click the `CALL_CTR_ID` column in the `LU_CALL_CTR` table and select **Create Attribute**. This attribute should also map to the fact table `SUBCATEG_MNTH_CTR_SLS`.
Description form: Drag and drop the CENTER_NAME column onto the new Call Center attribute.

You can rename an attribute at any time by double-clicking the attribute.

After all attributes have been defined, your SUBCATEG_MNTH_CTR_SLS fact table should look like the following:

Next, you define facts for the project, based on the fact table SUBCATEG_MNTH_CTR_SLS.

To create facts in the Project Tables View

1. Right-click the heading of the fact table SUBCATEG_MNTH_CTR_SLS and select Recognize, then select Facts. The Results Preview dialog box opens.

2. Four facts are displayed, with check boxes for each fact. Leave all check boxes selected to automatically create the facts, and click OK.

The facts are created beneath the attributes, as shown in the image below. This fact recognition is performed using the heuristics capability.
embedded in Architect. This capability allows Architect to automatically create facts and attributes, reducing the manual effort.

You can always define one fact at a time by right-clicking a column and selecting **Create Fact**.

Next, you group related attributes to define hierarchies in the Hierarchy View.

---

**To create hierarchies in the Hierarchy View**

1. Begin by creating the Time hierarchy. In Architect, select the **Hierarchy View** tab.

2. Click the **Year** attribute.

Notice that the Quarter and Month attributes remain solid yellow while the other attributes become partially transparent as if grayed out. This indicates that Quarter and Month are logical candidates to become part of the hierarchy that Year will be a part of, and are available for a parent-child relationship.
3 Click Year and drag to Quarter, then release, to create a connecting line between the two attributes. When you release the mouse button, the relationship is depicted as shown below:

![Image](image)

This creates a one-to-many relationship between the two attributes, specifically, one year to many quarters, with Year as the parent attribute and Quarter as the child attribute. You can edit the relationship by right-clicking the line or either of the attributes.

4 Use the same technique to define a relationship between Quarter and Month, to create the Time hierarchy as shown below:

![Image](image)

5 Define a relationship between the Category attribute (parent) and the Subcategory attribute (child), to create the Product hierarchy.

6 Define relationships between the Country attribute (parent) and the Region attribute (child), and then between the Region attribute (parent) and the Call Center attribute (child), to create the Geography hierarchy.

All three hierarchies are shown below, after clicking **Regular** from the Auto Arrange Hierarchy Layout area of the Architect toolbar:
7 Click **Save** to save all your changes. Then, from the **Architect Button** menu, select **Close** to close Architect. The Schema Update dialog box opens.

8 It is important to update the project schema before you begin defining your business abstraction layer. Ensure the check boxes are all selected and click **Update**.

**Building the business abstraction layer using Developer**

The business abstraction layer is comprised of metrics, filters, and prompts. This evaluation shows you how to create two metrics and a filter for your new project.

---

**To create metrics**

1 In Developer, in the Folder List on the left, under My First Project, expand **Public Objects**, then select **Metrics**.

2 On the right side of Developer, right-click, point to **New**, and select **Metric**.
3  Click **OK**. The Metric Editor opens, as shown below:
4 On the left, drag and drop Tot Dollar Sales into the Definition pane at the lower right. The following metric expression appears as shown below:

Facts for a project are stored inside the Schema Objects folder, in the Facts folder. You can browse to any project folder within the Metric Editor.

Notice that a Sum aggregation function has been automatically added to the fact, to create the equation. You can change the aggregation function by clicking $f(x)$ at the top of the Definition pane. You can use a combination of mathematical operators and functions on facts, to create complicated metric definitions.

5 Click Save, and name the new metric Revenue.

6 Create three more metrics, all using the Sum function:

- Cost metric: Defined as Sum(Tot Cost), and named Cost.
- Dollar Sales metric: Defined as Sum(Gross Dollar Sales), and named Dollar Sales.
• Total Unit Sales metric: Defined as Sum(Tot Unit Sales), and named Total Unit Sales.

You have now defined the four metrics for this project. Using a combination of facts, functions, operators, and metrics, you can define a large number of metrics quickly. For example, the Profit metric can be created by defining it as the Revenue metric minus the Cost metric (Revenue - Cost).

Next, you build a filter.

To create a filter

1 In Developer, in the Folder List on the left, under My First Project, expand Public Objects, then select Filters.

2 On the right side of Developer, right-click, point to New, and select Filter.

3 Click OK. The Filter Editor opens, as shown below:

4 The filter will be defined based on the Category attribute you created earlier. In the Filter Editor, from the drop-down list below Object Browser, select Schema Objects. Then double-click the Attributes folder.
5  Drag and drop the **Category** attribute to the right side of the Filter Editor. The Attribute Qualification pane opens in the lower right of the Filter Editor, as shown below:

6  Click **Add**. The Select Objects dialog box opens.

7  Double-click **Books** and **Electronics** on the left, to move them to the right. Then click **OK** to close the Select Objects dialog box.

8  In the Filter Editor, click **Save and close**. Name your new filter **Category = Electronics and Books**, and click **Save**.

Another way to create a filter is to use either the ID form or the DESC form of the Category attribute as your qualifying condition. You can do
this by selecting ID or DESC from the Qualify On drop-down list in the Filter Editor’s Attribute Qualification pane, as shown below:

You can also create a filter with multiple qualifications using one or more attributes or metrics. For example, you can create a filter named Category = (Books and Electronics) and Year = (1997).

This completes your filter and defines your business abstraction layer. Next, you build reports that use the objects you created for your project.

**Building the reporting layer using Developer**

The reporting layer is comprised of reports, documents, and dashboards. The reporting layer is built with objects defined in the business abstraction layer and the schema layer, above.

**To create reports**

1. In Developer, in the Folder List on the left, under My First Project, expand **Public Objects**, then select **Reports**.
2 On the right side of Developer, right-click, point to New, and select Report.

3 Click OK. The Report Editor opens.

4 In the Object Browser at the top right, browse to and open the Schema Objects folder, then open the Attributes folder.

5 Double-click the Year attribute (from the Time folder) so that it is moved to the report layout. Double-click the Category attribute (in the Products folder) so that it is moved to the report layout. The attributes should appear as shown below:

6 Browse to the Public Objects folder and open the Metrics folder. Double-click the Cost metric and the Revenue metric so that they are added to the report layout.
7 In the Public Objects folder, open the Filters folder. Double-click the filter named **Category = Electronics and Books** so that it is added to the report layout. Your finished report layout should appear as follows:

8 Click the Grid View icon to execute the report. This is the report view that an analyst sees:
9 Save the report as **Category Revenue by Year.**

You can convert this report into a document, by selecting **Create Document** from the **File** menu.

You can then build your reporting layer by creating thousands of reports using the objects created in the schema layer and in the business abstraction layer.

**Next steps in the evaluation process**

You have learned the basics of creating a project and project-related objects using MicroStrategy Architect. You are now ready to explore additional features and functionality of the MicroStrategy platform.

Return to the Welcome page (on the Windows **Start** menu, point to **Programs**, then to **MicroStrategy Tools**, and then choose **Welcome Screen**):

- To explore other products, follow the instructions on the Welcome screen to access other product evaluations.
- To view examples of business intelligence applications, click **View Business Intelligence Applications** and see **Viewing Business Intelligence Applications, page 199.**

   It is recommended that you complete the entire evaluation process prior to exploring the Analytics Module and business intelligence applications.
Introduction

The Human Resources Analytics Module is a set of packaged analytic reports, documents, and other components built using the MicroStrategy platform. It is a pre-created business intelligence application.

You can use the Analytics Module as a starter kit to begin developing your own custom analytic applications, and you can use the reports and documents as examples for your own report and document design work. The module is also designed to be mapped directly to your existing data warehouse as opposed to being hard-coded to a vendor-provided data model and data warehouse.

The Analytics Module provides a framework for rapid application development that provides you with an ideal analytical framework to jump start your application initiative. It consists of MicroStrategy Developer, MicroStrategy Architect, and the Analytics Module. The module comes with a sample data model and a collection of packaged reports that allow dozens of analytical variations.

This chapter walks you through an evaluation of the Human Resources Analytics Module. To view it in a Web browser, see Viewing reports in a web.
The Human Resources Analysis Module

MicroStrategy’s Human Resources Analysis Module (HRAM), built using the MicroStrategy platform, provides the power, scalability, and sophistication to analyze all aspects of human resources data, both summarized and detailed. The module comes with a sample data model and a collection of packaged reports that allow dozens of analytical variations.

HRAM queries human resources data optimized for OLAP reporting and analysis, and it can be deployed on top of your existing HR management system. From HRAM, you can extract reports directly from your HR management systems. These reports can replace those typically produced manually. You can also produce additional business reports that allow managers at all levels to focus on the performance of their employees, drill down to a detailed, individual employee level, view trends, and extract intelligence not otherwise evident.

The module can be easily modified and extended to meet additional reporting and data requirements. Summary and detailed reports are broken into areas such as:

- Attrition reports
- Compensation
- Departures, transfers, and new hires
- Employee expenses
- Employee history and detail
- Headcount reports and organizational structure

The Human Resources Analysis Module Reference contains detailed descriptions of all the reports in HRAM.
Viewing reports in a web browser

Because the products within the MicroStrategy platform are seamlessly integrated, you can explore the Human Resource Analysis Module as an end user using either MicroStrategy Developer or MicroStrategy Web.

This section describes how to use MicroStrategy Web to explore the Human Resources Analysis Module. To use the Human Resources Analysis Module in MicroStrategy Developer, see Viewing reports in MicroStrategy Developer, page 203.

To access HRAM using MicroStrategy Web

1. Return to the Welcome screen. You can open it from the Windows Start menu. Point to Programs, then MicroStrategy Tools, and then choose Welcome Screen.

2. Click View other business intelligence applications. MicroStrategy Web opens.
3 Log in as **User** with a blank password, and click **Login**. The Analytics Modules User Home page is displayed, as shown in the image below:
Click **Human Resources Analysis Module**. The HRAM Home page is displayed, as shown in the image below:

5. Click any of the report categories to see the reports grouped in that category. Click any document or report to run it.

### Viewing reports in MicroStrategy Developer

Use the following steps to explore the Human Resources Analytics Module using MicroStrategy Developer.

**To access HRAM using MicroStrategy Developer**

1. From the **Start** menu, select **Programs**, then **MicroStrategy Products**, and then click **Developer**.

2. Log in as **User** with a blank password and then click **OK**.
3 If it is not displayed, open the Folder List by selecting **Folder List** from the **View** menu.

4 In the Folder List, double-click the **Human Resources Analysis Module** project to open the HRAM User Home page.

5 Click **Human Resources Analysis Module**. Different types of Human Resources reports and documents are grouped into categories, as shown below:

6 Do one of the following:
   - To run a document or report, click the document or report’s link. Be sure to close each document or report when you finish using it. You do not need to save any changes, so click **No** if prompted.
   - To explore additional reports in the areas of Attrition Analysis, Recruitment Analysis, or Compensation Analysis, click the **More reports...** link at the bottom of the appropriate category.
   - To view additional areas of analysis, click **More Areas of Analysis** at the bottom of the HRAM User Home page.
• To return to the HRAM User Home page, double-click the Human Resources Analysis Module project from the Folder List. Click Human Resources Analysis Module to open the HRAM User Home page.

To view detailed descriptions of reports in HRAM, see the Human Resources Analysis Module Reference. Information on this reference guide can be found in Resources, page xviii.
Introduction

This chapter provides information on enhancing your project, and steps to create a Report Services document. This chapter also directs you to other product documentation resources to help you start creating sophisticated applications using the MicroStrategy platform.

Enhancing your project

This guide takes you through most of the fundamental features of the MicroStrategy platform, but there is a great deal of additional functionality left to discover. The following table lists some ways in which you can further enhance your project. It also provides a pointer to the MicroStrategy guides that can help you accomplish these tasks.
All of the guides are available in PDF format from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp), as well as from your MicroStrategy disk, as described in *Resources, page xviii.*

<table>
<thead>
<tr>
<th>To Learn How To</th>
<th>Use This Manual</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add new facts, attributes, and hierarchies to your project</td>
<td><em>Project Design Guide</em></td>
</tr>
<tr>
<td>Modify existing facts, attributes, and hierarchies</td>
<td><em>Project Design Guide</em></td>
</tr>
<tr>
<td>Create sophisticated reports and metrics</td>
<td><em>Advanced Reporting Guide</em></td>
</tr>
<tr>
<td>Create and maintain a security architecture including users, groups, security</td>
<td><em>System Administration Guide</em></td>
</tr>
<tr>
<td>roles, and security filters</td>
<td><em>Supplemental Reference for System Administration Guide</em></td>
</tr>
<tr>
<td>Create schedules for report delivery</td>
<td><em>System Administration Guide</em></td>
</tr>
<tr>
<td>Monitor the MicroStrategy system</td>
<td><em>System Administration Guide</em></td>
</tr>
<tr>
<td>Format and analyze report data</td>
<td><em>Basic Reporting Guide</em></td>
</tr>
<tr>
<td>Design an interactive dashboard to view on an iPhone, iPad, or Android device</td>
<td><em>Mobile Design and Administration Guide</em></td>
</tr>
<tr>
<td>Use MicroStrategy Office with Microsoft Office applications</td>
<td><em>MicroStrategy Office User Guide</em></td>
</tr>
<tr>
<td>Upgrade an existing MicroStrategy system to the current MicroStrategy platform</td>
<td><em>Upgrade Guide</em></td>
</tr>
<tr>
<td>functionalty</td>
<td></td>
</tr>
</tbody>
</table>
Creating documents

The image below shows the Regional Profits and Margins document, which is available in the sample Tutorial project:

![Image of Regional Profits and Margins document]

<table>
<thead>
<tr>
<th>Region</th>
<th>Year</th>
<th>Call Center</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Northeast</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2005</td>
<td>Boston</td>
<td>$168,710</td>
<td>24.21%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$129,762</td>
<td>24.29%</td>
</tr>
<tr>
<td></td>
<td>2006</td>
<td>Boston</td>
<td>$151,891</td>
<td>24.10%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$114,216</td>
<td>24.04%</td>
</tr>
<tr>
<td><strong>Mid-Atlantic</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2005</td>
<td>Washington, DC</td>
<td>$181,425</td>
<td>24.28%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Charleston</td>
<td>$251,116</td>
<td>24.21%</td>
</tr>
<tr>
<td></td>
<td>2006</td>
<td>Washington, DC</td>
<td>$161,321</td>
<td>24.20%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Charleston</td>
<td>$232,507</td>
<td>24.17%</td>
</tr>
</tbody>
</table>

The Report Services product lets you create documents, which deliver the most flexible report layout, with drag-and-drop simplicity and positioning. Report Services documents also provide comprehensive formatting capabilities. MicroStrategy Developers and MicroStrategy Web Professionals
can build Pixel Perfect documents such as scorecards and dashboards, operational reports, invoices and statements, managed metrics reports, and more. These documents can be distributed to MicroStrategy Web, MicroStrategy Office, MicroStrategy Developer, and MicroStrategy Mobile users.


Use the Regional Profit and Margins report, shown below, as a dataset in the document, to provide the warehouse data to display. This report is available in the sample Tutorial project in Public Objects\Reports\Subject Areas\Enterprise Performance Management.

![Regional Profit and Margins report](image)

The following evaluation walks you through the process of creating the simple, formatted document shown at the beginning of this chapter. The document shares the same name as the report used for its dataset: Regional Profit and Margins.
Creating a basic document with the Document Wizard

The Document Wizard provides an easy way to create a basic document that you can use as a starting point. Once you have created the basic document, you can use the Document Editor to further refine the document’s definition, formatting, and layout to create a sophisticated, visually pleasing, boardroom-quality document.

Use the following steps to create a basic document with the Document Wizard.

You can also create a document using a document template, which allows you to start with a predefined structure. You can also create a document from a report, which displays the report within a document. For more details on these various methods, including instructions, refer to the *MicroStrategy Report Services Document Creation Guide* (see Resources, page xviii).

To create a document using the Document Wizard

1. Open MicroStrategy Developer (from the Windows Start menu, point to Programs, then MicroStrategy Products, then click Developer).

2. Log in to the MicroStrategy Analytics Modules project source using the login ID User. Leave the password blank and click OK.

3. Expand the MicroStrategy Tutorial project, then expand My Personal Objects, and then select My Objects. This is where you can create your document.

4. From the File menu, point to New and then choose Document. The New Document dialog box opens.

5. Select Document Wizard and click OK. The Document Wizard opens and the Welcome page is displayed. The Welcome page explains the process that the wizard guides you through. Click Next to begin. The Select the Document’s Data Source and Specify a Title page opens.

6. You must specify the object to be used as the source for the document’s data; this is typically a report.

   Click ... (the browse button) to navigate to the Regional Profit and Margins report. This report is located in Reports\Subject Areas\Enterprise Performance Management. Then click Select.
7 In the **Document title** field, type Regional Profit and Margins and then click **Next**. The Select Fields for the Document page opens.

8 Determine the objects to be used in the document. You can add or remove objects later using the Document Editor.

Click the double right arrows $\Rightarrow\Rightarrow$ to move all the objects to the **Selected fields** list and click **Next**. The Select How the Document Is Grouped page opens.

9 This determines how the data is grouped in the document.

Select **Region** and click the right arrow $\Rightarrow$ to move it to the right side of the page. Select **Year** and click the right arrow $\Rightarrow$ again. Region should be above Year in the **Selected fields** list. Use the up and down arrows to change the order if necessary. In this case, with Region above Year, data is grouped first by Region and then by Year within each region. When you are finished, click **Next**. The Specify Group Sorting page opens.

10 Each grouping item selected in the previous page is listed in the Sort By table, with **Criteria** and **Order** columns for each item. The **Criteria** is what the object is sorted by. Since the items are all attributes, you can choose which attribute form to sort on. The **Order** determines whether the grouping item is sorted in ascending or descending order. Since the **Criteria** is defined as **Default**, you cannot select the **Order**.

Leave the default selections and click **Next**. The Select a Template for the Document’s Layout page opens.

11 These selections determine the general layout (the position and placement of items on the document) to be used as a starting point. In the next part of this evaluation you learn to modify the layout of the document using the Document Editor.

Select **Stepped** in the list of **Available layouts**. Then select the **Portrait** orientation option and click **Next**. The Select the Document's Formatting Autostyle page opens.

12 This page allows you to select the Autostyle for your document. An Autostyle is a predefined collection of formatting properties, which is applied to a document to change its formatting and appearance.

Select the **Tutorial Sample** Autostyle and click **Finish**.
The document is created and displays in the Document Editor, with all your selections appearing in the appropriate document sections as shown in the following image.

The layout and formatting, such as colored sections and text characteristics, are already applied as a result of the layout and autostyle you selected.

The next steps show you how to further refine the document’s definition using the Document Editor.

**Refining a document using the Document Editor**

You can use the Document Editor to create a new document from scratch. The Document Editor can also be used to edit or refine an existing document. For the purposes of this evaluation, you will use the Document Editor to refine the definition of the basic document that you created with the Document Wizard above.
The following steps describe some of the tasks that you can do with the Document Editor. Much more functionality is available that is beyond the scope of this guide. For complete details about document creation and design, refer to the *MicroStrategy Report Services Document Creation Guide* (see *Resources, page xviii*).

**To enhance the document’s design using the Document Editor**

1. Preview the document’s appearance when it is viewed as a PDF. To do this, from the **View** menu, choose **PDF**. The document opens in Adobe Acrobat Reader and you can see how it will look when others view the document. A portion of the document is shown below:

2. From the **View** menu, select **Design** to return to Design View and complete the document.

3. From the **File** menu, choose **Save** to save the document.

4. You can name the document anything that you like, but for this evaluation, name it **Regional Profit and Margins**, the same name as the report being used as the dataset for the document. You can save both a report and a document with the same name in the same folder; they are differentiated in the interface by their unique icons and object types.
5 Navigate to the My Objects folder, which is in the My Personal Objects folder and save the document there.

**Formatting the title of the document**

6 Click the title Regional Profit and Margins in the Document Header section so the text box is highlighted (indicated by small red handles around the edge of the text box). Then drag-and-drop the text box from the center to the top left corner of the document section.

7 Click the red handle on the bottom right of the text box and drag it to the right, to expand the size of the text box so you can see the entire title.

You do not have to expand the height of the text box to display the entire title. By default, the height of the text box expands to fit the height of the text box’s contents.

**Adding a description below the document title**

8 Add a description below the title using the following steps. At the end of these steps your document header should look like the image below:

- To make room for the description in the Document Header section of the document, click and drag the horizontal section divider below the Regional Profit and Margins field.

- From the **Insert** menu, choose **Text**. Then click below the title to add a text box. In the new text box, type the following description:

  This product and operational report shows Profit and Profit Margins at a yearly level for each call center. Financial data is available for the years 2005 and 2006. The information provided is first grouped by Region and then by Year.

- To modify the font, select the description text box. From the **Format** menu, choose **Format**. In the Format Objects dialog box, on the **Font** tab choose the Trebuchet MS font and click **OK**.
• Click in the white space outside of the text box. Extend the right side of the text box by clicking the red handle on the right side and dragging it to the 6-inch mark.

• Extend the bottom of the text box by clicking the red handle on the bottom and dragging it until you can see all of the text.

• If necessary, select the text box and drag it to position it on the left side of the document and directly below the title.

Your document header should now look like the image above.

From the View menu, choose PDF to view your progress. Notice that the headers Region, Year, Call Center, Profit, and Profit Margin are not centered in the teal-colored horizontal bar.

**Repositioning headers**

From the View menu, select Design.

To move all the headers upward at the same time, press and hold CTRL and click each header field until all of them are selected. Drag the headings up so they are aligned with the horizontal section divider as shown in the following image.

12 Add a horizontal line in the Region Header section so that the region is displayed above the horizontal line, which serves as a separator.

To do this, from the Insert menu select Line. Click and drag to create a horizontal line below the {Region} text box. Make this line span the entire document by selecting 100% for the Length Mode in the Property List.

If the Property List is not displayed on the left side of the Document Editor, click Property List at the bottom of the accordion pane on the left. If the accordion pane is not displayed at all, select Property List from the View menu.

**Formatting specific text**

Change the formatting for the way that the years are displayed so that they are differentiated from the rest of the values. The following steps
explain how you can do this by placing the Year values in a colored, horizontal rectangle:

- From the Insert menu, point to Shapes, and then choose Rectangle.
- In the Year Header section, click and drag to create a rectangle directly on top of the {Year} text box (in the Year Header) and extending all the way to the right edge of the document.
- With this rectangle selected, in the Property List, select Backcolor.
- Click ... to open the Color dialog box. Choose a light orange color and click OK.
- The filled rectangle now hides the {Year} text box. You can move the rectangle to the back and bringing the {Year} text box to the front. To do this, select the rectangle, and from the Format menu, point to Order and then choose Send to Back.
- Select the {Year} text box and change the font color to white. To do this, right-click the text box, point to Font Color, and choose the white color.

14 From the View menu, choose PDF to view your progress. Your document should look like the image below.
Adding page numbers

15 From the View menu, select Design.

16 Add page numbers to the document in the format Page x of y where x is the number for the current page and y is the total number of pages. To do this, complete the following steps:

- If the Page Footer section is collapsed, expand it by clicking the + icon next to the Page Footer section.

- Create a text box in the Page Footer section that spans the width of the document. To do this, from the Insert menu, choose Text. Click in the Page Footer section, and drag to expand the text field to the width of the document.

- In the text box, type Page.

- From the Insert menu, point to Auto Text and choose Page Number. The auto text code {&PAGE} is inserted into the text box. (Notice that a space is automatically inserted before the code.)

- Type a space after the auto text code, then type of, and then insert the Total Pages auto text code.

- Select the text box and, in the Text section of the Properties List, choose Center for the Horizontal Alignment to center the page information in the text box.

17 From the View menu, choose PDF to view your progress. Notice that information for the South region is split between two pages as shown in the image below. You can prevent this by specifying that the groups must
always be together. To fix this, return to Design view by choosing Design from the View menu.

<table>
<thead>
<tr>
<th>Region</th>
<th>2005</th>
<th>2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>Washington, DC</td>
<td>$181,425</td>
<td>$161,321</td>
</tr>
<tr>
<td>Charleston</td>
<td>$251,116</td>
<td>$232,507</td>
</tr>
<tr>
<td></td>
<td>24.28%</td>
<td>24.20%</td>
</tr>
<tr>
<td></td>
<td>24.21%</td>
<td>24.17%</td>
</tr>
</tbody>
</table>

Adjusting grouping properties and completing the document

18 In the Grouping section at the top of the document, right-click Region and choose Grouping Properties. Select the Keep group together check box and click OK.

19 From the View menu, choose PDF to view your completed document. Notice that all the information for the Central region is kept together on the second page of the document.

This evaluation showed you the basics of how to create a document. You can create more sophisticated documents with the Report Services product. To learn more about documents, refer to the MicroStrategy Report Services Document Creation Guide (see Resources, page xviii).
Chapter 1: Troubleshooting the Evaluation Edition

Introduction

This appendix is designed to help you work through some problems you may encounter while using the MicroStrategy Evaluation Edition.

The topics in this appendix do not address every possible problem. If you cannot resolve your issue, refer to the MicroStrategy Installation and Configuration Guide (see Resources, page xviii) or contact MicroStrategy Technical Support (see Consulting, page xxvii).

Chapter 2: Troubleshooting Installation and Configuration of the Evaluation

Section 1: Using the Installation Log File

During the installation routine, the MicroStrategy Installation Wizard gathers and records information about your system and your installation...
selections. You can verify installation setup information through the installation log file (install.log), located by default in C:\Program Files\Common Files\MicroStrategy.

The installation log file includes the following information:

- Installation date
- Target directories
- Program folder name
- Operating system identification
- Hardware specifications
- Selected installation options
- Registry paths
- List of registered files

The installation log file can be helpful if you encounter errors during the installation process. For example, the log can tell you if a registry key or path was not added or if a critical file was not registered successfully.

**Next button grayed out on Customer Information screen**

The Next button is not available and you cannot proceed past this screen until you enter a valid license key.

Make sure you have the correct license key and that you have typed it in correctly. The key is case-sensitive, so beware of common typing mistakes like using the letter “O” instead of the number zero (0) or “b” instead of “B”.

If you have the license key in an electronic form (for example, in the email you received when you registered), the easiest thing to do is simply copy and paste the license key into the Customer Information screen. Make sure that there is no space at the end of the license key after it is pasted; otherwise, the Next button remains unavailable.
Missing Requirements screen opens

If you choose to install a product but do not have the appropriate hardware or software requirements on your computer, this screen opens and tells you what requirements are missing and for what products. You must either install the missing requirements or choose not to install the products at this time.

For example, you will see this screen if you try to install MicroStrategy Web on a computer that does not have Microsoft Internet Information Services (IIS) installed. To install MicroStrategy Web, you must exit the installation and install IIS. Another option would be to go back and choose not to install MicroStrategy Web. Assuming that was the only product with missing requirements, you will be able to continue and install the other products you want to use.

Troubleshooting the MicroStrategy Developer evaluation

Link on Welcome screen is not active

The link on the Welcome screen is visible but unavailable until all of the necessary components are installed for that particular part of the evaluation. You must install MicroStrategy Developer for this link to be active. For detailed instructions on installing MicroStrategy Developer, see Installing the MicroStrategy Evaluation Edition, page 63.

Cannot log in

If you cannot log in, first make sure you are using the correct login ID and that you have not mistyped. If you are still having trouble, make sure the Intelligence Server is running. Use the following steps to confirm that Intelligence Server is running, and to start it if it is not.
To confirm or change MicroStrategy Intelligence Server’s status

1. From the Windows Start menu, point to Programs, then MicroStrategy Tools, and then choose Service Manager. The MicroStrategy Service Manager opens and shows you the status of your Intelligence Server.

2. If your Intelligence Server is not running, click Start. The server will start (it may take a few minutes), and the status will change accordingly.

3. When you are finished, close the Service Manager window.

Troubleshooting the MicroStrategy Web evaluation

Link on Welcome screen is not active

The link on the Welcome screen is visible but not available until all of the necessary components are installed for that particular part of the evaluation. You must install MicroStrategy Web and Intelligence Server for this link to be active. For detailed instructions on installing MicroStrategy Web, see Installing the MicroStrategy Evaluation Edition, page 63.

MicroStrategy Web page cannot be displayed

Just like any other web application, MicroStrategy Web cannot run unless the web server that hosts it is running. If you try to access MicroStrategy Web and get a standard “page not found” error, make sure that Microsoft Internet Information Services (IIS) is running.

To start Microsoft IIS

1. From the Windows Start menu, point to Settings, and then choose Control Panel. Double-click the Services icon to open the Services dialog box.
2 Locate the IIS Admin Service. If it is stopped, select it and click **Start**.

3 After the IIS Admin Service is running, locate the World Wide Web Publishing Service. If it is stopped, select it and click **Start**.

4 After the services start, click **Close** to close the Services dialog box and then close the Control Panel window.

**MicroStrategy Web is running, but there are no projects**

MicroStrategy Web relies on the availability of MicroStrategy Intelligence Server for the majority of its functionality. If Intelligence Server is not running or if MicroStrategy Web is not connected to Intelligence Server, you will see a page with one of the following messages:

You must be connected to at least one project to begin using MicroStrategy Web.

or

The contents of this page cannot be displayed because the MicroStrategy Server is not running.

Ensure that Intelligence Server is running, and then ensure that MicroStrategy Web is connected to Intelligence Server, using the steps below.

---

**To start MicroStrategy Intelligence Server**

1 From the Windows **Start** menu, point to **Programs**, then **MicroStrategy Tools**, and then choose **Service Manager**. The MicroStrategy Service Manager opens and shows you the status of your Intelligence Server.

2 If your Intelligence Server is not running, click **Start**. The server will start (it may take a few minutes), and the status will change accordingly.

3 When you are finished, close the Service Manager window.

Once the Intelligence Server is running, MicroStrategy Web should automatically connect. Click **Refresh** on your browser’s toolbar to refresh the page.
If for some reason it does not connect automatically, the following steps explain how to connect MicroStrategy Web to the Intelligence Server.

### To connect MicroStrategy Web to the Intelligence Server

1. On the Windows Start menu, point to Programs, then to MicroStrategy Tools, then choose Web Administrator.

2. In the Add a server manually field, type the name of the computer on which MicroStrategy Intelligence Server is running and click Connect. By default, this should be your computer name (see below to learn how to find out your computer name). The Intelligence Server is displayed in the list of Connected servers.

3. Click the MicroStrategy Web Home link to return to the MicroStrategy Web home page.

4. Now you see a list of available projects. Click MicroStrategy Tutorial to log in to the project. Log in as User with a blank password.

5. Click the MicroStrategy icon and select Home.

### To find out what your computer’s name is

1. In Windows, right-click My Computer.

2. Click the Network Identification tab. Your computer name is shown on the Network Identification tab.

---

**Troubleshooting the MicroStrategy Office evaluation**

**Links on Welcome screen are not active**

The links on the Welcome screen are visible but not available until all of the necessary components are installed for that particular part of the evaluation.
For these links to be active, you must install all components of MicroStrategy Office, MicroStrategy Web Services, and MicroStrategy Intelligence Server. In addition, you must have Microsoft Office, with at least Excel installed. For detailed instructions on installing the required MicroStrategy products, see *Installing the MicroStrategy Evaluation Edition, page 63.*

**There is no MicroStrategy Office toolbar**

To see the MicroStrategy Office toolbar, you must have installed MicroStrategy Office. If Office is installed and you do not see the toolbar, it may be hidden. You can show it by opening the **View** menu, pointing to **Toolbars**, and then choosing **MicroStrategy Office**.

**Troubleshooting the MicroStrategy Mobile evaluation**

**Link on Welcome screen is not active**

The link on the Welcome screen is visible but not available until all of the necessary components are installed for that particular part of the evaluation. For this link to be active, you must install MicroStrategy Mobile and MicroStrategy Intelligence Server. For detailed instructions on installing the required MicroStrategy products, see *Installing the MicroStrategy Evaluation Edition, page 63.*

**Troubleshooting the MicroStrategy Architect evaluation**

**Link on Welcome screen is not active**

The link on the Welcome screen is visible but not available until all of the necessary components are installed for that particular part of the tutorial.
You must install all components of MicroStrategy Developer and Intelligence Server for this link to be active. For detailed instructions on installing these products, see *Installing the MicroStrategy Evaluation Edition, page 63.*
**Activation Code**  A code used to activate MicroStrategy Intelligence Server after installation. This code is sent to an email address provided during activation.

**administrator**  A user who installs and monitors software and user configurations, maintains the state of the software, and administers the MicroStrategy servers in the platform. An administrator also defines users, assigns user login accounts and user privileges, and analyzes the performance of the system.

**analyst**  A user who analyzes business data by accessing reports, performing drilling, and otherwise manipulating reports and documents to see required business data. An analyst receives useful data from information devices like smart phones and email without necessarily understanding how such information is derived or delivered.

**analytical application**  In MicroStrategy, a software application designed to provide predefined reports and other analytics based on a predefined metadata repository, for various industries to gain insight into their business data. The application is not fixed to a specific physical schema, giving it the flexibility to be ported to a company’s existing data warehouse.

**Analytical Engine**  A component of the MicroStrategy Intelligence Server that performs all advanced analytical functions. The Analytical
Engine evaluates functions not supported by the data warehouse RDBMS and it cross-tabulates reports.

**application program interface (API)** A set of related functions that provides an interface between existing applications and new applications. The API can be seen as a platform over a set of services on which new applications can be built. The functions, or interfaces, are implemented in a Dynamic Link Library and are defined in a standardized syntax. Application functionality available in the platform can be integrated or embedded into other applications through the use of the APIs.

**attribute** A data level defined by the system architect and associated with one or more columns in a data warehouse lookup table. Attributes include data classifications like Region, Order, Customer, Age, Item, City, and Year. They provide a means for aggregating and filtering at a given level.

**attribute element** A value of any of the attribute forms of an attribute. For example, New York and Dallas are elements of the attribute City; January, February, and March are elements of the attribute Month.

**attribute form** One of several columns associated with an attribute that are different aspects of the same thing. ID, Name, Last Name, Long Description, and Abbreviation could be forms of the attribute Customer. Every attribute supports its own collection of forms.

**autostyle** A set of predefined formatting that can be easily applied to many reports in either MicroStrategy Developer or MicroStrategy Web. Autostyles are a good way to apply a corporate look and feel to reports.

**business intelligence (BI) system** A system that facilitates the analysis of volumes of complex data by providing the ability to view data from multiple perspectives.
cache  A special data store holding recently accessed information for quick future access. This is normally done for frequently requested reports, whose execution is faster because they need not run against the database. Results from the data warehouse are stored separately and can be used by new job requests that require the same data. In the MicroStrategy environment, when a user runs a report for the first time, the job is submitted to the database for processing. However, if the results of that report are cached, the results can be returned immediately without having to wait for the database to process the job the next time the report is run.

conditional formatting  A method used to format specified controls in a document depending on predefined criteria. It allows certain properties of controls, including sections, to be controlled by data-driven conditions.

custom SQL  Additional SQL code independently created by the user for execution against the data warehouse. MicroStrategy provides tools to write custom SQL, including Freeform SQL and Query Builder.

data warehouse  A database, typically very large, containing the historical data of an enterprise. Used for decision support or business intelligence, it organizes data and allows coordinated updates and loads.

data mart  A database, usually smaller than a data warehouse, designed to help managers make strategic decisions about their business by focusing on a specific subject or department.

data mart report  A special kind of report that saves its report data in a database rather than returning those results to the user. Data mart reports either create a new table in the database to store the report data or append the report data into an existing table.

dataset  A MicroStrategy report used to define the data available on a Report Services document.
**derived metric**  A metric based on data already available in a report. It is calculated by the Intelligence Server, not in the database. Use a derived metric to perform calculations on report data after it has been returned from the database.

**document**  A display representing data coming from one or more reports, as well as positioning and formatting information. A Report Services document is used to format data from multiple reports in a single display of presentation quality.

**drill**  A method of obtaining supplementary information after a report has been executed. The new data is retrieved by requerying the Intelligent Cube or database at a different attribute or fact level. In documents, drilling takes place via a link from one document to another document, report, or HTML document.

**entity relationship diagram (ERD)**  A diagram that provides a graphical representation of the physical structure of the data in the source system, which lets you easily recognize tables and columns and the data stored in those columns.

**filter**  A MicroStrategy object that specifies the conditions that the data must meet to be included in the report results. Using a filter on a report narrows the data to consider only the information that is relevant to answer your business question, since a report queries the database against all the data stored in the data warehouse.

A filter is composed of at least one qualification, which is the actual condition that must be met for the data to be included on a report. Multiple qualifications in a single filter are combined using logical operators. Examples include "Region = Northeast" or "Revenue > $1 million".

A filter is normally implemented in the SQL WHERE clause.

**folder**  A MicroStrategy object used for storing in a single place a set of objects that are similar, such as filters, templates, or reports.
**function plug-in**  Allows user-defined functions to be used by the MicroStrategy Analytical Engine.

**graph view**  Report viewing mode that displays results as a graphical chart.

**grid view**  Report viewing mode that displays result data in a tabular format.

**History List**  A folder where users can retrieve the results of previously executed or scheduled reports and documents.

**logical data model**  A graphical representation of data that is arranged logically for the general user, as opposed to the physical data model or warehouse schema, which arranges data for efficient database use.

**metadata**  A repository whose data associates the tables and columns of a data warehouse with user-defined attributes and facts to enable the mapping of the business view, terms, and needs to the underlying database structure. Metadata can reside on the same server as the data warehouse or on a different database server. It can even be held in a different RDBMS.

**metric**  A business calculation defined by an expression built with functions, facts, attributes, or other metrics. For example: \( \text{sum(dollar\_sales)} \) or \([\text{Sales}] - [\text{Cost}]\)

**outline mode**  Report viewing mode that creates indented, collapsible groupings of related elements to make reports neater and easier to read.

**page-by**  Segmenting data in a grid report by placing available attributes, consolidations, and metrics on a third axis called the Page axis. Since a grid is two-dimensional, only a slice of the cube can be seen at any one time. The slice is characterized by the choice of elements on the Page axis. By
varying the selection of elements, the user can page through the cube.

**plugin** An application that can easily be installed and executed by the MicroStrategy Intelligence Server in one of several identical interfaces. For example, advanced statistical and financial functions can be added as additional processing components.

**privilege** Assigned to users, a privilege defines the functionality available to a user, for example, which objects a given user can create and which applications and editors he can use.

**project** The highest-level intersection of a data warehouse, metadata repository, and user community, containing reports, filters, metrics, and functions.

**project designer** The user category of one who creates projects and all of the schema objects (facts, attributes, hierarchies) for a project. A project designer is thoroughly familiar with the data model and schema object editors.

**project source** Defines a connection to the metadata database and is used by various MicroStrategy products to access projects. One project source can contain many projects and the administration tools found at the project source level are used to monitor and administer all projects in the project source.

**prompt** The user is asked during report execution to provide an answer that completes the request that is then sent to your data source. A typical example with a filter is choosing a specific attribute on which to qualify.

**qualification** The actual condition that must be met for data to be included on a report. Examples include "Region = Northeast" or "Revenue > $1 million". Qualifications are used in filters and custom groups. You can create multiple qualifications for a single filter or custom group, and then combine the
qualifications using the logical operators AND, AND NOT, OR, and OR NOT.

**query**  A request for data from a database or data warehouse. A report is a database query.

**Query Engine**  The MicroStrategy component responsible for submitting SQL code to the database.

**report**  The display of data from your data source. A report is central focus of any decision support investigation, and allows users to query for data, and then present it in a visually pleasing manner for analysis.

**report designer**  The user category of one who creates all application objects such as grid and graph reports, filters, templates, documents, consolidations, and custom groups. The report designer understands all of the business intelligence capabilities of the system.

**security filter**  A qualification associated with a user that is applied to all queries executed by that user.

**security role**  In a MicroStrategy security model, the set of privileges that a user can have.

**Software Development Kit**  A distribution package of application program development software and the instructions for its use. Allows customization of an application.

**SQL Engine**  The MicroStrategy Intelligence Server component that in report execution converts report requests into SQL to be used for a database query.

**threshold**  Used to create conditional formatting for metric values. For example, a threshold triggers the report that, if dollar sales is
greater than $200, format that cell to have a blue background with bold type.

**view filter** The set of criteria that restricts the report data that is currently being viewed. It may include filtering conditions based on any of the objects on the report.
INDEX

A
activating installation 79
  activation code 77
during installation 75
activation code defined on 77
  activating installation with 75
requesting 77
  requesting during installation 72
administrator defined on xvii
analyst defined on xviii
Analytics Module 70, 199
  Human Resources Analysis Module 200
Android 166
  MicroStrategy Mobile evaluation 166
application object overview 108
apps, viewing predesigned 166
Architect 176
  starting 178
architecture of MicroStrategy 43
archiving report 127
attribute defined on 92, 177
  creating 183
attribute element defined on 92
B
business intelligence system defined on 35
  architecture 43
cloud computing 40
data proliferation 37
  examples 36
mobile devices and 40
technology stack 42
trends 37
user proliferation 38
visual data discovery 39
C
cloud computing 40
conditional formatting defined on 89
  document 89
  report 115
contacts 171
  example 172
creating
  attribute 183
  filter 193
  hierarchy 188
metric 190
    table 182
creating a report
    in MicroStrategy Developer 104
    in MicroStrategy Web 130
customer analysis reports 99

D
dashboard 88, 94, 114
    KPI 88
data discovery 39
data proliferation 37
data warehouse defined on 42
dataset defined on 210
Dataset Objects pane
    adding and removing objects from a document 117
    in MicroStrategy Web 117
delivering a report 123
derived metric defined on 93
device 171
Distribution Services 169
document defined on 88
    accessing sample evaluation 87
    conditional formatting 89
    creating with Document Wizard 211
    Editable Mode in MicroStrategy Web 116
    editing in MicroStrategy Web 116
document
    enterprise reporting 97
grouping 90
    heat map 121
    in Developer 88, 89
    in MicroStrategy Mobile for iPhone 151
    in MicroStrategy Web 114, 115
Document Wizard 211
drill defined on 92
report in Developer 92
report in MicroStrategy Web 119

E
Editable Mode in MicroStrategy Web 116
    enabling 116
delivering a report 124
datatv enterprise performance management reports 100
datatv enterprise reporting documents 97
evaluation process 3
Excel. See Microsoft Excel.

F
fact 177
    creating 187
filter 178
    creating 193
Folder List 108

G
grouping in a document 90

H
hardware requirements 64
    heat map 121
    hierarchy 92
Android 166
  downloading to iPhone 149
  in platform architecture 47
iPhone 148
  prerequisites 148
MicroStrategy Object Manager 70
MicroStrategy Office 70, 133
  adding a report to a PowerPoint presentation 141
  adding a report to a Word document 145
  adding a report to an Excel worksheet 137
evaluation 134
  refreshing data for Excel 136
  refreshing data for PowerPoint 140
  refreshing data for Word 144
MicroStrategy SDK in platform architecture 50
MicroStrategy Web
  Editable Mode 116
  enabling Editable Mode 116
  in platform architecture 46
  logging in 112
  overview 70
  undo 117
MicroStrategy Web Services 70
MicroStrategy Web Universal 112
mobile devices 40

R
  refreshing data in MicroStrategy Office 136, 140, 144
  report defined on 87
  accessing sample evaluation 87
  archiving 127
  creating in MicroStrategy Developer 104
  creating in MicroStrategy Web 130
  customer analysis 99
  drilling 92
  emailing 124
  enterprise performance management 100
  graph report in Developer 96
  graph report in MicroStrategy Mobile for iPhone 163
  graph report in MicroStrategy Web 122
  grid report in Developer 91
  grid report in MicroStrategy Mobile 163
  grid report in MicroStrategy Web 118
  human resources 100
  inventory 101
  page-by in Developer 91
  page-by in MicroStrategy Web 119
  sales and profitability analysis 102
  scheduling 126
  supplier analysis 104
  supply chain 101
  report designer 107
  Report Objects pane
    adding and removing objects from a report 105
    in Developer 105
    in MicroStrategy Web 131

P
  page-by in a report 119
    Developer 91
    MicroStrategy Mobile 152
  PowerPoint. See Microsoft PowerPoint.
  project defined on 176
    MicroStrategy Tutorial 176
  schema object 177
  prompt 178
<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Services document. See also document</td>
</tr>
<tr>
<td>requesting an activation code</td>
</tr>
<tr>
<td>requirements</td>
</tr>
<tr>
<td>hardware</td>
</tr>
<tr>
<td>software</td>
</tr>
<tr>
<td>sales and profitability analysis reports</td>
</tr>
<tr>
<td>scheduled report</td>
</tr>
<tr>
<td>schema object</td>
</tr>
<tr>
<td>overview</td>
</tr>
<tr>
<td>scope of analysis. See Intelligent Cube.</td>
</tr>
<tr>
<td>subscribing to a report</td>
</tr>
<tr>
<td>subscription</td>
</tr>
<tr>
<td>archive</td>
</tr>
<tr>
<td>scheduled</td>
</tr>
<tr>
<td>subtotals</td>
</tr>
<tr>
<td>supplier reports</td>
</tr>
<tr>
<td>support. See technical support.</td>
</tr>
<tr>
<td>system administration</td>
</tr>
<tr>
<td>table</td>
</tr>
<tr>
<td>creating</td>
</tr>
<tr>
<td>technical architecture</td>
</tr>
<tr>
<td>administration</td>
</tr>
<tr>
<td>data layer</td>
</tr>
<tr>
<td>design</td>
</tr>
<tr>
<td>information delivery and alerting</td>
</tr>
<tr>
<td>integration and customization</td>
</tr>
<tr>
<td>interactive reporting and analysis</td>
</tr>
<tr>
<td>report server</td>
</tr>
<tr>
<td>technical support</td>
</tr>
<tr>
<td>template</td>
</tr>
<tr>
<td>threshold</td>
</tr>
<tr>
<td>time-series graph</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>transformation</td>
</tr>
<tr>
<td>transmitter</td>
</tr>
<tr>
<td>troubleshooting</td>
</tr>
<tr>
<td>Developer evaluation</td>
</tr>
<tr>
<td>installation and configuration</td>
</tr>
<tr>
<td>MicroStrategy Architect evaluation</td>
</tr>
<tr>
<td>MicroStrategy Mobile evaluation</td>
</tr>
<tr>
<td>MicroStrategy Office evaluation</td>
</tr>
<tr>
<td>MicroStrategy Web evaluation</td>
</tr>
<tr>
<td>undo (MicroStrategy Web)</td>
</tr>
<tr>
<td>uninstalling</td>
</tr>
<tr>
<td>MicroStrategy Office</td>
</tr>
<tr>
<td>MicroStrategy products</td>
</tr>
<tr>
<td>user proliferation</td>
</tr>
<tr>
<td>Welcome screen</td>
</tr>
<tr>
<td>Word. See Microsoft Word.</td>
</tr>
</tbody>
</table>